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1.0 AIMS AND OBJ ECTIVES 

After studying this les on, you should be able to: 

• Acquire knowledge on windows XP 

• Discuss about the hi tory ~f windows operating system 

• Discuss the importance of tools and accessory in XP 
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Windows XP is an operating ·ystem made for windows platfom1. Ct is one of the most 
user friendly operating system which was most widely used in earlier years after 2001. 
This operating system had many other version under the name of XP itself like XP 
home edition, XP pr fessional edition, XP media center edjtion, etc. 

1.2 WHAT IS WINDOW XP? 

Windows XP is an operating system made on windows platform. It is one of the most 
powerful and most used op rating system. This operating sy tem was introduced in 
the year 2001, the pr vious operating available before XP wa Millennium popularly 
known as windows ME. This operating system had compatibility and stabi lity issues. 
Windows XP has made huge improvement over all previously available OS version, it 
provides easy navigation, easy internet access and many other fi atures to ease and 
enhance its user experi nee. 

1.3 EVOLUTION OF WI DOWS OPERATING SYSTEM 

Windows operating system have a huge impact on world computing technology in las 
25 years. It is almost impossible to imagin our life without windows base operating 
system but this succ ss was not easy to achieve, it took a long time for team Microsoft 
to achieve this fame and success. Windows operating system have evolved in phases 
starting with MSDO to window 10 up till now. Early age op r ting system had very 
less GUI (Graphic User Interface]. Earlier operating system was command based like 
we use ommands in MSDOS to operate work, so this i not an easy thing for user to 
operate on this OS. Later windows introduced GUI bas d OS [Operating System] with 
click and surf techn logy where user wi ll be provided with icons and graphic to 
enhance user experience. 

EEi 
W1ndowsl Windows 3.1 1ndow, 95 Wmdows )(P Wmdows Wt~ 7 W11'1dows 8 Windows 10 
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Win dow Icons 

1.3.1 W indows 1.0 

Working on MSDO wa tough for its users as it wa command base OS . To 
overcome this problem Micro oft announced its first edition of windows in the year 
1983 known as window 1.0. Thi O supported pointing device like mouse . By using 
the mouse, now the user can lick n various icons and options available on screen, 
option like dropdown menus, icon, dialog boxes helped user to learn the program 
easily. 

MS-DOS file management, Paint Notepad, alculator, and a Calendar, these features 
were a part of the introductory Operating System. A ga me caUed "Reverse" was also 
included in the first edition. 
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1.3 .2 Windows 2.0 

HELUA .FOtl HSDOS.EXE 
HELUB.FON MSDOSD.EXE 
HI FONTS. FON NOTE PAD .EXE 
HPLASER.DRU PAINT .EXE 
LOFONTS. FON PRACTICE.DOC 
MODERN.FON READHE.DOC 

St l e Pal ett e O tions 

DOS 1.0 
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ROHAN.FON WIN.CNF 
SCR IPT. FON WIN.COM 
SPOOLER.E XE WIN. IHI 
TERH INAL. EXE Wltl1110.BI 
THSRA.FON Wltl11111.0U 

This OS was introduced on December 9, 1987, in thi O processing speed and 
reliability was tremendously improved and from here on computers had started 
becoming a part of our day to day life. Use of desktop icons and keyboard shortcut 
help speedup work for its user. Control panel was first introduced in this operating 
system. 

DOS 2.0 

1.3.3 Windows 3.0 

This OS was launched on 22nd May, 1990. It was once the most popular version of OS 
of its time and the rea on of its success was its advance graphics with 16 colours, 
improved icon support, reliability. This edition had 368 bit processor. Program 
manager, file manager, print manager were som new features which were introduc d 
in this OS. Games like Heart, Solitaire and Minesweeper were also first introduced in 
this version of window . 

1.3.4 Windows 95 

This is one of the most popular versions of window operating system which remained 
in existence for ery long time. This versi n was launched on 24th August, 1995. This 
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OS had Start button and start menu for very first time. Thi OS had many pow rfu l 
features that laid the foundation for upcoming windows OS, apart from very powerful 
GUI it was more fast, accurate and re liable. This OS laid the fo undation for e-mai l, 
fax, modem and multimedia games. This vers ion of windows aUowed the auto update 
since it was compatible with previous version of windows. The upgrade can be done 
by both floppy and CDROM. Thi ver ion upports 12 different languages as well as 
Win95 had built-in support for internet. dial-up network. This S also support plug 
and play capability for various hardware that made it very easy fo r its user to install 
hardware and software. 

1.3.5 Windows 98 

This OS was launched on 25th June, 1998. This version of OS was designed to meet 
the needs of general consumer it was consumer oriented O . By this time so called 
computers were becoming PC's computer designed to me t the personal and 
professional need of con umers. Now the computers were seen more commonly in 
places like cafe, home, work etc. The major improvement in this version of windows 
was that it was capable of opening and closing function much more quickly. The 
version brought support of DVD' s, USB [Universal Serial Bus] into existence. It was 
the last vers ion to be based on MS-DOS. 

Window 98 Icon 

1.3.6 Windows ME 

This version of OS wa launche on l st September, 2000. M here stands for 
millennium. This OS had feature Li ke internet explorer 5.5, window media player 7 
and movie maker. Movie maker allowed users to record video and also helped them to 
edit and redesign it. Although the lifespan of windows ME wa very hort. This OS 
was very slow and had 1 ts of bugs that made it unsui table for rising user needs. This 
OS was soon replaced by Windows NT and later by Windows XP. 

1.3.7 Windows XP 

This version of windows was launched on 25 th October, 2001. It was one of the best 
selling Operating system in world, this version came up with the fresh look and it 
focused on usability that it had built in help and support centre. This ear of 
computation suffers from virus attacks and increasing trade on internet also lead to 
increase in practices like backing. This OS emphasized on help and support which 
upto a certain extent help user to overcome and protect tbemselv s from outer world 
treat like hacking an viru e . 



Microsof 

W indows 
Window XP Icon 

1n addition. Navigation implicity of the start menu, taskbar and control panel were 
more intuitive in this edition of Windows. Windows XP wa avai lable in 25 different 
languages and had everal editions like Windo XP 64-bit Edition 20 I), Windows 
XP Media Centre Edition (2002) and Windows XP Tablet PC Edition (2002). 

1.3.8 W indows Vista 

This OS was launched on 30th January, 2007. This OS was more secured and had u er 
account control feature which helped its user to protect computer from such software 
that ma changes in functi 11ali ty without own r knowledge. In Vista Ultimat it al o 
had fea tures like Bit Lockers, Device Encryption which provide excellent data 
s curity. This OS also bad 35 different languages. Fresh new look of start button and 
many new features like border around window etc., also first came in exi tence in thi 
version of windows. Not only th new look of thi version of OS focus ed on better 
fi le sy tern and fa ter proce sing alg ri thms which aided user in fast and effi ient 
search of requi red files . 

1.3. Windows 7 

This O wa launched on 22nd October 2009. Thi OS have touch screen 
compatibility and had maj r improvements over previou windows ver ion. It came 
with a fresh new look of overaJI windows and came up as much efficient a OS. This 
OS also had touch and handwriting r ognition popularly known a "touch and type" 
which help the new generation user to experience touch reen technology whereas it 
continue to serve its old consumer with traditional type experience. This OS also have 
vinual hard disk feature which is a concept of cloud computing and have kernel for 

irect access function. Windows 7 support multiple heterogeneous graphics ard to 
meet the ne ds of increa ed computing experienc of different cu tomer. "Your most 
unhap py customers are your gr ale t ource of learning", Bill Gate , rhe founder 
of the giant company quoted hims lf. Windows 7 i available in following di tions: 

• Windows 7 Home Premium 

• Windows 7 Professional 

• Windows 7 Ultimate 

Windows 7 wa the only operating sy tern that was evaluated by 8 million tester world 
wide before it's released. 

1.3.10 Windows 8.0 

This operating sy tem was launched in October, 2 12. This version cam up with 
totally n , interfac and the focus of tb i OS was on touch creen totally new start 
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menu was launched in thi ver ion of application, fil e webs ites were also being 
atta bed to this new start menu lo provide easy navigation. 

Wind ws 8 

These are the fo llowing editi n of Window 8: 

• Windows 8 

• Windows 8 Pro 

• Window 8 Ent rpri e 

1.3.1 l W indows 8.1 

The visi n of Window 8 to provide powerful apps and cloud conn ctivity let the 
upgrade to Windows 8.1. Changes in user int rface and desktop, online services and 
functionality, secw·ity and hardware compatibili ty, et . are improvements to name a 
few. In addition, some very interesting apps were also hipped in Windows 8.1, some 
of them are, Bing Smart Search so you can find what you' re looking fo r across the PC 
or the web, Bing Food & Drink, Bing Health & Fitness, and great uti lity apps like 
Reading Li t, Calculator and Alarms. 

Windows 8.1 Operating System has the following editions : 

• Win w RT .I 

• Windows 8. 1 Edition 

• Windows 8.1 Pro Edition 

• Windo 1s 8.1 Enlcrpri e Edition 

1.3.1 2 W indows lO 

This v rsion of windows wa launched on 29 th July, 2015. A number of new func tions 
like Windows st re app, Microsoft edge, virtual desktop, action centre, r vamped core 
app, th Xbo app, continuum, unified settings, etc., first made the ir existence in this 
edition. Microsoft edge is a new web browser of windows family pecially designed 
for light weight web br w ing. Windows IO al o have many new version subsequently 
launched and one of most special feature of Windows IO is that if you are a genuine 
Window 10 holder th n you can upgrade to new version for free unlike older days 
consumer don't have to buy new version very time they wi h to upgrade. 



Windows 10 

1.4 FEATURES OF WINDO WS XP 
. 

D sktop: This is the first screen of computer we see as oon a when we tum it on. It 
is aJso a placeholder from where the u er navigates through different application. The 
d sktop can be customised by its user, like a us r an copy paste fde and folders on 
desktop for easy and quick retrieval. 

Icons: It is a small representation of program, fiJe, folder, etc. They are the mall 
picture ti und on desktop. Each icon is always associated with one program. 

( I He lp ... rt pe::. m 

N 

Deskt p Icons and Folder 

1.5 DESKTOP ANATOMY 

My Computer: This icon provides a complete in ight of what is stored in the 
computer. It gives you acce s to everything that a computer has like hard drive , 
floppy drives, CD-ROM drives, files, program and do um nt. tc . 

Recycle Bin: Thi is the place where deleted files and folder get stored initially. If a 
user wishes to restore some file or fold r removed accidently can do o but once the 
user empty recycle bin then file or folder cannot be retrieved again. 

My Network Places: This option provides the full infonnation of network resourc s if 
a computer is connected t any network. Through this option, the u er can hare 
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hardware over the network. hardware like printer and drives. U ·er can also play games 
with other computer connected on th network. 

In t met Explorer: Thi is one of tbe most commonly us d option. Using internet 
explorer a us r can navigate through internet and various web ites. Internet explorer 
is also known as web brow er. 

Start Button: It is the button which i found on lower left corner of desktop. It is used 
to open various programs and files, thi button also have the information of program 
and fil e mo t recently used r most frequently used. 

Ta skbar: It is horizontal bar fi und at the bottom of d sktop screen. It contains the 
information of programs curr ntly in use. It can contain the infonnation of more than 
on program currently running. 

Quick l aunch Bar: This provides an easy way to launch a program with just one 
click. Sometimes this is hidden, to display it, right click on the task bar and choose 
Toolbars, then click on Quick Launch. 

Wallpaper: Using this option. one can customize the bac ground of computer screen. 

1.6 WINDOW S AND ITS ELEMENTS 

A typical window w ill have multiple features to aid it user needs. A window consist 
of multiple drop down menu and horizontal and vertical bars every windo,, have one 
wor ing area wh re user performs various task. 

Example of a Microsoft Windows window 

CCJIIJUC~ R.::_.:e eXMEpl e anc1 cv~-v-ie.w o.t &.Ll t;he 
r~e:n.t._. tr..-c &a.kl!! ~ 11 -.,.1..ndcv.l 

Status ~r 
Horizontal scroll bar 

Every window will have following element : 

Scroll 
arrow 

Resize comer 

File Menu Bar: Thi bar will have aU dropdown menu r lated to fi le operations, using 
the e optio from th m nu the user can add, modify or delete any existing file. 

Title Bar: This option will di play the name of file currently open, if the file is a new 
fi le then title bar will di play no name or untitled. 

Minimize, Maximize and Clo e: Thi option helps its user to customise the size of 
window. Mini mize option will pull the window down to taskbar, maximize option will 
open the window on full ize of de ktop and close ption will close a window 
currently being opened. 

Tool Bar: This ar ill contain a variety of tools to mak a fil . Th e tools help the 
u r to customi there file and I o help making work more profe ional. 



Horizontal and Vertical Scroll Bar: This allow user to traverse through a fil e as the 
size of file increase horizontal and vertical bar also appear. 

Resize Corner: This option help user to customise th ize of file a per his or her 
need. 

1.7 WHAT S NEW IN WINDOW XP? 

Windows XP came to market in the y ar 200 I , it had following great new features that 
made it legendry and best selling product of M icrosoft. 

• It came with new de ign and feel to its user interface. 

• This OS was built on windows 2000 kernel. 

• It was mor reliable and safi . 

• It was faster and had plug and play for wireless network. 

• XP started to upport DVD burner. 

• XP was not launched in server version. It came in two edition home and 
professional which make it very u itable for home based u er. 

• Professional version was very well suited for small and large organisation. 

Fill in the blanks: 

1. XP OS was introduced on ---- ---

2. OS stands for --- ----

3. Pointing device was introduced in OS. --- - - --
4. Icon is -------
5. Internet explorer is used for ______ _ 

1.8 LET US SUM UP 

• In this chapter we saw variou ver ions of operating ystem. 

• We also saw how windows have va lved from command line operating system to 
application based operating system. 

• We also saw what windows is all about. 

• Now we know in brief about the anatomy f wiodows. 

• We hav explored about the features and functionality of windows XP. 

1.9 LESSO END AC TIVITY 

Why w need so many operating systems? Why updated versions of operating systems 
are important? U e internet to fin d it out. 

1. 10 KEYWORDS 

DOS {Disk Operating System}: It is a kind of operating sy tern u ed in early days. 

OS: It is a short fonn for operating sy st m. 
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MS: It is the short form of Micro oft. 

PC [Personal Computer]: It stands for personal omputer popularly known as 
desktop. 

CD-ROM [Compact Dis · Read Only Memory]: It is a short for CD drive you use for 
storing data . 

DVD [Digital Versatil Di c]: It is a kind of CD having better features then typical 
CD. 

XP [Windows XPJ: It stands for Windows "experience", because XP is supposed t be 
a whole new great experience with Microsoft. 

1.11 QUESTIONS FOR DISC USSION 

I. Write a short note on the new fea ture of Windows XP. 

2. What are the significant changes brought in Windows 98 and 95? 

3. Differentiate between DOS operating system and Windows XP. 

4. Write a detailed n te on Windows XP. 

5. What do you unde tand by windows anatomy? 

6. Explain the evolution of operating system in detail. 

Check Your Progres : Mod I Answer 

I . 24th August, 2001 

2. Operating system 

3. Windows 95 

4. Representation of program 

5. Web browsing 

1.12 SUGGESTED READINGS 

O'Hara, Shelley, 2003, Ab olute Beginner's Guide to Micro o.i Wmdo~ XP. 

Covers conne ting to th Internet, maintenance, applications, and multimedi features. 

Harry L. Phillips, 2012, New Perspective · on f\,Jjcrosoft Wmdo~ 7 -for Power Users. 

Without assuming prior knowledge of the operating system, this text allows students 
to quickly review the b ics and move on to cover more ad anced concepts and 
features. 

Guy Hart Davis, 2007 Ma tering Microsoft Windows Hsta Home: Premium and 
Basic. 

The FTP site appears in the lntemet Exp! rer window as a rie of links: Click the Up 
to Higher Level Directory link to go ... WindoH-s Live Spaces was fonnerly known as 
MSN Spaces before Mi ro o.ibrought it into the fold of Live ervices. 
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2.0 AI MS AND OBJECTIVES 

Aft r studying thi I sson, you bould be able to: 

• Learn about windows acces ories and tools 

• Know how to use the tools 

• Learn about the need for tools 

2.1 INTRODUCTION 

This le son is all ab ut window XP features, program and tools that allow us to 
customize our computing experience. In this lesson, we will explore about different 
tools and their working capabilities. 

Every window op rating system contains a vast variety of tools and supporting 
program to aid its user. The e tool , acces ories nd program are very useful in order 
to make work more profe ional. Tools have a huge role in every computer program. 
These tools and acce sory programs are very important in increasing th productivity. 
They ·ave a lot of time and moo y of its user becaus by using these tools a user can 
do a lot of tasks in very hort pan of time. 

2.2 CALCULATOR 

Windows calculator is an application included in all windows version operating 
system. It is used for performing various types of calculation Like simple calculation, 
scientifi calculation or programming calculations. 

Calculation application was fir t introduc d in Windows 1.0 as a simpl c lculator. In 
Windows 3.0, scientific mode was added in which the u er could perform exponents 
and root, logarithms, factorial base fun tion, tc. 

In Windows I more feature were added to the calculator like statistics, unit 
conversion, date calcu lation and worksheet mode cal ulator was r modelled for th 
fi r t tim ince its introdu tion. 



Calculator in MS Wind w 

2.2.1 How to Open a Calcu la tor? 

First Method 

Click on start menu-go to programs-di k on Acces ories--then select Calculator 
to start calculator. 

Second Method 

We can also use Run dialog box [ tart-Run] type calc in Run dial g box and press 
enter. 

2.2.2 How to Use Calculator? 

Step 1 

Open Calculator program using any of the above stated method. 

Step2 

From view drop down menu hoose the type of alculator [Standard, Scientific, 
Programmer or Stati tical] by default standard mode open at first. 

StepJ 

Type the required calculation to be performed in the dialog box. Copy paste command 
can also be used to input numbers in calculator by user and al o copy the result from 
calculator to another application. 

2.3 CHARACTER MAP 

Character map is free feature included in all version of windows operating system. 
The feature allows you to ee and copy sp cial character in your document instead of 
typing them. 

We use character map to copy paste special symbols uch as trademark, special 
mathematical character or any other symbol coming from any forei gn language. 

13 
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2.3.1 How to Open Character Map? 

Take the following step to open haracter map: 

• Click on start . 

• Point to All Program folder. 

• Select Accessories folder. 

• Select system tools. 

• Double click character map or press enter. 

2.4 USING OUTLOOK EXPRESS 

Outlook express is a windows application used for e-mailing . This application was 
first introduced in Windows 95. But later after Windows XP this application was 
discontinued for multiple rea ans and one of the most trong r ason was it that it was 
way too complicat d and very error prone. In Window 7, outlook express was 
replaced with wind w mail and later windows mai l was rep laced by windows live 
mail. 

If your computer is still u iug Windows 95, 98, ME 2000 or XP take following steps 
to open outlook expre 

Step I 

Click on Start menu to lauacb Outlook Sxpress select Tools drop down menu then -
Accounts. Then following creen will appear. 



Out look Exp ress W indow 

Step2 

Click on the Add button and select Mail option. 

StepJ 

LUA,.-,~lilllfllllllP 
l.aulAIM N""'°"' 

L«•-" .. "-

Internet Account Dia log Box 

Enter your display name. Display is that name which will appear to receiver when the 
mail is sent from your account. Now, Click on Next button to continue. 

-~1111(1-,!0i,...,. -rihftOffll..id J~--.. .l"i'-~"'' -· 
Ditdll' r,_.. 

Connection Wizard Dialog Bo. 
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Step4 

Now enter your e-mail address. Make sure you enter a valid e-mail address otherwise 
this step will not comp! te. Now click on next to proceed. 

lntemet E-mrulAddfeu 

'four e-mail oduett i, lhe addren other people use lo ~end e-mail lo you. 

E-mail .!lddrets: I account@l andl help corn 

For example. someone@mocrosott.com 

< Back ([ Next > )f I CNicel 

Connection Wizard ·and Its Op tions 

Step5 

In this step, select the proto ol to send and receive mail. Select POP3 or HTTP for 
incoming mails and select SMTP for outgoing mails. This step is very important in 
order to configure your outlook express account becau e by only choosing the right 
protocol we can send and receive mails conveniently. Now, click on Next button to 
continue. 

E-mail Seiver Nam:,• 

A 

._I po ___ p._1an_ d_1 _com __________ --'l1 B 
An SMTP ~erver II lheserver th.al is u~ed for your outgoing e-mail. 

Outgo mail {SMTP) <etvet 

._! t-rn-lp_.,_an_d_l ._com ____________ _.! C 

< Back 

onnection W izard and Its Opt ions 



Step6 

In this step, you will enter your full e-mail address as your account name and your 
password associated with your above stated e-mail. If you don't want to enter your 
password every time, you send or receive e-mail check on "Remember password" 
option. Once your are done with all formalities cl ick on Next to continue. 

Step 7 

Type the tJCCOU'll name and password your Internet service p1ovider ha~ given you. 

AccOU'll Mme. account@1 and1 help. com 

Password •••••••• 
0 Remember password 

If your Internet tervice provider requite,; you to use Secwe P o,d Authentication 
(SPA) to acces:t yoUt mail account, select the 'Log On Um g Sec~e Password 
Authe1'11iealion [SPAr ,:heck bo~. 

0 LO\'l or, using Secure Password Authenllcation (SPA) 

+ 
< Back JI N ) I r 

Connection Wizard an d Its Options 

Cancel 

Now your e-mail is configured to your outlook express click on Finish to exit the 
wizard. 

Int 1ne 

Cong, atulalions 

You have .~ull)' entered all of the information requwed to &el u yoUI accounl 

To save !me seltrngs, click Finish. 

Cancel 

Connection Wizard and Jts Option 
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Step8 

Now you can send and receive e-mai l by clicking Send/Receive button on the top of 
the outlook express window. 

Iools t,lo<,- l:lefl> 

F_ , 
~Outlool. Exl)leJ< 

- 0 Local folders 
~ lnbow (ll 
-:,o...tt,o, 
'i!3!S.nt ltems 

G o,,leted It.ms 

'.$! o .. 1ts 
,

1 

_ 1£3 pop . land I.com 

'&J lrbo~ 
~ 5el'lt ltern::; 

~ O.oft, 

~M'lle....i 
5er< ~Se<' -­

CJ Spain 

t,Mh 

X 

Tlwe aruo contacts to .:kf:,loy, Clck 
Ofl C.or'lt tli to cretm a netY C\TI:« t. 

Conhtl 

t!d There tt I unread Mail me s1aoc 1n your Inbox 

Create a new Mail mes:Hg; 

W01III 

$ft UP 4 N;tit1sgrqyps dQC9 UOt ·· 

---~ 
Opr.n thi, Odd,.,., 8oolt ... 

find Pe1w le ... 

Us e nne-..,•w oaine- to 
quickly op r n or savr 
file att»chmenta . 

Soet 8 m 6S:S'31QO .-,tm 
ri ettdchod file Cl,d, 

011 th tvue papercllp 
Icon located below e 
meha·o• ~t and ol"t th1 
h,r ";!h t Se! thtt 
filename l;o oot"l'I ,t. or 
,11cl.. 'Save 
Attac:hm~nts ll!I i&'¥t­
che file to your 
t compure,r , 

r w "OutlOQ~ ETO-Teu sta rts , QO di rect!-, tom , Inbox . -__ _, 

Outlook Express Window 

2.5 ADDRESS BOOK 

The Address Book is a windows utility program used for creating a single list of 
contact information and this list can later be used by multiple pro ams. The program 
that most commonly us thi information is outlook expre s. 

Address book provide a very convenient option to store information of your friends 
and family and also pr vide easy retrieval. Using the Addre s book uti lity, you can 
create mailing group, send and receive electronic business cards etc. 

2.5.1 How to Open the Address Book? 

To open Address Book Click on tart Button - select All Programs - then select 
Accessories then click o Addre Book. 



: ....... ,~_...,..._..,..~~ -~-
I 

:1 Sl~rt - . - .. · .- - - -- --- ------. -
- - - -

Exl 

) 

Address Book Window 

2.6 MICROSOFT PAINT 

MS Paint is an application available in all Micros ft Window ver ion. It is a basic 
graphic based painting application. This application is used for dra ing, colouring 
pictures, editing pictures, etc. This application provide the fac ility of browsing 
pictures even from digital medium such as digital camera. We cannot only edit 
pictures but can al o create pictures of our own wisb. Thi is a very fu n application. 
Even kids like playing with M Paint, it helps them to explore their creative side. 

Using MS paint, we can save creations in standard .JPG and .bmp format. To paint 
using MS paint all we need to do i drag the mou e in paint area of MS paint. 
Different type of artistic brush, colours, shapes are available i paint tool box to make 
colouring more fun activity. 

One of the most exciting thing about MS paint is that you can never run ut of colours 
and brushes. Paint allow you to pick va ·t variety of colou ranging from basic to 
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advance colour selecti n. It also has features like pencil art and airbrushing. It allows 
you to enter text, shape , different types of lines, etc. It also has the function of erasing 
something that went wrong. We can increase and decrease size of image by using 
magnifier tool. 

2.6.1 How to Open MS Paint? 

To open MS paint follow the giv n steps: 

• Click on Start button. 

• Select Accessori folder. 

• Select MS-Paint. 

• Click on MS-Paint or pre enter. 

2.6.2 MS Paint Menu 

MS Paint has the fo llowing menus: 

• File Menu: Thi menu is used for creating n w file saving your creations, 
printing your c1 ation etting your creati n as background. etc. U ing file menu, 
we can open pre-existing imag s saved in any location of your computer 's hard 
disk and later c n edit it. and then you can save it as completely new creation. 
Whenever we open Paint it shows as untitled - paint on the top of the window. 
Later we can give name to our creation by using save option. 

M Paint Window 



s.,.,. Oli+S 
~A, ... 

Pml:"'-
Pa,g,e5eh.c> ... 
Pmt ... Cbl+P 

Send ... 

ElClt Al+F-1 

Fil Option of MS Paint 

• Edit Men u: Edit menu is used to undoing the complete t of operation currently 
performed or for redoing the current oper tion this menu also have copy and pa te 
option. Paste from option in ed it menu let you pa te image from any I cation of 
your computer. 

Edi t Menu 

• View M nu: This menu allows you t cu tomize your view or look of MS-paint 
you add and remove items lik tool bo , colour box, status bar, text box, zooming 
and viewing bitmap. If you unch ck any item in the view menu then it will 
disappear from your MS-paint creen or may be dea tivated . 
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X 

~- .......... . ,-_, r■r ■■r r 

Vi wMenu 

• Image Menu: This menu i used fo r performing variou operation on current 
image like starching a irnag or flipping a image, or inver ing the colours. This 
menu is also used for cl aring the currently op n image. 

- IU0_Dl/8 P..:;ml 

Image M nu and It Opti ns 

• Colours /1.1 nu: This m nu i u ed for edit ing colour . When we select this menu 
a separate window p p ups that allow you to modify colours . 

•••••••• •• 

Colour Forma tting Dialog Box 

• Help Men u: This menu i or upport and compr hen ive help asso iated with 
M Paint program. 



2.6.3 MS Paint Tool Box 

The tool box is a very useful part of paint. It contains a lot of tools that help in mak ing 
graphic paintings. Tool box have the following tools: 

• Free from selection and select tool: This tool i used for selecting specific part of 
image, we can copy and paste selected part of an image in some other part f 
image. We can also u e th is tool to delete sp cific part of image. 

• Erase or colour erase: This tool i used to remove your drawing or a part of 
image. We can select the size of eraser as per requirement manually. 

• Pick colour: This tool helps us to pick any specific col ur and make it as the 
actively available colour by default. 

• Pencil: This t ol is used for drawing, there are a variety of pencil art available in 
paint we can choo e thickne of pencil. 

• Airbrush: This tool is u ed for spraying colour in your creation. We can select the 
thickness of airbru h manually. 

• Line tool: This tool helps us to draw a variety of line ' with different measures of 
thickness. We can cboos what kind of line we want in our er ation manually . To 
make line, hold mouse cl ick and stretch it to the length you are looking fo r. Select 
thickness of line from toolbox. 

• Rectangle tool: Thi tool is used for making rectangle bape in our creation. We 
can also draw a square hape by pre s holding the hi.ft key. To mak a shape hold 
your mouse and stretch the pointer till desired ize i not achieved. 

• Ellipse tool: This tool is used for drawing llip e in drawing. We can also draw 
circle using this tool by press holding the shi ft key before you start dragging your 
mouse. 

• Fill with colour: This tool is used to fill specifi colour in an object drawn in your 
creation. 

• Magnifier: Thi tool is us d for zooming purpo e. We can zoom any specific part 
of drawing. We can select the size of zoom simply by clicking on drawing until 
desired zoom is not achi ved. 

• Brush: This t ol i used for painting. There are a variety of bru hes available in 
Paint, we can elect the kind of brush as per requirement. 

• Text: This tool is used for inserting tex t in drawing. We can choo a variety of 
font, style, colour and different font ize al o. 

• Curve, Polygon. Rounded rectangle: These tools allow the user to create different 
shapes with respective to the names given to tool. 

• Colour box: This tool helps you to choose different colours in drawing. 

2.7 NOTEPAD 

Notepad is a text editor. ''What is Text editor?"' Text editor is an application program 
that helps you to type and create simple te t document. Even if you write □umbers text 
editor will treat it a text nly. Now let's get back to otepad - it is an applicat ion 
program. "What i an application program?" An applicatjon program is kind of 
software which is developed to accomplish a sp cific task for which only like text 
editor can be used to create text documents. Now, again let' get back to NOTEPAD. 

Notepad is an application program used for creating imple text document. Notepad i 
used for reading and writing .txt files only, we can never insert an image in a notepad 
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file. Notepad is also u ed for cript programming. We can create web pages in notepad 
HTML "Hypertext markup Language" is used for creating web pages. 

Notepad only supports basic text formatting although you can have a variety of text 
style in notepad, also like you can have Ariel, Times New Roman, etc. font style in 
notepad. We can also have variety of fo nt size in a notepad file . 

We can save a notepad file in variety of fonnats like Unicode, ASCI, UTF8, java, 
Cpp, etc., this feature of notep:1d provides great fl exibility while working with 
documents of different character set or with differt>nt programming language. 

Notepad W indow 

2.7. l How to Open otepad? 

To open notepad follow the given steps: 

• Click on the start menu. 

• Select Accessorie folder . 

• Now place mouse cursor on '"notepad" option available in the list. 

• Double cli k r press enter to op n notepad. 

CCOISSOOCS 

~kul.to, 
Command Prompt 
Conm,cl to• NC'IWo<\: Projt<tor 

C onMCI to • PrqKtor 

u <!IJngSU~ ed 
M . l11pu1P~ 
Note:pld 
p int 

llenot Delctop (ORl'ltt<:tton 

Run 
Snlppng T ooJ 

t Sound ordtr 
St, Not .. 
S,-nc Center 

tndOW'l'l:>plorff 

W01dP•d 

S,-.t= T«>ols 

T PC 
,ndow> PowerShell 

p 

One more easy option is also available j ust type "notepad" in Start Menu search box to 
open notepad. 



2.7.2 How to Create & Save a Document with Notepad? 

To create a text document using notepad is very a y, all we need to do is to open 
notepad and start typing. It is always recommended to turn word wrap on so you don ' t 
have to scroll to the right s ide of document to see end of the line. You can choose font 
style as you like. Once you chosen the font style, then entire d cument will have same 
font. 

By using File drop down Menu, you can start a new page once if you are done with 
current page to do o, just click on the New option available in File menu. Using Open 
option available in file menu we can open a pre-existing file. Print option of note page 
lets you have a hardcopy of document you have currently opened. By default every 
page in notepad is tilled as untitled until it is not saved. 

Once you are done with text editing you can sa e lhe file us ing Save as option 
available in notepad file menu. By default "My Document" is a folder where all 
notepad files get saved you can choose different location to sav fi le by browsing it. 
All Notepad file will have the extension .txt so if you are working with some 
programming or encoding always be careful with ext n ion of file while saving it. 

!,'$ ••• 

J>,IQIII 5etil> ... 
e:,n... Cb'H-1' 

~ 

Notepad File Menu 

2.8 WORDPAD 

WordPad is text editor available in all windows ver ion operating system. It has more 
advance text fonnatti.ng features called "rich text fom1atting". Files saved in WoruPad 
get saved with exten ion " .rtf'. We can have variety of text tyle, colours, images, etc. 
in WordPad. 

f,. Help pre f1 I I.I 

WordPad Window 
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To open WordPad take the followi ng steps: 

• C lick on Start Button. 

• Select Programs folder. 

• Select Accessories. 

• Select WordPad. 

• Or just type Word.Pad earch dialog box of Start menu. 

OPE I G 'ORDPAD 

To (lp •n WMdPnd. Ii k on ,- tnrt, a ll progi m ·. 
. . · •l • ·L WordP d. 

\ . 

Following are the operation availabl in WordPad: 

• We can specify the pag layout for a document like paper size and margin 
settings. 

• We can type, edit or delete any part f text using Word.Pad. 

• We can modify fi nt tyle, colour or size as per our need . We can also modify 
page ind nt and alignment. 

• W ordPad also ha e find and replace option. 

• We can create document containing rich text, image , spreadsheets, etc. 

• We can al o link videos created in other application to a WordPad document. 

2.8 .1 Working with Do uments 

• To create a new document: To create new file in WordPad, click on File menu 
then click on N w option. Ch k the file type you want to create before. Now 
click on OK and tart typing. 

File Menu-New- file type-OK 

• To save a fife: To a ea new file on WordPad, click on the Fi le Menu then select 
Save As Option available in file dropdown menu and then enter the name you 
want to give to your WordPad document and then Cl ick on Save. You can also 
spe ify the locati n where you want to save your document. By default document 
gets saved in My Docum nt fol der. 

To save new change made in currently pre saved document, all you need to do 
is click on File M nu- select Save option available in file menu. 

• To open a document· To op a a pre- ·isting document in WordPad, all we need 
to do is to cl ick on File Menu sel t Option a ailabl in file menu. Another 



window will pop up asking you to pick up a file from list of files available. You 
can also browse the location of fi le saved on different drive or folder. After 
selecting appropriate fi le, click on Open button or press enter to open. 

• Specifying page layout: Setting page layout means setting page size, orientation, 
margin, etc. Page size start from A4 to many other different sizes. Page orientation 
have modes like landscape portrait etc. To change page setup settings click on 
file menu then select page setup , another window will pop up containing page 
settings. Th is ett ing will only be applicable on the current document you are 
working on. Pr ss OK or enter to apply etting . 

Pag S tup Dial g Box 

• Printing Documents: When you wish to have a hardcopy of the work done in 
WordPad, w cboo c the Printin 1 option. Printing option i · available in File menu 
of WordPad. 1t is suggested to have print review before printing a document. 

Using Print Preview, we can see h th page appearan e will look like after 
printing. If you are not happy with current page look, y u can change the se ttings 
again. To have Print Pre iew click on th File menu- and select Print Pr view 
option. To return on current working do ument click n clos button. 

To chang print rs nd printing option ·, enter nam and settings of new p1inter. 
To change page pecific tion ent r page ettings under it n th n print hardcopy 
of your doc 1ment. 

2.9 DIFFERENCES BETWEEN NOTEPAD AND WORDP AD 

Notepad Wor d Pad 

I. It is a simple text editor. l t is a text editor with rich tex t. 

2. Notepad is ·ed for rearing w b ba ed page:. Word Pad i not ry suitable for it. 

3. In notepad linking of vid os and imag _ i, not In rdPad we can link imarres and video . 
possible. 

4. File saved in notepad will have extension .lxt by File avcd in WordPad will have extension 
default. .rtf by default. 

5. We have very limited text ~ m1atting options. We h , ea I t o f tc ·t formatti ng options. 

6. Notepad ha - no find and replace option \\ ordPad ha find and replace option . 
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As name sugge t it is an application which allows il users to talk virtually. 
NetMeeting is a conferencing program featured in Windows XP professional with 
service pack2[SP2J. 

Computers running on Windows 95, 98, ME, NT, 2000 or XP can use this application 
to communicate u ing internet. This program is very useful for small and large 
organisation running on remote locations . 

This software has voice technology video technology, electronic whiteboard, file 
transfer protocol text ba e chat program. This appl ication is used widely by many 
organisations to share data and files. Th is application also has remote desktop sharing 
feature which make it very useful for organi ations making conferencing through 
internet. 

To connect using NetMeeting all we need is some conn ting medium to internet such 
as modem, ISDN, LAN or TCP l.P to send and re eive data from source to destination. 

ecurity feature of NetMeeting i very strong and that makes it very usefu l. This 
program uses H.323 protocol for video confer ocing. 

N tMeeting wa very popular program till free conferencing olulions came in market 
like Skype, Yahoo M s ·enger, MSN etc. it lost its popularity because it lacked fun 
features. GUI of NetMeeting i very old fashioned and du ll . Later Microsoft launched 
it n w video confer ncing called Windows Messenger and Micro oft live Meeting 
these new program i as good any other chat program. 

Mu; rornfl Ne1Mccl.n<1 , 

etMeeting Wizar d 

2. 11 MICRO SOFT INTERNET EXP LORER 

Internet explorer is a web brow er u ed for browsing pages and websites on internet. 
Microsoft internet explorer ruled the market in web browsing for a very long time in 
late 90s. It was the only popular brow er to explore web pages. internet explorer is 
also u ed for streaming live video and audio content. 

internet explorer was fust intr duced in August, 1995 a Internet Explorer 1.0 and was 
included wi th Microsoft Window 95 . IE explorer is included in all the versions of 
windows operatin s t m a tilJ n w. Win w recently laun hed new internet 
explorer call d .. Mi ro oft Edge' . 



Need for new explorer is to compete with other available explorer like Chrome, 
Firefox, Mozilla, etc. 

2.11.1 Basic Structure ofl nternet Explorer 

Internet explorer con ists of various elements. These elements are responsible for 
smooth internet exploring experience. 

AOORESS BAR MAIN WEBPAGE WINDOW 

Internet Explorer Buttons 

Internet Explorer ha four main bars: 

1. Title bar 

2. Menu bar 

3. Address bar 

4. Tool bar 

1. Title bar: This bar is located at the top of the window. his bar shows the name of 
web page currently running. At the beginning, it display "about blank" which 
means no pag is under processing currently. 

2. Menu bar: Menu bar contains a variety of options to customize your navigation. 
By using these menus you can perfonn many functions such as change language, 
open new internet explorer window, print web page currently open, etc. 

3. Address Bar: Address bar is also known as URL "unjfonn resource locator". URL 
bar contains the web address of page currently open, address bar contain three 
elements: 

(i) Protocol 

(ii) Name of the web page 

(iii) And extension of web page that describe its type 

Syntax of address bar 

Protocol://www. {name oftne page}. [extension] 

Example: https:// www.google.com 

Here https stand for ' hyper text transfer protocol" this is tandard protocol used 
by all web browser to open a page. www stands for "word wide web" . Name of 
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4. 

page could be any valid web page available over the network. Every web page 
will have some extension and every extension hav its re pective significance like 
.com stands for comm rcial web page, .gov stands for government web pages, 
.edu is for educational web pages, .in stands for India, etc. 

Tool bar: Internet explorer has fine quality of tools available in tool bar. These 
tools aid its user while exploring the internet. 

(a) Forward and backward button: This tool allo the user to traverse between 
pages. Internet explorer is capable of storing se ions o if the user wishes to 
go back to the page previously viewed, the user can go back to it using back 
button and if user wishes to come back to the page before going back, then the 
user can use forward button to come back to th point where he started from. 

' 
(b) Refresh and stop button: The refresh button is used to reload a page whereas 

the stop button is used when a user wishes to top processing going on in 
internet expl rer. 

(c) Home ands arch buttons: The Search button will take you to the page that 
you have set as default search page, if you haven't set any page as default 
search page then it will take you to Microsoft defauJt earch page. If you press 
back button after clicking the home button then internet explorer will take you 
to the page that you ju t left behind. 

Home button will take you to the page that you set as default home page. You 
can choose any web ite or most commonly used webpage as home page. 

(d) Favourites, history and media button: Favourite button wi ll show you the list 
of web pages that you visit most often . Before viewing this list, we need to 
enter the web pages which we like the most, so to do so we need to click on 
add to favourires option available in tool bar to add any page to favourites list. 

History button will display the list of pages open in internet explorer. IE keeps 
track of history by it elf, no one need to add pages to bi tory. But yes we need 
to empty history from tun to time io keep the internet explorer healthy. If we 
don't remov hi tory of internet explorer then it becomes heavy and hence 
leads to slower proce ·sing. 

Media button will play online streaming audio and video using Windows 
Media Player. 

(e) Mail and print button: Print button allows you to print the current page. Mail 
button will open th e-ma il box set as default, if no mail id is set as default 
then it will traverse page to MSN.com 

2.11.2 Advantages ofintern t Explorer 

• Internet explorer i free. 

• Internet explorer is mo t popuJar. 

• It is very simpl to use. 

• It is very less c1Tor pron 

• We can stream live audio and ideo in internet explorer. 

• We can traverse between pages move back to previous session and can go 
forward. 

• Internet explorer save old es ions . 

• Saves pages off1ine. 



• Internet explorer open applications without any pecial plugins. 

• Internet explorer supports a broad an-ay of applications and scripts that modem 
explorer might not support. 

• It is capable of very fast processing. 

• Internet explorer allow its user to restrict viewing of some pecific sites. 

2.11.3 Disadvantages ofl nternet Explorer 

• IE have no add on support. 

• It is slower in compari on with chrome and other internet explorer. 

• Security feature of newer version in IE explorer i very poor so it can be easily 
targeted by hacker . 

• It offers very limited extensions and plugins. 

• It is very difficult to cu tomize internet explorer. 

• The users find it le attractive as it continues to have same interface smce 
beginning. 

• Internet Explorer often fa ils to read the scripts in ome particular CSS. 

• There is no tab feature. 

• Internet Explorer often slows down which make it unsuitable for small bandwidth 
condition. 

• Internet explorer is not a very suitable option for mobile internet because it is 
heavy and occupies a lot of space. 

2.12 WINDOWS M EDIA PLAYER 

The windows media player is a utility program of Micro oft used to play audio and 
video. This media player is capable of playing any media format. This is one of the 
most popular media players till now, its compatibility with audio and video makes it 
unique in its own way. 

The most common format for audio is MP3 which i upported by windows media 
player. It also support formats like WMV, WMA and WAV for audio format. Window 
media player have online radio feature which stream live radio using internet. 

Window Media Player 
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For videos, the common format is A VI and MPEG4 which is supported by windows 
media player. We can al o use window media player to watch live TV, news, online 
videos, movies, etc. using internet. 

Windows Media Player works on two modes for playing song and videos : 

1. Now playing. 

2. Players library. 

"Now playing" mode will imply start playing song randomly by choosing it from 
library whereas "playe, library" will keep the track of arti t and it also allows the user 
to choose specific artist. 

Windows media player ha evolved over a period of ti me. It allows the users to create 
different playlist as per their mood. It can pick media from external drive also. 
Windows media player cannot only play CD and D D but can also create custom 
DVD's for its user. 

2.12. l History of W indows Med ia Player 

Windows media player wa first introduced in the year 1991 with Windows 3 .0 at that 
time it was known as media player. That time it had limited features and was capable 
of playing very limited audio and video. But with every new version windows media 
player kept on improving and is st ill standing strong after so much of competition. 

Microsoft recently developed a new media player for it mobile user called "windows 
media player mobile" and this version also supports many media format as well. We 
can also configure windows media player with other external devices like digital 
camera. Movie making i al o possible using windows media player. This feature is 
not available in many popular media players. 

One of the biggest di advantag of windows media player i its inability to stream 
videos online, it gets very slow on low bandwidth internet. It is also seen that this 
media player can not get sync with other devices like iPod. 

2.12.2 How to Open Windows Media Player? 

Take the following steps to op n windows media player: 

• Click start. 

• Select All Program folder . 

• Double click "Window me ia player' or press ent r. 

Or 

Type "windows m dia player" in search text box and click on "search" button 
select windows media player from search result. 

2.13 MS-DOS 

MS-DOS stands for Microsoft disk operating system. MS-DOS is a command line 
operating system. DOS is non graphical operating system. MS DOS was developed by 
Tim Paterson and wa introduced by Microsoft in August 1981. The last update for 
DOS OS came in 1994 wh n DOS 6.22 was released. 

2.13.1 What is Com mand Line Op erating System ? 

Command line operating sy tern are those kind of OS which work on command for 
doing a single operati n u er hav to write corresponding comman'd to execute that 
operation. Users do not get interactive graphic environment to work. Command line 
OS are very difficu lt to handl and it demands its u er to get trained before start 



working on it. To work on command line OS users are expected to remember all the 
commands to perform tasks. 

2.13 .2 Advantages and Disadvantages of DOC 

Advantages Disadvan tages 

It is a small size operating sy tern. It is a command line OS that makes it not very 
user friendly. 

It supports many disks type uch as floppy, CD Difficult to operate on. 
and hard disk. 

The OS is one of the most safest OS, it have very Supports very less external devices. 
few chances of external threats. 

1t supports many computer languages. Unsuitab le for modem computing. 

Being an old fashioned editor but still has text It is a single command taking OS which means 
editor. that only one task can be done at a time. 

2.14 CONTROL PANEL 

The control panel is a centralized feature of window. used for editing computer 
settings. Control panel contains all the tools related to your computer customization at 
one place only. 

2.14.1 How to Open Control Panel? 

• Click on the start button. 

• Select "control panel". 

• Double click or press enter. 
-- ------ - -
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When you select to open control panel, the following screen will appear at your 
computer screen showing a variety of customization tool and function. Make sure 
you remember the change you are making so in ca e of a mistake you can undo the 
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previously done changes. Control pan I contain many tool like tools for changing 
desktop, removing prein tailed program, adding and removing hardware, etc . 
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Cont rol Panel Window 

Following are the tools for customizing your computer and its working: 

• Accessibility Option : By u ing this option, we can change the settings of 
keyboard, mouse, display anct sound. 

• Add Hardware: hen we select this option, a new window will pop up called 
"Add Hardware Wizard" which will look for any newly connected hardware and 
then show step by step procedur to install plugins and hardwan:: functions . 

• Add or Remove Prog.-am : By us ing this tool, we can add nd remove software 
from our comput r. We mu always uninstall a oftware program instead of 
deleting from hard drive. 

• Administrative Tool : This tool i used for managing administrative functions of 
computer. By using thi option, we can monitor system performance, edit security 
policies, administrat computer serv ic , etc. 

• Automatic Update : Thi option is used to tell about windows when to take 
updates from the internet. We can set our preference whether to update it 
automatically or ask before updating. 

• Bluetooth Devices: This option i for managing Bluetooth d vices if you have 
any. You can add r remove u ing th is option. 

• Date and Time: ThL option is for managing your system's date time and region, 
etc. 

• Display This tooJ is used for diting your display properties such as background 
(wallpaper), resolut ion and er en saver. 

• Folder Options: Thi option i used to adjust your view for fil es and folder. 

• F ants: This option allows you to add new fonts to your computer. By selecting 
this option, you g t the information of pre installed font in your computer. 

• Game Controller : If y u have any gaming devices ucb a joystick or steering 
wheel , you can u thi tool t a d and remove or to troubleshoot it. 



• Internet Options: Tb.i tool helps to change settings of internet explorer such as 
history, connections and security. 

• Keyboard: Here you can adjust the settings such as how fa t the keyboard will 
repeat a character when a key is held down and the cur or bl ink rate. 

• Mail: This tool allow you to change settings of outlook express . 

• Mouse: This option is used to adjust the mouse settings. We can change mouse 
pointer and efti cts (e.g., processing effect will have rotating round, we can change 
that effect using mou e option available in contr I panel). 

• Network Connections: This tool is used for customizing your network settings. It 
will show you all the active network connecti ns . rf you wish to set up new 
r onnection use this option to do so. 

• Phone and Modem Options: This tool is used for changing settings of your 
modem and computer calls. 

• Printers and Faxe : Th_i- tool is used to add a new printer to your system or to 
chang~ printing properties. 

• Scheduled Tasks: Thjs tool helps you to run some task at certain time of a day. 

• Security Centre: Thi tool keeps a check of your windows security, firewall, virus 
protection, etc. It tool helps you to set your secur ity check on auto update. 

• Sounds and Device : This tool is used to adjust ound ettings of your computer. 
By using this option, you can set different sound on different occasion. This tool 
is also used to troubleshoot your sound hardware. · 

• Speech Propertie. : This tool will adjust properti s of speech input that is used for 
reading text in computer voice. 

• System: This t ol gives you detailed information of your computer hardware and 
software configuration. 

• User Accounts: Thi option is used to change the user settings who are logging in 
your computer. By using this tool , you set programs and featu r s that a particular 
user can view. 

• W1i·eless Network Setup Wizard: This tool allow you to et devic s that can use 
your wirelcs ac e p int. 

2.15 WINDOWS PICTURE AND FAX VIEWER OVERVIEW 

This program is a windows utility program used for vi wing imag s coming from 
digital or any other ext mal medium. This is a default program that opens up every 
time when we open an image, to view this program ha e no drop down menu. All it 
has is set of some tool that allow you to view, traverse, zoom, rotate, print, save with 
new name, delete and erut image currently viewing. 

To open windows image and fax viewer all you need to do is to d uble click image in 
"my picture folder" and as a result image will open in fax and image viewer. 

If you don't want to open an image in this program lhen select and left click on the 
image, then choose option "open with" and then choose the program that you wish the 
picture to open in. If you don't choose any program then pictur will open in image 
viewer by default. 
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Window Picture and Fax Viewer 

Image viewer will give following options and tools when you open an image in it: 

• Allows you to traverse between images of current open folder. 

• View image in fu ll creen. To exit fu ll screen press esc. k y. 

• View images as a slide show one after another. 

• Zoom size of image, it provide increase and decrease zoom. 

• You can rotate the image in 90 degrees. 

• You can delete the image that you don't want to keep. Photo will get deleted from 
currently open folder. 

• You can print the current open image. 

• You can save the current open image wilh some djfferent name. When you take 
this option what actu Uy happen is that the new copy of image with new name 
gets saved and old copy also exists so if you don ' t wish to keep both copies then 
you can delete the old c py of the image. 

• We can edit an image. By default, an image will open in paint where you can edit 
it as per your requirements. 

• In new version of image viewer you can modify image like increase and decrease 
contrast, increase brightne , add text and clipart to image, etc. 

2.16 HYPER TERMINAL AND WINDO WS ME SENGER 

This program is used t connect with other computers. This program is used to send 
and receive data over network. To make HyperTenninaJ connections all you need is 
modem or Ethernet connection. HyperT nninal is more than just connecting 
computers, it is also capable of sendin g large files over a network. It can also be used 
to control remote terminal. It can communicate with character based computers. It 
keeps the record of messages ent from other end. By u ing HyperTerrninal, we can 
send text messages. 

HyperT rm inal Window 



2.16.1 How to Open Hyp erTerminal? 

To open HyperTenninal follow the giv n steps : 

• Click on the start button. 

• Go to All Program . 

• Select access rie folder. 

• Set mouse focu on the communication folder. 

• Select HyperTerminal. 

• Double clic r press ent r. 

2.17 WINDOWS ME SENGER 

Windows messenger wa launched ith Windows XP in October, 2001. This 
messenger was very popular in lat 90s. It is a pre installed feature of windows XP, 
users don't have to download it eparately. Thi messenger ha featur s lik presence 
awareness. It uses SIP protocol "se sion initiation protocol" to end and recei e 
instant messages. 

While chatting use can send wink nudges and cu om emotion which make the 
whole chatting experience mor fun. 

This messenger had ome major drawbacks lik it wa very error prone and it was 
considered as slow. Hence, it got discontinued aft rward . Later window launch d its 
new messenger called "Windows Live Messenger" Lhat is as good as any other 
messenger. This new window messenger is also very suitable for mobi le data 
processing. 
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MSN M . enger 

2.18 WINDOW MOVIE MAKER 

Window movi maker i a windows XP program used for editing video. This 
program all ws you to make movies u ing your computer. To mak movi s all you 
need to do is to copy im ge r video to your c mputer. A movie made in movie 
maker can have sound effect· background mu . ic narration, etc. We can customize 
the movie by adding ti tle . translation and video effects. 

Thi software i ea ·y to use, it guides its u er' step by tep process to develop movies 
using movi maker. The pro e of making movie is divided into three step precisely. 

Step 1 Capturing vid o. You can import videos from your digital camera, hard driv , 
mobile, etc. 

Step 2 Assemble Lhe vide clips, dit it as per your n ed. 

Step 3 View the movie and ave it in easy to hare fom1at. 

To open movie maker go to tart menu then select "All Program folder· then choose 
'"windows movie maker •. 

Check Your Prn°rcss 

Fill in the blank : 

1. Calculat r is a _ _ ___ _ program u ed for _ _____ purpose. 

2. Character map is found in _ ____ _ 

3. Outlook expre s wa replaced by _____ after XP. 

4. Notepad is ______ program. 

5. Refr h button in internet explorer is u d for _____ _ 



2.19 LET US SUM UP 

• This lesson is all about windows tools and ace ory. 

• We have seen how the e t ols are helpful. 

• We explored various drop down menus of various programs. 

• We have also discussed a bit about text editor. 

• In windows, we have WordPad and Notepad basic text editor. 

• Now we know about the basic struchire of internet explorer. 

• We are also aware about the advantages and d i advantages of internet explorer. 

• We know now how windows media player and windows movie maker work. 

2.20 LESSON END AC TIVITIES 

1. Use WordPad and Notepad to er ate a file and ee what extension your file ha . 
Also try to find out all media extension using internet. Try to ustomize your 
internet explorer. 

2. Use internet to find all DOS commands and it syntax . 

2.21 KEYWORDS 

.txt [for text fil '}: It is the format used for text files . 

. exe [executable file]: By using this file, we run in tallation of any program in 
computer. 

OS [Operating System]: OS is a program that acts a a base to run any application it 
provide user and user frien ly GUI to work on. 

IE [Internet Explorer]: This is the program used for acce sing web pages available on 
internet. 

MP3 [Moving Picture Experts Group Phase 3): Thi is the extension used for vid o 
files . 

URL [Uniform R esource Locator]: A Uniform Re ourc Locator (URL). colloquially 
termed a web address is a reference Lo a web re ourcc that pccifi s its location on 
a computer network and a mechanism ti r retrieving it. 

MSN [Microsoft Network]: It was a kind of messenger service u ed in old r days. 

LAN [Local Area Network]: It is a type of network topology. 

TCIP [Transmis ion Control i nternet Protocol]: It i a protocol used t sending and 
receiving files trough e-mai l. 

IP [Internet Protocol]: It is a protocol used for intern t brow ing. 

MS [Microsoft]: Thi i a casual name used for Micro oft. 

2.22 QUESTIONS FOR DISCUSSION 

1. List all the difference between Notepad and WordPad. 

2. What is MS Paint? Explain in detajl. 

3. What are the various tools available in MS Paint? 

4. Write a short note on Text Editor. 
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5. List out the differences between Windows Media Player and Windows Movie 
Maker. 

6. Describe how to use Outlook Express and NetMeeting? 

7. Write a short note on MSN and HyperTenninal. 

8. Write short notes on: 

(a) Internet explorer 

(b) Calculator 

( c) Character map 

( d) Control panel 

(e) DOS 

Check Your Progress: Model Answer 

I . Application, cal ulations 

2. Accessory fold r 

3. Windows mail 

4. Text editor 

5. Restart session 

2.23 SUGGESTED READINGS 

helley O'Hara, 2003, Absolute .Beginner's Guide to Microsofl Mndows XP. 

Covers connecting to the Internet, maintenance, applications, and multimedia features. 

Harry L. Phillips, 2012 New Per pecti e on Microsoft Mndows 7 lbr Power Users. 

Without assuming prior knowledge of the operating system, this text allows students 
t quickly review th ba ics, and m ve on to cover more advanced concepts and 
features . · 

Guy Hart Davis, 2007, Mastering !vlicroso.i Hfndows \.i ta Home: Premium and 
Basic. 

The FTP site appears in the Intemet Explorer window as a eries of links: ◊ Click the 
Up to Higher Level Directory Link to go ... Windows Live Spaces was formerly known 
as MSN Spaces before Micro o.ibrought it into the fold of Live services. 
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3.0 AIMS AND OBJ ECTIVES 

After studying this les on you should be able to: 

• Define file and folder 

• Learn how to create fil es and folders 

• Explain the differences between files and fold rs 

• Discuss the various m thods of opening files and folders 

3.1 INTRODUCTION 

In this lesson, we will learn about how to create a fiJe and folder in Windows XP. In 
this lesson, we will explore different shortcuts used to create files in windows. We 
will also gain knowledge about arranging of files and folder in different order. 
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A fil e is a collection of facts, data and information. Everything stored in the computer 
is in tenns of fi le . There are differ nt kinds of files Like software fi les, operating 
system files, program files etc. Folder i lik a place holder to keep our fil es and data. 
A file can have a variety of extension. Every software installed in computer will have 
an associated folder and folders have no extensions. A file can be of .txt, .bat, .sys, etc. 
the last three alphabets after (.) tell us about type of file whereas a folder is just a 
fo lder nothing more then that. If we remove the file, then information stored in that 
file will be lost forever but if we remove the folder containing files then the group of 
information and associated file w ill be lost forever. A folder can conta in subfolders 
but file are a lways single and unique. 

3.3 VIEWING FILES AND FOLDERS 

V iewing any fi le and fold r i about viewing the content tored in it. W indows have a 
variety of fi1 and fold r option . All files and folder in our computer system are not 
ava ilable for our v iew me files and older can b kept hidden. Some file a l o can be 
a read on ly fonn which means that it cannot be edited by any other user. 

If you have different login modes in windows then fiJe created by one user from 
another login cannot be v iewed by oth r user login until the first user gives permission 
to other user to view it. But on other hand, administrator can view all th fil es created 
by all users. To view any file or fol der we can perform the following t of actions. 

Double Click Meth od 

To view any file or fo lder using tbi m thod is very easy, all we need to do is to select 
the file that we wish to open and dou ble click fil e to open it. 

If you wish to open a file of specific type, make sure its supporting software is 
properly installed. If you open a file whose appropriate application is not installed in 
computer then file open in unreadable fonnat mostly is in ASCII format or some time 
in some strange unreadable ormat. 

Mouse Right Click M thod 

This method i used for opening a fi t or ti Ider. In this method, we select the file or 
folder that we wish to op n and then right click the mouse as we press mouse right 
click different pop up menu will appear showing variety of options. Choose open or 
pr ss O key from keyboard to open a sociated file. 

E ample t show - How to Open a File 



3.4 ARRANGING FILES AND FO DERS 

It is almost impo sible 10 work without folder and file in computers. Keeping them 
in order is equally important in order to retrieve files or folders wh n required. To 
arrange files and folders in computer is called sorting and it can be done in many 
ways. 

We can a1Tange files and fo lders manually. To do so we have to keep track of all the 
fi les and folders manually, and also need to remember when they are created which 
seems to be like a difficult sk. 

Other option a ai lable i to right click the mouse at empty space of indows explorer 
on desired location where the group of fi les and folders is tored and then select 
"Arrange Icons By" option from pop up m nu. 
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"Arrange Icons By" menu will di p lay mul ti ple option choo e one sorting option 
which you find most uitable for you. 

• Name option will sort icon alphabetically . 

• Size will sort file and fo lder according to it ize ( malle t to larg ·t). 

• Type will sort files and fo lder to their type like appljcation, configuration and so 
on. 

• Modified on option will sort file · and folders by date they are last modified on. 

When we are orting files and folders in windows explorer, we can sort files and 
folders in groups. Thl gr up ing option wil l so1t imilar files at one place. We can also 
sort file in alphab tical order like all fo lders or fiJ tarting with alphabet "A" will be 
at one place and o on and so fa r. We can cu tomize our complete fil e viewing 
experience by s rting it in appropriate order. Sort ing files and folder makes work easy 
while extracting them. 

3.5 CREATING A NEW OLDER 

A folder is also called a Directory. It is the place where we keep our fil es organi ed 
and ordered. A folder can b1;; er ted anywh re in lhe computer but it is very important 
to remember the location of folder n hard di k. A folder can be created with 
fo llowing opt ions: 

• Creating Folder on des top. 

• Creating fo lder u ing file menu. 

• Creating fo lder using windows explorer task panel. 

3.5 .1 Creating a Folder on Desktop 

To create folder on desktop right lick 011 the de ktop working area. A pop-up menu 
will appear with multiple option . et mouse focus on ew option and then sele l the 
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fol der option as soon as you pre s enter a new folder will appear on your desktop with 
blue highlight text saying "New Folder". 

By defaul t all fo lders at first are called New Folder we can modify this name with any 
othe r name of our choice. 

It is always recommended to give folder that name which gives a brief description of 
its content like if in a folder you are keeping songs, give it the name of music or 
songs. 

Undo Delete Ctrl+Z 

;,; Wc,rdpad DoclJJ'llel'lt 

!a] Rich Text Document 

"J Text Document 

Proper ty Di I g Box 

Creating Folder Using File Menu 

Cr ating fold r in hierarchical view will always be a subfolder no matter whatever 
location you choose. Folders a,q be created us ing file menu. To do so you have to 
select File drop down menu available in windows explorer. Theo select new option 
und r fil menu and at la t click on Folder option available in that menu. 

Henc , the n w fo lder is created. This folder will also be named as New Folder in 
beginning and we can always change the name. Make sure you ch o right location 
to create fo lder other wi e you have to move fo ld r fr m one place to another. 
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3.5.2 Creating a F Ider using Windows Explorer Ta ·k Pan el 

For us ing this method al o it is very important to ch o e right location of folder. 
Using this m thod, we ha e t Li k on "Make a new folder' option available on left 



side of windows explorer, as soon as we click on thi option a new folder will be 
created on the current location . 
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Example to Create New Folder 

With this method we get fo llowing sub-options that we can u e to modify current 
folder action. 

• Rename the fo lder option will allow its user to r ate new name for a folder 

• Move the folder option allows you to move folder from one location to another. 

• Copy the folder will create a copy to currently made folder. You can paste this 
copied folder in any otb r location of your hard drive or desktop. 

• Publish folder on the web will allow its user to bare the content for folder over 
the internet. 

• Share folder will let you share folder over then twork. 

• E-mail the folder file option will let you mail the content files of folder through 
e-mail. Remember you are just mailing files not fold r . 

• Delete the folder option will remove the folder currently made. This option is very 
helpful when you make a folder accidently. 

3.6 CREATI GA FILE USING SHORTCUT 

In this section, we will learn about how to create a shortcut for files and folders. 
Before we learn to create shortcut we must know what i a shortcut? 

3.6.1 What is a Shortcut? 

Shortcut gives a quick access to files and folders buried several levels down the file 
hierarchy. We er ale shortcut usually for those files and folders that we use most 
often. By creating we don ' t change the location of tile or folder w just create a quick 
access. Choose location of shortcut wisely, most commonly we place shortcut on 
desktop. 

3.6.2 How to Create a Shortcut? 

Take the following steps to create shortcut using 

• Choose the file or folder using windows explorer whose shortcut you wish to 
create. 

• Right click the file or fo lder for which you want to create the shortcut for. 

• Select "Create Shortcut" option from the pop up menu. 
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• Press enter. 

• Drag newly created short ut to desired location or cut the shortcut by opening its 
properties and paste it on de ired location. 

3.6.3 Create a Shor tcut using Microsoft's Wizard 

To create a shortcut us ing Microsoft wizard takes the following steps: 

• Choose the location where you want to create shortcut on for example; on 
desktop. 

• Right click on the empty space available. 

• Select New option given in pop-up menu. 

• From New select 'Shortcut option. Double click or pre s enter. 

• Browse the location of fiJe for which you want to create shortcut. 

File Shortcuts 

While working on files some of the common shortcuts are u ed to perform tasks more 
quickly. For example if we want to select entire content of file we drag the mouse by 
holding left mouse button to the end of file instead of this we can use keyboard 
shortcut "Ctrl+A" to s lect full content of file, this method is quick and efficient. 

Using shortcut for fil manipulation gives a quick and foster fi l processing solution. 
All we need to do is remember all the shortcuts while working on files and folders. 
Files and folders will have separate set of keyboard shortcuts. Still some are common 
for both. 

Windows XP keyboard shortcuts are given ahead. 

3.6.4 Windows System Key Combination 

F 1: Help 

CTRL+ESC: Open Start menu 

ALT+TAB: Switch between open programs 

ALT+F4: Quit program 

SHIFT+DELETE: D lete item permanently 

Wfodows Logo + L: Lock the computer (without using CTRL +ALT+DELETE) 

Program Key Combination 

CTRL +C: Copy 

CTRL+X-Cut 

CTRL + V.· Paste 

CTRL+Z: Undo 

CTRL+B: Bold 

CTRL+U· Underline 

CTRL +I: Italic 

Windows Explorer for S lected Object 

F 2: Rename object 

F3: Find all files 



CTRL+X Cut 

CTRL +C: Copy 

CTRL + V.· Paste 

SHIFT +DELETE: Delete selection immediately, w ithout moving the item to the 
Recycle Bin 

ALT+ENTER: Open the properties for the selected object. 

General Folder Shortcut 

F 4: Selects the Go To A Different Folder box and m ves down the entries in the box 
(i f the toolbar is active in Windows Explorer). 

F5: Refreshes the current window. 

F 6: Moves among panes in Windows Explorer. 

CTRL+G: Opens the Go To Folder tool (in Windows 95 and W indows Explorer only) 

CTRL+Z: Undo the last command 

CTRL+A: Select all the items in the current window 

BACKSPACE: Switch to the parent folder 

SHIFT + click + Clo e button: For foiders, close the current folder plus all parent 
folders 

Reference: Microsoft MSDN 

Fill in the blanks: 

1. FI shortcut key is used for _ _ _ _ _ _ _ 

2. Folder is - - - ----
3. Every file will have -------
4. Shortcut provide - --~- -- to programs. 

5. A folder will never have - - - --- -

3.7 LET US SUM UP 

• Now we know what is file and what i fo lder. 

• We know the variou methods of creating fit · and folders. 

• We know now the differ nee between fi le and fo lder. 

• We can now make hortcuts to gain quick access to mostly used programs . 

3.8 LESSON END CTIVITIES 

l. Create folder and ubfo lders and try making folder with no name and note the 
output. Try creatjng fil e having link of some other file, mak its shortcut on 
desktop. 

2. Try using all shortcut keys on files and folder and see what happens. Note the 
output. 
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Exe [executable file}: Using this file, we run installati n of any program in computer. 

Txt [text file} extension is used for text files only. 

OS: Jt is the short form used for operating system. 

Ctr/ [control key]: It is a key present on keyboard for perfonning various operations. 

Alt [alternate key]: It is a key present on keyboard for performing various operations. 

3.10 QUESTIONS FOR DISCUSSION 

I. What is a file? Explain. 

2. Write a note on folder. 

3. How to create a shortcut? 

4. What are shortcut keys? 

5. Why do we creat shortcut for files and folders? 

6. Is it possible to create a file without any extension? If no, then explain why? 

7. Write in detail all the methods for creating files and folders. 

Check Your Progress: Model Answer 

1. Help 

2. Place holder 

3. Extension 

4. Quick access 

5. Extension 

3.11 SUGGESTED READINGS 

Shelley O'Hara, 2003, Absolute Beginner's Guide to Microso.i ITTndows XP. 

Covers connecting to the Internet, maintenance, application , and multimedia features . 

Harry L. Phillips, 201 2 New Perspectives on Microso ft ITTndo w.s- 7 for Power Users. 

Without assuming prior knowledge of the operating system, this text allows students 
to quickly review the basic , and move on to cover more advanced concepts and 
features. 

Guy Hart Davis, 2007, Mastering. Microsoft ITTndows ½sta Home: Premium and 
Basic. 

The FTP site appears in the Internet Explorer window as a eries of links: Click the Up 
to Higher Level Directory link to go ... ITTndows Live Spaces was formerly known as 
MSN Spaces before Microso.i brought it into the fold of Live services. 



LESSON 

4 
CUSTOMIZING YOUR COMPUTER 

CONTENTS 

4.0 Aims and Objectives 

4.1 Introduction 

4.2 Customizing Your Desktop 

4.3 Customize Desktop Bu tton 

4.4 Changing the Start Menu Style 

4.4.1 Two Style of Start Menu 

4.5 Advance Customization of Start Menu 

4.6 Setting a Screensaver 

4.6. l What is Screensaver? 

4.6 .2 How to Set a Screensaver? 

4. 7 Reversing Your Mouse Buttons and Changing the Appearance of Your 
Mouse Pointer 

4.7. l Re er ing Your Mouse Buttons 

4.7.2 Changing the Appearance of Your Mo e Pointer 

4.8 Adding a New Font to Your Computer and Adding or Removing of Programs 

4.8.1 Adding a New Font 

4.8.2 Adding or Removing Programs 

4.9 Logging off from the Computer 

4.9.1 How to Create a New User Account? 

4. 10 Hiding and Displaying Quick Launch Bar 

4.10.1 How to Display Quick Launch? 

4.10.2 How to Hide Quick Launch? 

4.11 Let Us Sum Up 

4.12 Lesson End Activities 

4.13 Keywords 

4.14 Questions for Di cu sion 

4.15 Suggested Readings 

4.0 AIMS AND OBJECTIVES 

After studying this les on, you should be able to : 

• Understand how to customize your Desktop and its button 

• Discuss how to change the start Menu Style 

• Understand customization of Start Menu 
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• Know how to set a creensaver 

• Discuss how to add a new font and remove the programs from your computer 

• Know how to I g off from the computer 

• Discuss how to hid and display Quick Launch Bar 

4.1 INTRODUCTION 

This lesson is all about changing the display of your computer, GUI as per your need. 
In this lesson, we wiU learn about why and how to customize your computer. 
Customizing wind ws is a great feature of Windows XP which provide you great 
flexibility to experience new colour schemes and various display ~ptions. 

4.2 CUSTOMIZING YOUR DESKTOP 

Customization of de ktop stand for changing the properties of deskt p set as d fault 
by windows. Micro oft Windows provides a lot of options and fea tures to chang 
windows colour scheme and windows pattern. To customize the desktop all we need 
to do is to right cl ick u ing mou 'e on empty area of the deskt p. Take the fo llowing 
steps to customize windows desktop using desktop property menu: 

• Right click on desktop will open th property menu. 

• Select propertie from pop-up menu. 

• Now display properties will app ar. 

• Now select di fferent tab to u tomize your desktop di play. 

r O II uncer I 

Desktop Property Window 

By default deskt p will open fi rst when we will right click on desktop to open its 
properties. From this tab, we can hange desktop background . The windows is loaded 
with some wallpapers, we an brows images and picture and set them as wallpaper. 

We can set wallpaper in three modes stretch, centre and tiles. We can choose different 
colours for desktop background. Once done with ettings that you wi h to change 
press enter of clic on apply to s e the new settings. Clicking on cancel button will 
wash out all the change mad and will bring you back to the previously applied 
settings. 



4.3 CUSTOMIZE DESKTOP BUTTO 

· If you wish to recover some lost item from desktop use this button. This button wi ll 
open a new wind w containing important folders and small check boxes. Choose the 
option that you want to keep on desktop and click on re tore default button. This 
button will take you back to the standard configuration. 

I °'-'-
t• lap~ 

0 IOCtciNr>4>-lnlllddotir.lop-lO• I,._ 

QR...eetllep~w,..,.._eo 
~, au,.--1) ......... --1-, .... ~1 

or J! c.nc. 

Desktop Item Dialog B 

4.4 CHANGING J HE ST ART MENU STYLE -------- ---------
we can customize tart menus style by right clicking on task bar placed on the bottom 
of windows screen. When we right click on the ta k bar a ne window will pop up 
showing two tabs 'Taskbar and Start menu" select tart Menu tab to change settings. 
Start menu in Windows XP comes in two styles: 

1. Classic style menu 

2. Start menu style [style menu of XP] 

0!1• --s.a11w .... .,..,., __ .... ___ ...,...,,, __ 

~ rarr 

Desktop Customization Dialog Boxe 
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4.4.1 Two Styles of Start Menu 

The classic menu wiU display limited options like we use to have in the earlier version 
of windows. This menu is parti ularly helpful for those who are not familiar to the 
new menu and find it difficult to work on it. 

On other hand, default menu has more features and al o gives flexibility to user to 
have quick access to some of the very useful programs. 

Defa ult Start Menu 

Cla::sic Start Menu 



4.5 ADVANC E CUSTOMIZATION OF START MENU 

Apart from setting start menu on classic default mode we can also have some advance 
settings to fine tune our start menu. To open advance settings cl ick on "customize 
button" in Start Menu tab. When we click on this button another window will pop up 
with tow tabs "General ' ' and "Advance". 

• General tab: By using this tab, we can decide the size of icons we want on start 
menu. We can decide the number of shortcuts to get pinned on start menu. We can 
also choose either we want internet explorer or not. 

Pt~ 

Tha Stait ffleR.I conll!lffl d,c,to,t IO tha ?0!1 ,cu lli>sl Olten 
ONor,g Ill d lhclrlc\b cto.t nai deiale tl-..p,011-

~urios ol p,ogr- on Stat ,-,u 6 

OK j( ~ 

Cu tomized Start Menu Dialog Box 

• Advance tab: This tab gives more advanc settings of start menu. By using this 
tab, we can choose options like either to display recently op n document in start 
menu or not. We can also choose to either we want to highlight th newly installed 
program or not. We can also customize start menu items as per users need. 

G-• Advanced 

..._.,)JM!UNOll !hem Mh 
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Customized Start Menu Dia log Box 

53 
Customizing Your Computer 

http:tI"'1()lIIi.lL


54 
Windows and MS Office 4.6 SETTING A SCREE SA VER 

4.6. l What is Screen aver? 

A screensaver is a program that sav s computer screen from over heating. A 
screensaver can be of many types. It c n b a constant moving image or some graphics 
running on comput r constantly or can be a comp! te blackout. Screensaver stops 
immediately when computer notices some movement like rnou e click or key board 
key press. 

To set screensaver all we need to o i' to open display properties of desktop by right 
clicking mouse on empty creen area. When display property window pop-up select 
"screen aver" tab to 

Screen Saver ~pearance Settings 

~creen ' 6 

1 \l✓indowsXP v Seltings J [ Pre_yiew ,-------------, (None) 
30 FlowerBox 
30 Flying Object 
3D Pipe~ 
3D Text 
Bezier 
Blank 
Fish Tycoon 
Ma1quee 
My Piclur Shdeshow 
Mystif_y 
Starfield 

me, Qa.ssword protect 

ower settings and ave energy, 

Pgwer .. 

Cancel 

De ktop Proper ty Window 

In this tab, we hav many options to set r ensaver, choose appropriate option. To 
choose arious available options click on "screen saver" dr p down button. We can 
also set slide show of pictures as creen aver. To do choo e "My Picture Slide 
show" from drop do n and elect the picture you want on your lideshow. 

We can also choos the ize of picture and how often picture should change in slide 
show screensaver. To lret h ize of small pi ture check the check box available on 
the bottom of setting window. 

Transition effects b tween pictures ch ck box will er ate visual effects on selected 
images. And allow scrolling through che k box allow you to change pictures of 
screensav r without topping iL. Once don with all setting click on " K" to return to 
main display etting wind w. 



~ My Pictures ,,creen ~ ver 

How often mould pictures .5ehange'? 

More 

!iow big thould pictures be? 

Smaller 

Use wcturai rn t - folder 

s~econds 

90% oi the screen 

Larger 

C:\Documents co Settjngs\Jenn1fer\My Documents Pre _arowse 

D Stietch small pictureB 

0 ~how iile n.ames 

0 l,! te t1 ans ii.ion effects between pictures 

0 Allow scrolling through piclut e$ with t~ J:ieyboald 

---□-~-~] [ Cancel 

cree aver Dialog Box 

To view all the change made previously cli k on pre i w button. To stop preview all 
we need to do is to move mouse po ition and scr i;;nsaver wiU t p anJ wi ll renl.I'Jl 
back to display property window. 

In er ensaver tab, we can al o set duration which a comput r hould wait before 
staring screen aver. We can also et pa word protect n resume in order to avoid 
unauthorized access. 

T~ D~ktop Screen Saver .6.ppea1anc~ S 11,ig, 

.S. reen rwe1 
[ Se,j ] [ Preyiew 

0 ~ □ 1 m1rnJtes On re-!tlme, pa........a,d piotecl 

Monitor poooe 
T,:, adjt1sl mo~m powei ;etlJiO Md save t!lel.llY, 
dick Power 

__ 0 __ 11 ~ 

De ktop Property indo\ 
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Windows and MS Office 4.7 REVERSING Y UR MOUSE BUTTO AND 

CHANGING THE APPEARANCE OF YOUR 
MOUSE POINTER 

4.7.1 Reversing Your Mou e Buttons 

Reversing mouse button means swiping the working of mouse by default left click is 
for selection and right click is for opening propertie:; of object. We can swap the 
properties like we can change left click for properties and right cl ick for selection. To 
do take the following steps: 

• Click Start Menu and open control panel 

• Select mouse optio available in control panel. 

• When you select mouse option mouse properties window will open. 

• Select buttons tab in mou e properties in order to swap mou e buttons. 

• Select button configuration check box to switch default con.figuration . 

• Once your done sel cting button configuration. 

• Click on Apply bu n. 

~.,. 

Mou Property Window 

Swiping mouse button is very essentia l for those users who work wi th there left hand. 

4.7.2 Changing the Appearance of Your Mouse Pointer 

Mouse pointer classically i a aero ign used for selecting variou objects . This pointer 
can be customized in window. It would be fun to see a different pointer for change. To 
do take the following step : 

• Click Start Menu and open control panel 

• Select mouse option availabl in control panel. 



• When you select mouse option mouse properties window will open. 

• Select "pointer option " tab in mouse properties in order to swap mouse buttons. 

• Select one pointer of your choice from "customize'' list menu. 

• You can also use browse button to select pointer from all the pointer available in 
your computer. 

• Once you are done selecting mouse pointer click on apply 

• As soon as you apply new settings new pointer will appear to you 

• Click ok and exit ettings. 

We can also select various pointer scheme from scheme drop down menu. Using this 
drop down menu, we can change pointer for various occasion. Like while processing 
some application or in busy state the pointer tum into a sand watch or a rotating 
wheel. We can change pointer behaviour on variou occasion. Once done changing 
scheme for pointer don't forget to apply settings. 

a 

Poin ter Tab under Cursor Property Window 
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Windows and MS Office 4.8 ADDING A NEW FO T TO YOUR COMPUTER AND 

ADDING OR REMOVING OF PROGRAMS 

4. 8.1 Adding a New Font 

Before we add any new font in our computer system, we must download it from 
internet. Once it is downloaded we must install the font being downloaded. To install 
the fo nt, open the folder in which font got downloaded. Select the font fil e which you 
want to install and click n fn tall button to copy font in your y tern. This installation 
work is done in control panel using font folder option. 

Before installing a font, make sure you unzip the font if it is in zip form. N w open 
"control panel"' select ' font folder" and install the font you wish to install by 
following the instructions given by comput r. 

4.8 .2 Adding or Rem oving Program 

To add any program, we ne d nol to o much because it gets installed by itself. All we 
need to do is to fo llow the instructions given by the so are program. But to remove 
a pr gram e need to u e control panel option of windo s. ever ever try to remove 
any program from C drive, it may lead to serious problems in operating the system . So 
it is recommended to remove software using ''Add and Remove" ption available in 
control panel. 

....... ~,1. •.&all --~-- - .... . .. ... ..... ........ ,.. .......... ------~ ~ 

Exam ple to h w'Add an Remove Progr am Method 



Take the following steps to remove program using control panel 'Add or Remove" 
Program: 

• Open control panel. 

• Select Add or Remove Program option . 

• Once you choose the above tated option, a pop up window will appear showing 
the list of all the programs and software installed in computer. 

• Choose the program that you wish to remove. 

• Click on "Change or Remove" button. 

• Follow the instructions that your computer asks for. 

• Wait for the proce s to fi nish itself, computer will prompt you once done after 
uninstalling program. 

• Do one stop the process in middle because then the program won t b uninstalled 
properly nor be available for reuse. 

• Once done close the Add or Remove Program window. 

4.9 LOGGING OFF FROM THE COMPUTER 

Logging off computer never means that you are hutting it down. Th.is option is 
available in the start menu along with "Shut Down" button. If you are having a user 
login mode in your computer, you can use "Log off ' option to come out of your login 
and let other to use your r.:omputer. 

It is always recomm nded to have your own user login in order to protect your privacy 
from unauthorized acce s. ---

Dawn· Pedersen 
l. , ..ctr A.~~-...:.._ •-, •- :.,;.__~~:__ __ 

;,..) yOocun 

Mid 

AIPrOQraim 

Logoff Bu tt n m Sta rt Menu 

4.9.1 How to Cr eate a w User Accoun t? 

To create new user account foll w these teps: 

• Open control panel. 

• Select "User Account ". 

• Click on create new account. 

• Enter the name and password that you woul like to ha e as a new user. 
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0 

• The name yo:1 choo e will appear at welcome window. 

• Select account typ . 

• Remember admini trator will have all the rights to chang or d lete any user 
account. 

• And at last click on create account. 

4.10 HIDING AND DISPLAYING QUICK LAUNCH BAR 

Quick launch bar give its user an ability to launch programs themselves. In quick 
launch bar, user can pin shortcut of programs and files that they use most often. The 
quick launch bar was fir t introduced in Windows 98 and ever since has been an 
integral part of window operating system. All we need to do is to drag and drop 
shortcut to quick launch menu. 

4.10.1 How to Disp lay Quick Launch? 

To have quick launch bar in your desktop take the folio ing steps : 

• Click on task bar. 

• Open task bar properties. 

• Check on "Quick Launch". 

Show the Deslltop 

Ta$1,\MaMQer 

Exampl to Demon trat How to Launch Quick Tool Bar 

4.10.2 How to Hide Quick La unch? 

To hide quick launch ollow the same procedure and uncheck the "Quick Launch" 
option of task bar. 

Fill in the blanks: 

I. Desktop is _ _ _ _ _ _ _ 

2. There are _______ and _______ type of start menu. 

3. Screen saver is -------

4. Mouse pointer is u ed for ______ _ 

5. ______ _ i u ed f r adding and removing font. 

6. Logging off c mputer can be done by ______ _ 



4.11 LET U SUM UP 

• This lesson is alJ about changing the appearance of your computer screen, mouse, 
background, etc. 

• We also saw how to use controI panel to add and remove fonts. 

• By using control panel, we also learn to change mouse settings. 

• Now we know what is logging off from computer and how to perfom1 it. 

• We also learnt about the significance of quick launch bar and about various 
options available at quick launch bar. 

4.12 LESSON END ACTIVITIES 

I. Use control panel to install a new font in computer. Download new front from 
internet and create a file in WordPad using new font downloaded. 

2. Try changing appearance of your mouse pointer. Make it ca cade sty le. 

4.13 KEYWORDS 

GUI [Graphic U: er lnterfacejbasic idea of GUI is to how u er their working area on 
which they can perform v rious functions. 

XP [Extended Procedure]: It is a kind of an operating system. 

Exe. [executable file]: Using this file, we run installation of any program in computer. 

4.14 QUESTIONS FOR DISCUSSION 

I. How to hide and di play quick launch menu? 

2. Mention the st p by step process of changing wallpaper. 

3. How to create custom creensaver? 

4. What is log off? Explain its importance. 

5. How to install a new font without control panel? 

6. What do you understand by customizing your computer? 

Check Your Progress: Model Answer 

I. Working area [GUI] 

2. Default start menu, classic start menu 

3. Option to save de ktop from overheating 

4. Pointing objects to open them 

5. Control panel 

6. Log off button at start menu 
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Shelley O'Hara, 2003, Absolute Beginner's Guide to Microso.i Wmdows XP. 

Covers connecting to the Internet, maintenance, applications, and multimedia features. 

Harry L. Phillips, 2012, New Perspectives on Microsoft 1-t'JndoM' 7 foF Power Users. 

Without assuming prior know! dge of the operating system, this text allows students 
to quickly review the basics, and move on to cover m re advanced concepts and 
features. 

Guy Hart Davis, 2007, Mastering Microsoft 1-t'Jndows Vista Home: PFemium and 
Basic. 

The FTP site appears in the Internet Explorer window as a series of links: Click the Up 
to Higher Level Directory link to go ... 1-t'Jndows Live Space was formerly known as 
MSN Spaces before Micro on brought it into the fold of Live services. 
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5.0 AIMS AND OBJECTIVES 

After studying this I sson, you should be able to: 

• Learn about various office suites 

• Focus on why MS Office is best 

• Explore and acquire knowledge on various software program that come along 
with MS Suite package 
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Office suite is a software program used for office work. Jt is a tool for making office 
documents professional. In this lesson, we will learn about office suites and what all 
tools and features a typical office suite has. 

In this lesson, we will al o fo us on how XP office suite i different from other office 
suite available in market. 

5.2 WHAT IS OFFICE SUITE? 

Office suite is a software application program that encompasses a variety of 
applications used for office work. It typically contains word processing tools, data 
base management tool· , presentation tool, data sheet tools etc. 

Each tool has its own significance in office work. These tools are very easy to use and 
have a very user friendJy interface which gives its users an environment to make a 
document more profes ional. 

5.3 DIFFERENT OFFICE SUITES 

In market these days there are a variety of office automation tools are available, one of 
the most popular office suite application is "Microsoft Office" . This application is 
widely used for its simplicity and great efficiency. There are many office suite 
applications available today in market with their own et of pros and cons. Some 
popular office suite applications are as follows: 

Google App for Busine s [G Suite] 

This office suite is from Go gle. This office suite have bu iness version of Gmail , 
goog1e talk, google calendar, google docs, etc. 

Libre Office Producti vity Suite 

This is a free office suite which came from an NGO. Thls application has tools like 
draw, impress, writer, math, etc. The only problem with it i that the support is very 
limited and comes from the community working for NGO. 

Open Office 

This suite is developed by oracle, it include tools like write, draw, math, etc. 

Microsoft Office 

This is the most co only u ed suite by users worldwide it have many versions 
starting from home to students and business to industry. This uite can be customized 
as per requirement. Thi ute typically includes word excel, power point, access, 
outlook, etc. This application i not free but users get limited time period trial version. 

Word Perfect Office X5 

This office suite get customized as per user requirement. This application includes 
, tools like word proce ing pread heets, slide show and presentation, etc. This is not 

a free application but ser may get limited time period trial . 

ZOHO 

This office suite doe not come in form of package. In thi suite, applications are 
individual. This suite is free for its home and student u er. But for business version 
users have to pay. It include t ol Like write, sheet show and calendar. 



K Office 

This is a free office suite. This application includes K word for word processing, K 
cell for spreadsheet and show case for presentation. Since it' s a free tool it largely 
depends on volunteer for update and maintenance. 

Soft Maker 

This productivity tool includes Text Maker for word processing, Plan Maker for 
spread sheet application and presentation. This application is not a free application. 

5.4 MICROSOFT OFFICE XP SUITE 

Office suites are the applications sold in a package with almost same interface but 
with different propertie . One the most popular office suite application is "Microsoft 
Office". 

This application has versatility encompassing a vast ariety of tools and support for its 
users. The reason for it popularity comes from its simplicity and its strong support 
that makes it a user friendly application. A typical Micro oft office suite contains the 
following application: 

• MS Word 

• PowerPoint Presentation 

e MS Excel 

• MS Access 

• One Note 

• Outlook Express, etc. 

MS Word 

It is a word processing tool that offers tools for text formatting and text processing. It 
lets its user to create creative word document. File created in word is called document. 
MS Word is a very popular tool. It is very simple to use. Jt allows us to create 
document containing picrures, sound and videos. Fi les created in word are saved with 
.DOC extension. 

MS PowerPoint 

This tool is used for creating presentation. Presentation are created using slides. A 
slide is like a page that can contain special text, image animation, sound effects, etc. 
By using this tool, we can present ideas in a creative way. Files er ated in PowerPoint 
are saved with .PPT exten ion. 

MS Excel 

This tool is used for mathematical calculations. A file created in excel is called a 
worksheet. We can store related information in one file. A single unit in which data is 
stored is called "cell". We can apply various advance mathematical formulas in a 
work sheet to perform calculation. Files created in excel are saved with .XLS 
extension. 

MS Access 

This tool is used for database management [DBM ]. This tool gives its users an 
integrated environm nt (GUI] to create, update and relate data. DBMS is created in 
tabular form which an be edited easily in care of any error. Unl ike other DBMS tools 
it is very simple to use. It also gives its user a set of very u eful tools to make data 
base. 
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5.4. l What ' s Special about O ffice XP? 

Microsoft Office Suite is a package that has all the possible fac ility to and tools to 
accomplish office tasks easily. What make is so spe ial is its simplicity and support 
that makes it most user ITiendJy office suite. Another factor that makes it so popular is 
its cost. Every middle cla s u r can afford this office suite since it is not that 
expensive. Followin g are the points that make Micro oft Office a very special and 
most user office suite: 

• Mu1tiple version : This suite comes in a variety of versions that satisfy specific 
user need. It has versions like home and professional. All these versions come 
under very nominal price. 

• Simplicity: Th is GUl of this product is very user friendly and hence makes it very 
easy for any user, even if he has very limited computer know ledge. 

• Multiple programs: This sui te contains multiple programs to satisfy the general to 
business user need. It has programs like word for text processing, excel for data 
entry and calculation, acce s for DBMS, etc. 

• Support and help: This product comes with great documentation and online 
support. So if a user get stuck in some trouble, he can take assistance from help 
menu or even can take online help from Microsoft MSDN to troubleshoot 
problem. 

• Global tool: File created in Microsoft suite are readable on all platforms. If in 
some specific platform file is not readable then Micro oft provides plug-ins to 
open document. File created on MS suite are accepted worldwide as a standard 
professional document. 

5.5 VOICE DICTAJ'IO AND VOICE COMMANDS 

Voice dictation and voice command is an inbuilt function of Microsoft office suite. 
This tool allows the users to give dictation instead of writing all the time. This tool is 
particularly helpful for physically handicap users. I o use this tool II we need is a 
good microphone that an take your commands to computer. 

This built in sot'tware will convert your speech into lexl in a respective program 
currently open in MS Offi e Suite. 

5.5.1 How to Inser t Voice D ict i n? 

To insert voice dictation take the fo llowing steps for example in word we insert voice 
dictation like this 

, T§,ble w,ndow tf.elp 

!,_anguage 

~ ord Count.. . 

.,,, Speech 

F7 

Alt+Cbck 

Shared Worls5pace ... 

L!.!_t ters and Mailings 

f\_utoCorrect Options . . . 

~ustomize ... 

Qptions .. , 

Tool Menu Speech Opt ion 



• Open MS office suite. 

• Select the program that you want to use. 

• Go to Tools drop down menu . 

• Check Speech option. 

• Make sure your microphone is connected to your computer. 

Before you start using voice command to input text, you must enroll with speech 
recognition programs. Take the following steps to enroll in voice recognition program: 

,- - -- - - ·- - - -- -- - - - . - - - - .. . - ., 
fr Microphone Wizard - Adjust Volume · L8J 

Read the following sentence in your everyday tone of voice 
until the volume meter level conslstentl·1 stays in the green 
area : 

"I am using the Microphone Wizard. 
It is adjusting the volume of my microphone." 

1
1 

Help ] Click Help for rnim1ph,~nc tips if the volume 
meter does not move dll you are speaking , 

< Back 

Voice Training W iza r d 

• Click on "Start" to open "control panel". 

• Select "Speech Recognition" to open speech. 

• Connect your microphone and follow the , teps that wizard 1s asking you to 
accomplish. 

• Setup wizard will ask you to perform certain ta k in ord r to enroll with voice 
recognition. 

• Once you are done with your training then click on '' tart Speech Recognition". 

• A small window will open containing small window with microphone will open. 

• Now launch your Microsoft office program in which you want to insert voice. 

This program gives you the option to modify text when understood by computer 
incorrectly. This tool is not very popular as hands free tool since it reql!lire specific 
accent to insert voice and data. Asian users have different accent compared to US 
accent or UK accent. 

There are very fair chances of errors which need to be modified manually. Hence, this 
tool is not very commonly used. 
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Smart tags are also referred action tags. This tool help us to increase productivity 
and often save a lot of time when the smart tags are string with the text containing 
some information associated with that tag. When some instance occurs matching that 
string then smart tag gets triggered. 

5.6. l How to Use Smart Tag? 

Smart tags are denoted by purple doted underline. To know what action you can take 
with a smart tag all you need to do is move your mouse to that purple underline. When 
you move your mouse over it mart tag action button will guide you what action you 
can take with that smart tag. 
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Smart Tags 

5.6.2 How to Insert Smart ag? And how it Works? 

To insert a smart tag take the following steps: 

• Open any office suite program in which you want to add a mart tag. 

• Go to "Tools'' drop down menu. 

• Select "Auto correct options command" . 

• Select now "smart tag" tab . 

Tools > AutoCorrect Option comm nd > Smart Tags tab 

Each smart tag recognizer identifies a type of data such as name, date, or telephone 
number, and is designed to provide one or more actions for each data type. 

When you type a texl with which a smart tag data type is associated with, then it 
denotes it with purple doted underline and gives the list of po sible action associated 
with data type. 

For example, if you hav created a smart tag with "Name" and then you enter name in 
"name data type" then smart tag wi ll get trigger and gives you option and possible 
actions that can be taken on name data type. 



5.7 ASK A QUESTION BOX 

The ask question box i a new way of finding help for MS office suite applications. 
The ask box is the most convenient way to get instant help . This box is placed at the 
top right corner of every window application. 

5.7.1 How to U e A k a Question Box? 

To use ask a question box all we need to do is type a question associated with office 
application. Every application will be able to provide answers to its own application 
not of any other software of MS suite. 

For example, if you are having trouble with "functions" in excel then you need to type 
functions in ask question box to get all the help with reference to function. 

• Ask a question box provides the list of all possible help qui kly. 

• This method will match the typed string with all possibility. 

• To access help referring to the topic typed lick on the available option that 
matches you need the best. 

• It is recommended to type question more clearly to get appropriate help. 

5.8 DOCUMENT RECOVERY 

This feature is the mo t helpful feature of office suite. It allows its user to recover the 
document not saved properly. Depending on the version of MS office, there is more 
than one way to recover in.fi nnation of a document being lo t. 

5.8. l Why to Save a Document? 

It is very important to ave document in order to read it again. If we will not save the 
document then it won't be available for further use. It i een very often that work 
done on a particular application does not gets saved properly which may result in 
serious loss of information. To 'overcome this we use "Recovery to0l" . 
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5.8.2 How to Recover a Document? 

In Word 2007 and below w have a fi ature called "Auto Save'. This tool keeps on 
saving updates mad on document in every IO minutes. We can i.ncrease or decrease 
the time period for "auto save" . Take the following steps mentioned ahead to do so . 

This helps a lot in saving information lost happen due to malfunction of computer 
system. 

Wor d Opt ion Dialog Box 

• Open any offic application for example word. 

• Click on the word menu on top left side. 

• Click on save tab. 

• Now change the time. 

• Close the tabs and start working again. 

But what if malfunction oc urs before th auto save triggers? 

If a malfunction occurs then all you can do is to re-launch the office application. The 
software program will search for the "Auto save" file while tarting if found any, then 
it will show the auto recovered file on left side of the window and you can resave this 
like following the normal pro edure. And hence the file i recovered. 

Remember that this is not a ure short method to recover infonnation, so it is very 
important to reduce the recovery time [ using above method] in order to reduce the 
chances of loss . 
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5.9 PRODUCT ACTIVATIO r 

This is the first step of installing any product on your c mputer. This process requires 
the product setup that you need to execute on your computer to achieve all the tools 
and function of product. Setup ill is called .exe file . . exe tands for executable file. 
Before activating a software product in your computer you need to buy the license of 
it. Some software ersions allow you to download the product directly from internet 
and also I t you to us the product fo r limi ted free trial p riod after experiencing its 
productivity. ou can decide whether y u want to buy it or not. While some software 
product com s on D's and DVD's which you need to buy from market. 



Every software product will have one product key which will remain unique to 
product. This key i u ed to activate the product. Thi key i also responsible for 
validating your product authenticity. To install MS Office take the following steps: 

• Click Start , point to ett ings, and then click Control Panel. 

• Double-click Add/Remove Programs, click Add New Programs, and then 
click CD r Floppy. 

• Click Next. 

• Click Browse. 

• Locate the root fo lder of the Office source location, click Setup .exe, and then 
click Open . Setup.exe is add d to the command line that appears in the Open box 
of the Run Installation Progr am dialog box. 

• Click Finish to run Office S tup. 

• If requested, type your customer name and product key (CD key) infonnation in 
the appropriate boxes, and then click Next. Note The Next button is not a ailable 
until you type a valid product key. 

• Accept the End User License Agreement, and then click Next. 

• Specify the location where you want to install Office, and then click Next. 

• On the Choos which applications for setup to install page, lick Next. 

If you click 

Choose deta iled in tallation options for ea h application on the hoose which 
applications for setup to install page, and then click Next, the fi ature tree appear on 
the Choose installation options for all Office applications and tools page. Becau e 
Office Setup detects that you are using Terminal ervices, only the instaHation states 
that are available are Not Available and Run fr om My Computer . 

Common Elements of the Suite, Introduction, Different Integrated Items in Office 
Suite, Menu Bars and Toolbars, Shared Tools, Objects, Linking, Embedding, Office 
Assistant and Online Help. 

Fill in the blanks: 

1. Office is a software. - - ---

2. Office suite contains _____ and _ ____ fundamental programs. 

3. MS Word is used for -----

4. MS Office is popular because ____ _ 

5. Voice diction and voice commands are feature of - ----

6. Office ta k pane provides quick access to ____ _ 

5.10 LET US SUM UP 

• This lesson is all about office suite package programs. 

• This office uite programs are used for helping user to do task much fficiently. 

• There are variou kind of office suite package available among those also MS 
office is one the most popular option. 
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• This suite has option like voice dictation and voice command. 

• Voice command and dictation are particularly helpful for physically handicap 
users. 

• By using smart tag, we can gain quick help, by using task pane, we gain quick 
access to most frequently options and files. 

5.11 LESSON END ACTIVITIES 

1. Use internet to find out all the pros and cons of all available office suite 
application. 

2. Create a document using voice command. 

5.12 KEYWORDS 

!vJS short form of Microsoft 

G suite short form used for google office. 

NGO [Non-profit organization] works on no profit no Joss basis mostly for social 
causes. 

/ 
.DOC [eJttension of document fi/e]extension used for MS Word files . 

. PPT [exte.nsion'ofpower point file] extension used for MS Power Point files . 

. XLS [extension of excel file] exten ion used for MS Excel files . 

. DBMS [extension ofac file] extension used for MS Access files. 

GUI [Graphic User Jnterface]ba ic idea of GUI is to show u er their working area on 
which they can perform vari u funct ions . 

. 13 QUESTIONS FOR DISCUSSION 

I. How to activate a produ t in computer? Explain in ste by tep process. 

2. What is office suite? 

3. What is task pane and smart tag? 

4. Explain all the methods of file recovery in MS office. 

5. Expla,in the signi fi cance of ask ques tion box. 

6. Write a brief note on all office suites available in marker. 

Check Your Progre : Model An wer 

l. Application program 

2. Text manipulation, data manipulation 

3. Text manipulation 

4. It is simple and e y to use 

5. MS Office suite 

6. Frequently used programs 



5.14 SUGGESTED READINGS 

Jennifer T. Campbell, Steven M. Freund, Mark Frydenberg, 201 6, Shelly Cashman 
Series Discovering Computers & Microsoft Office 365 & ... 

Gary B. Shelly, 1995, Microsoft Office. 

Advanced Concept and Techniques expands on those projects, showing you 
additional capabilitie that help increase your productivity. With Introductory 
Concepts and Techniques, you'll gain a better understanding of Microsoft Office 

· Manager. 

Joesph Habraken, 2001 Microsoft Office XP 8-in- l. 
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6.0 AIMS AND OBJECTIVE S 

After studying this 1e son, you should be able to : 

• Focus on anatomy and menus of MS office suite 

• Learn about the significance of office suite application tool and menus 

• Focus on tooils that are common in all office suite of Micro oft 

6.l INTRODUCTI ON 

This lesson is all about the anatomy of office suite application. We will focus on 
various available tool bars and menu bars. We will also I am about how to take help 
for office suite application u ing internet. We will see how to correlate files created in 
different applications of office uite. 

6.2 DIFFERENT INTEGRATED ITEMS IN OFFICE SUITE 

Office suite software's omc in package. So all program will contain some common 
features that make us call it a package. Integrated items are tho e programs or options 
that every software und r one ·uite must have. Integrated items ar also those items 



that every software will have. Every office suite will have the fo llowing compulsory 
features: 

• Word processing 

• DBMS 

• Information processing 

• Presentation 

• Online support 

• E-mail, etc. 

Every office suite wiU have the following mandatory functions that remain common in 
all the programs of office suite. 

• Create 

• Update 

• Delete 

Every office suite will allow its user to make new documents, this is called create 
operation. User can update or modify pre exis ting file, this method is called update. 
Deletion of files allow user to remove file from computer. 

Since there are many kinds of office suite availa le in market, some software will 
have some functions and some wiLI have some other functions. Anatomy of every 
office suite program will have following features: 

Fonuntng toolllar Btandn to 

• Every program will bave a title bar to display the title f currently open document. 

• Every program will contain drop down menus Ii e File Edit, Help, etc. 

• Every program will contain tool bar that allows you to fom1at a file as per 
requirement. 

• Every program will have a status bar that will display the current status of 
currently open file like word count, language zoom, etc. 

• Every program of office suite will contain help tool to enable support of product. 
Support can be online and offline. 

• Office suite contains linking and embedding tool ' t link your file with internet or 
with other file in other program. This allows the user to navigate from one part to 
another part without actually opening it. 
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Menu bar and toolbar are very important to any office suite application. Using these 
toolbar and menu bars, we can make files more professional and productive. 

Example of Menu Bar and Toolbar 

6.3. l Menu Bar 

This bar is located at the top of th window below title bar in any typical application. 
This bar will contain multiple dropdown menus for text and data formatting. Menu 
bars are also known as dropdown list since it drops do n when clicked. Every menu 
bar will contain the following options: 

• File: This menu will contain options like open, ave, close, new, etc. options 
differ from one version to another. 

• Edit: This menu will contain options like cut, copy and paste. It will also contain 
options like redo and undo. By using this menu, you can elect the entire content 
of a file. Although all the e function can also be performed with keyboard shortcut 
key. 

• View: This option ontain the command that control tbe view of document. Like 
layout, zoom, header and footer, etc. 

• Insert: This menu will allow you to insert pictures, clip art, hyperlinks, footnotes , 
chart and tables, etc. By u ing this menu, we can make a file more interactive. 

• Format: This menu ontains commands for editing the layout of your document. 
This menu contains option like font, text effects, etc. 

• Tools: This menu contains functional tools that are applied on an entire document 
like it have options of pell check, auto correct, etc. that enables the corrections on 
document automatically. 

• Windo"'.S': This menu contains commands from the currently opened window. It 
has options like minimize, zoom, etc. 

• Help: This menu will bring the help as per user requ irement. This menu can work 
both online and oftlin . 

6.3.2 Toolbar 

Toolbar is a horizontal bar just below the file menu. This tool tray contains various 
tools for file modification and helps its user to perform a variety of task with ease. 

Every office application is loaded with multiple tools for helping the user. Tools differ 
from application to application, like fo r example excel tool tray will contain tools for 
inserting formula wherea PowerPoint application will contain tools for slide 
modification and insertion. There are basically two kind of toolbars one functional 
toolbar or main toolbar the other one is object toolbar. 



• Functional or main too/bar: This tool bar contains tools uch as print, save, help, 
zoom, etc. this toolbar has the basic fun tion on a file. 

• Object too/bar: This tool bar contains object tool with reference to current open 
file, like for example if you make the font bold in your fiJe then bold font will 
appear in your current opened fil only and not in any other file. These toolbar are 
objectifi ed for pecific file only that is they are called object tools. 

6.4 SHARED TOOLS 

Shared tools in office suite are those tools that are available in all the versions of 
office uite. Shared tools are also those tools that every application in office suite will 
have. For example, print, this tool is found in all the applications of office suite 
package. Shared tools have changed with increasing needs for consumers some got 
discontinu d, some got modified whereas some remained the rune as wh n 
introduced. Some common shared tools are as fo llows: 

• E quation Editor: Thi tool is used for making mathematical equations. This tool 
is included in all commercial applications of Microsoft Office. This tool is no 
longer a default tool for making equations. 

• Microsoft Graph: This is originally known as Microsoft Chart. This tool is used 
for making charts in applications like Excel and Acces . Office supports many 
types of chart. In office 2007, new graph engine was introduced which support 3 D 
graphs to make visualization of graphs more intere ting. 

• Word art: This tool i available in 30 different styL · of Microsoft Office suite. 
This tool enable us to create text with various effects uch as starched, rotated, 
etc. This tool is available from a very long time though it can be modified using 
customize tool bar. 

• Smart art: Smart art is special form of a grapl that hows hierarchy. It allows user 
to insert text in it to show wh t this graph i about. There are about 115 smart art 
available in Microsoft Office uite. Smart art is available in under smart tab of MS 
Office. smart art change its colour, theme style, etc. to match current document 
formatting. 

6.5 OBJECT LINKING AND EMBEDDING 
Object Linking and embedding is supp rt d by Micro oft Office. By using this 
method, we can access the content of one program in another program. For example, 
you can link excel file in word document or vice v rsa. We can create object of only 
those program that supports object linking. L ink remains as a separate fil e, it cannot 
be updated. Like if you Linked a X file in a Y fi le and later you made chang s in X file 
then those changes will not be brought to X file . Anyways we can remove the link and 
can also rel'ine the file in order to get updates. 

6.5.1 When to Use Linking of an Object? 

We use object linking between files when we want a file to get updated using object. 
Remember the source file remain unaffected. For example, if we are using object 
linking between X and Y file, we hav er ated an obje t of X file in Y fi le. Then we 
made some changes in Y file using obj ct only as a re ult, object file will get updated 
not the source file. 

6.5.2 When to Use Embeddin of an Obj ect? 

We use object embedding when we want the source file to be viewed only. When we 
embed a file in another file then source file can only be viewed. This is one method of 
hiding source file from modification. 
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Office Assistant is an animated character of MS office that brings help for various 
topics. This office as istant was named as "Clippy''. Thi fea tu re was introduce in 
Office 97 and got discontinued in Office 2003. However most of the users find it 
annoying hence got di continued. Office Assistant is a function that helps us to find 
help regarding anything in office suite. 

I lool<s Il<e ya/ e 
wrltn;! a letter . 

WOJld yru 111.te he\;,7 

8 Get help With 

wr ltrg lhe letbar 

• Just lype the " 
IBtll!r wnt,c,ut • 
help 

MS Office Help 

Online help is a feature of office suite to take help for various topics from the internet. 
All the programs in office uite ha e their own help function but if you are looking 
for some very speci fic olution Lhen you can take onl ine a sistance. For example, if 
you want to insert picture in a word document 1':en yo can browse internet to see the 
process and steps invol ed in ins rti ng a pict1 re in a document. Remember that by 
using help search, you c n only browse oftline help and for further references help 
browser will redirect you Lo the internet by itself. Online as istance is a very helpful 
feature of office sui te for beginner . To get instant help in MS office press shortcut 
key . 

Cl11.:ck Yuur Prnl..(rcss 

Fill in the blanks: 

l. Word art have ______ styles. 

2. _____ _ mart art are available in MS office uite. 

3. Linking and embedding is used for _ ____ _ 

4. key is u ed for instant help. ------

5. There ar and kind of toolbar available ------ ---- - -
in MS Offi e. 

6. Edit menu is used for ------

6.7 LET US SUM UP 

• In th i I son, we aw all the ba. ic a ai lable features of MS Office sui te that are 
common to all M flice programs. 

• In this lesson, we gained knowledge about all the available menus of office suite 
programs. 



• ow we know alJ the shared features of office suite programs. Shared featur~ are 
those feature· that remain common to all th ·oftware in office suite. 

• By using help we an earn knowledg about variou - functions of office suite. The 
h Ip function works both online and offline. 

6.8 LESSON END ACTIVITIES 

I. Use internet to make a document containing all possible help function of MS 
Office. 

2. Use various menus of MS Office to explore its functionality. 

6.9 KEYWO RDS 

DBMS: It stand for Database Management System. 

Fu11ction/Main Too/bar: lt contain tools such print, ave, help, zoom, etc. 

Format Men u: Thi menu contains commands for editing the layout of the document. 

6.10 QUESTIONS FOR DI CUSSION 

1. How to get help in MS offic using internet? Elaborate. 

2. Explain anatomy of MS office menus u ing diagr m. 

3. Why we need linking and embedding of object ? 

4. Write a short on shared tool of office uite. 

5. Differentiate between linking and embedding in detail with example. 

Check Your Progress: Model Answer 

1. Font 

2. Word art 

3. Dynamic object conn ctions 

4. Fl 

5. Standard tool bar, formatting tool bar 

6. Editing options 

6.11 SUGGESTED READINGS 

Jennifer T. Campbell, Steven M. Freund, Mark Frydenberg, 20 16 'helly Ca hman 
Series Discoverin Computers & Microsotl O/B e 36 & ... 

Gary B. Shelly, 1995, Microsoft 0llice. 

Advanced Concepts and Techniques expands on those project • showing y u addi­
tional capabilitie that h Lp increase your productivity. With introductory Con epts 
and Techniques, you'll gain a better understanding of Micro oft Offi e Manager. 

Joesph Habrakan, 2001 Micro oR 0flice XP 8-in-J. 
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7.0 AIMS AND OBJECTIVES 

After studying this les on, you should be able to: 

• Aim to gain knowledge about task panes 

• Know about the ignificance of task pane 

• Be aware about how to use these task pane? How to add and remove task pane? 

• Acquire knowledge on different types of task panes 

7.1 INTRODUCTION 

The task pane was introduced in MS Office 2003. This feature brought a major change 
in the GUI of office suite. Task pane is a multipurpose window located at right side of 
window anatomy. Following are the features that every ta k pane will contain. It is 
also known as global ta k pane. The purpose of task pane is to provide quick access to 
useful and most often used functions. Every application will have its own task pane 
with different options. 



7.2 OFFICE TASK PANES 

New File Task Pane: The function of this task pane is to provide a quick file 
formation . This task pane also shows the templates that other files have used so far. 

Office Clipboard Task Pane: It enables you to cut, copy or paste items from clip 
board to your new document. We can paste near about 24 items on the clipboard. 

Clip Art Task Pane: It all ws user to look into office clip art gallery to paste clip art 
in new document. 

Search Task Pane: It enable user to search for a fil e or an application of MS office 
suite. 

Research Task Pane: This enables its user' s to take research references from internet 
and use that research in new file. Online references ervic s are accessed by 
"Microsoft Encarta". 

Task Pane 

Office Task Pane 

7.3 DISPLAYING AND HIDING AT ASK PANE 

Task pane is a utility that every program in MS o ice have. It brings those options 
that are most frequently used. To enable a task pane in MS offic follow the given 
steps: 

• Click start to open MS office. 

• Select program that you wish to open. 

• Once selected program opens up go to "View" tab or menu. 

• Now check ta pane check box . 

• Task pane wi ll get docked on the right or left s1d of window [depending on the 
version of MS office]. 
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Window, and M Offi c: 

Enable this 
check box 

Window Showing Option to Hide Task Pane 

7.3. l Hiding Ta k Pane 

Task pane i a very helpful feature but sometime the user find it very annoying. In 
that case, w can alway hide it. When w u e hjde option to disable task pane at that 
time the ta k pan will disappear from application GUl . To hide task pane take the 
following steps: 

• Op n the application by clickfog stat menu. 

• lick on view tab. 

• Now uncheck th task pane. 

• Ta k pane will di appear. 

We can also clo e task pane by clicking on clos option available t tas pane title bar. 
But this m thod will clo e task pane temporarily. When we open the same application 
again then task pane wiU re-appear. This method is only u efuJ when we don't want 
the task pane to stop forever. 

7.3.2 Additional Task Panes 

Additional Task Pane are tho e ta k panes that appear within the ta k pane. Once ta k 
pane gets tarted there ill be multiple options available to help the user perform task 
with ul using drop down menu . In task pane title bar, there are 3 small buttons. They 
are used for opening th1: task pane menu, auto bide ta k pane and cl e task pane. If 
we click down arrow then la.s.k pane menu will app ar. The m nu of task pane will 
have follow ing options: 

• Find: Thi option will help us to find pecifi file in current directory. 

• Go to: This opti n will take u to specific location in current directory. 

• Recent file and folder: Thi pane is specifically very helpful for saving fi les 
quickly. We can al o op n rec ntly edj ted file from this pane. 

• Replace and spelling: This work is same as spell check and find and replace 
option. 

Additional task pane , arc aJso classified a differ nt options a ail ble in different 
application. Every application in MS Office wi ll contain task pain by default but 
options will differ like when we use ta k pane for PPT pre ntation . At that time, task 
pane in PPT will have option like clipart, lide, etc. When we use MS Word task pane 
will con tain options for text formatting mail merge etc. 

Every ta k pane will have ome elements of common features and some additional 
feature which i er from one applicat ion to another. 



T ask ·Pane Window Options 

7.4 TYPES OFT ASK PANE 

New File Task Pane 

The function of this task pane is to provide a quick file formation. This task pane also 
shows the template that other files have used so far. 

Office Clipboard Task Pane 

It enables you to view cut, copy or paste items from office clip board into your new 
document. We can paste nearly about 24 items on th clipboard. You can remove 
items from the Office Clipboard at any time by placing the mouse on the item. A drop­
down arrow appears; click the drop-down nrrow and ·elect Delet from the hortcut 
menu that appear . You can clear the entire Clipboard by clicking the Clear All button 
at th.e top of the task pane. 

Clip Art Task Pane 

It allows user to look into office cl ip art gallery to paste clip art in new document. ln 
the task pane's Search For box type keywords that Office can use to ind your clip art 
images. Use the Search 1n drop-down box to -pecify the collections you want to 
include in the Up art arch. Se! cted collections are marked with a check mark in 
their check box that you can toggle on and of with a simple click of the mouse. Use 
the Results Should Be drop-down box to spe ify the type of files that should be 
included in the search. You can select or d select the different file types such as Clip 
Art, Movies and Sounds. When you have fin ished tting your search parameter , 
click the Search button. When the search is complete. the clip art that meets your 
search criteria appears in the task pane. In the Image Ii t, locate the image that you 
want to place into your Office document. Th n lick the imag . The application 
inserts clip art into document. 

Gip rt Pane 

83 
Office Task Panes 



84 
Windows and MS Office 

Search Task Pane 

It enables user to search for a file in computer or network. To specify the locations 
that should be searched, click the Sele ted Locations drop down box. You can expand 
any of the 1 cations Ii ted uch a My omputer, by clicking the plus (+) symbol to 
the left of the location. This enables you to view folders and subfolders at that 
location. U se the heck boxe to the left of each location to specify whether that 
location should be earched. We can al o specify the type of file we are looking for in 
office suite application. To do so, refine your search parameters by using multiple 
avai lable options . 

Research Task Pane 

This enables its user to take research refer n from internet and use the re earch in 
new fi le. This task pane also enables us to create data that can be used fo r future 
references. When w u e re arch ta k pane, it loo s for the string in all o.ffice 
applications to implement research process. This task pane is the most recent addition. 
Online reference ervices used by research task pane are accessed by "Microsoft 
Encarta". 

Help Task Pane 

This is also now a tandard ta pane used for fetching help fo r MS office 
applications. 

Insert Clipart Task Pane 

Using clipart is a great way to explain things. By using clipart task pane, we can insert 
clipart to programs like Word Excel, PowerPoint, etc. This task pane mak it very 
easy for users to ins rt clipart in a file, all we need to do i to earch for a cLipart . MS 
Office clip art task pan will look into the library of clipart and show the output that 
matches the search parameters. 

The output will appear in the form of a thumbnail. 

How to Use Clipart Ta 'k.Pane? 

To use clipart task pane take the following st ps: 

• Select any applicalion of MS office. 

• Now select insert and point at picture. 

• Now select clipart, pre s enter or double cl ick. 

• Clip art task pane will appear. 

• To find clip art, use dip art search box. 

• Use the Search In drop-down box to pecify the collections you ant to in lude in 
the cl ip art search. Selected collections are marked with a check mark in their 
ch ck box that you can toggle on and off with a simple click of the mouse. 

• Us th Results Should Be drop-down box to sp cify the type of fil es that should 
b included in the search. You can el ct or deselect file types such as Clip Art, 
Movies and Sound . 

• Once you are done with setting of search criteria then click on search to get cl ip 
arts. 

• Now select image as per requirement. To select image daub! click it when you 
double cl ick image, i1 gets inserted to th orking area of program. 



7.5 STYLES AND FORMATTING TASK PANE 

This task pane was introduced in Office 2002 and it brought significant changes in 
working with styling and fonnatting of word file . This task pane is at right side of the 
window. By default, word provides many tyles to format a document but it also keeps 
it hidden. No matter we choose any style or not, by default some style wiJI be applied 
to a file. Style applied automatically to a file is called default style. 

Style and Formatting Task Pan 

7.5.1 How to See All Your Styles? 
• Format > Styles and Fonnatting. On the right, you'll ee th Styles and 

Formatting ta k pane. 

• In th Show box, select Custom. (No, don't choo e 'All Styles'. Microsoft's idea of 
'AU Styles' does not mean all the styles. True!) 

• You'll now see the Format Settings dialog box. From the Category Ii t choose 
"All Styles" . Then cli k Show All and click OK. 

• Back in the Style and formatting pane, in the Show box., choose All Styles. 

• Thi ta k pane also keeps the record of most frequently used style. 

• Go to Tools > Options > Edit. If you tick the Keep Track of Fonuatting box, then 
Word will keep track of the formatting you have ever used in this document. 
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• Style and formatting pane provide the list of all the styles used in a fi le. In early 
versions there were only two styles namely paragraph style and character style. 
But in Office 2002, thi feature of hawing all available tyle was introduced. 

Style and Formatt ing Ta sk Pane 

7.5.2 What all I can do with Style and For matting of Task Pane? 

• Apply style to y ur text. 

• Se what style and formatting you bave used in a document. 

• Creat new style. 

• Modify exi ting tyle. 

• Select all text or a part of a text to apply new style. 

• To see the description of all formatting and style used. 

• To keep track of most frequently used style. And much more all we ne d to do is 
to experiment and explore. 

7.6 MAIL MERGE TASK PANE 

This task pane gives you step by step assistance in creating document that can be sent 
as an -mail to various user at a same time. This task pane give you the facility to 
acce s file without actually opening them. Using this pane. we can e-mai l files to 
saved contacts on another application. 



Mier soft Word use a task pane to help users complete a mail merge and this is 
automatically displayed when you click the Finish button. The Mail Merge task pane 
adopts a step by step approach to mail merging and i shown b low. 

Srlect~ 
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Mail Merge Ta k Pane 

When you click the Finish button on Booking Pro's Mail Merge Wizard steps 1, 2 and 
3 of the task pane are automatically completed so you should click the Next: 

Stey4 of 6 

Mai l Merge Ta k Pane 
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Use MS Word to edit your document if required cl ick next once fini shed editing 
document. Use preview function to vi w your document. 

Edit recipient list if n ces ary, click next to fi nish mail merge process . 

Complete the merge 
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Mail Merge Task Pane 

This is the final step of the mail mer e and you can either use the Print option or 
the Edit individual lett r .. . option to complete th mail merge. 

To e-mail your letters use the ~ .Merg to E-mail option on the Mail Merge toolbar 
(rather than the task pane). The toofbar is illustrated below but you may need to drag it 
t a new position on your toolbar to be able to view it easily. 

Mail M r ge T o I Box 

C licking Merge to E-mail di plays the foll wing form . 

.__ _ __,1 r er-:a 

Mail Merge Dial g Box 



Simply select the Contact E-mail item in the To: dropdown and enter a subject for the 
e-mail. Finally click on the OK button to send the e-mails using your e-mail software 
(e.g., Microsoft Outlook). Please note that when you click the OK button, the e-mails 
are sent without any furthe r intervention from yourself and you do not have any 
opportunity to review the e-mails before sending. 

Fill in the blanks: 

I . Task pane wa introduced in _ _ _ _ _ 

2. Task pane window is at _ ____ side of window. 

3. Task pane provides _____ access. 

4. To display or bide use _____ opti n. 

5. Clipart after earching appears as _ _ __ _ 

7.7 LET US SUM UP 

• In this lesson we learnt about the significance of ta k pane. 

• Know we know about di fferent types of task pan sand their use. 

• We can hide and display task pane using view tab. 

• To insert clipart, we use insert clipart task pane to style text. 

• We use style and formatting task pane and to create e-mails we use mail merge 
task pane. 

7.8 LESSON END ACTIVITIES 

1. Using mail merge option and mail merge task pane send e-mail to your friends. 

2. Use clipart task pane to inset clip from clip art library. Try to insert some image 
from clip art gallery. 

3. List the detaiis of all style used in a file. 

7.9 KEYWO RDS 

GUI [Graphic User Interfa ce] basic idea of GUI i to how user there working area 
on which they can perform various functions. 

MS is short form u ed for Microsoft. 

PPT [Power Poin t Pre en tation] extension is used fi r MS PowerPoint files. 

7.10 QUESTIONS FOR DISCUSSION 

I. What is task pane? 

2. Differentiate between research task pane and search ta k pane. 

3. Write a note on clip art task pane. 

4. How to use mail merge task pane to create an e-mail? Explain in steps . 

5. Explain all the additional task pane. 

6. What do you under tand by style task pan_e? Explain with upporting diagrams. 
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Check Your Progre s: Model Answer 

1. MS Office 2003 

2. Left comer of window 

3. Quick access to frequently us d programs 

4. View tab 

5. Icons 
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8.0 AIMS AND OBJ ECTIVES 

After studying thi les on. you should be able to: 

• Use MS Word proficiently 

• Use different features of MS Word 

• Know about MS Word's tools and menus 

• Become aware about MS Word file types and file manipulation 

8.1 INTRODUCTION 

Word processing is a software program that all ws it user to make t , t files. T xt 
processing is far more then just text. It encompas · a vast variety of tools and function 
to facilitate its u er to: 

• Create files 

• Update files 

• Delete files 

Word processor programs enable u to create, delete, manipulate store, retrieve and 
print fil es. A fi le created in a typical word processor is called a "document". These 
programs help us not only to type a file but it al o help in corre ting wrong words. 
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we can have a variety of fonts, we can a copy part of text without retyping it, we can 
insert figures, pictures, pecial character, etc. 

These all features of word pro e sor make it a very strong tool for office automation 
because it ubstantially reduces the effort for creating a new document. 

8.2 FEATURES OF WORD PROCESSOR 

Word processor programs enable us to create files containing text, pictures, graphs, 
tables, special text, etc. The e all features are not available in traditional manual 
typewrite. To u e word proce sor a user does not need to acquire any special skills. 
User with limited computer knowledge can also use the word proce sor program 
easily. 

The following are the features of word processor program: 

Typing 

All word processor allow their u ers to in ert any kind of text in a working area of 
text processor. In any text processor, there is no limit to add text in a file. We can copy 
text to any part of a file. We can create paragraphs. We can a.I o delete or move any 
part of the text. Cutting a part of the text is a different operation of file manipulation 
and copying a part of text is a different operation. 

We can copy a part of text many times within a file or in a11y otber file also. But if we 
cut a part of text, we can only paste it once in any part of a ti le or any other file. 

Sa ving 

All text proc ssor allow their user to save the work on any part of the hard disk 
[HDD]. The saved work i called document. lf we try to exit text proces or without 
saving the fit content then text processor prompts its u er to save the work. lf there is 
an event like power failure then most processor allows their user to recover the lost 
progre ·s. 

Adding Removing and Applying Text [Find and Replace Operation] 

This operation of a word processor allow you to change any string with another 
string. Once thi option i cho n then it is applicable to entire docum nt currently 
typed. or example, if you wi h to change tring' ram" with "Rama" then in find box 
you will type "ram' and in replac box you will type 'Rama" and then press ok to s e 
the hanges in entire current document "ram" wiJI get replaced with "Rama". This 
whole proce s is done automatically, no manual interfer nee is required. 

Change Style 

Every word processor program i loaded with a variety of tyles and font, we can 
choose any of it as p r our requirement. 

Spell Ch eck of Words 

This feature of word proce or notifies user on the event of spelling mistake by 
underlining the mi taken word with red colour. It also noti.lii;s the grammatical errors 
by underlining them in green colour. Although we can ignore the pelling mistake or 
grammatical errors but it is alway strongly re om.mended to correct. 

Header and Footer 

This function allow er to add details to a document. Header and footer note are 
used for adding details to a page. Header and footer note are water mark effects that 



cannot be removed. Header note is displayed at the top of a page whereas footer note 
is at the bottom of a page. 

Numbering and Bulletins 

This function is used to for making points and keeping track of them. By using this 
method, we create emphasis on a specific line or sentence. Sentences with bulletins 
will display a mark at the beginning of sentenc.:e with no number on it. 

Insert Pictures, Ta bles and Graphs 

Every word proces or program allows us to insert pi nares table, graphs, etc. to make 
document more interactive . We can insert pictures by browsing it on HOD. We can 
add 3D tables and graphs to show how data differs. 

Print Preview 

This function of word processor allows us to view th final picture of document about 
to get printed. This is very unique and important fea e of word processor. If user is 
not satisfied with the look or any other thing related to document, he can always go 
back to page and make nece sary chan·ges. 

Mai/Merge 

Mails merge option is u ed for creating e-mails. By using this function, we can send 
documents to through e-mails. 

Macro 

We can create macro for certain type of repeated work. AJI we need to do is to insert 
macro in pface where retention is necessary. Hence it ave a lot of typing time. 

8.3 MS-WORD - A POWERFUL WORD PRO ESSOR 

MS Word a most commonly used 'text processor. It allows you to create documents far 
more than a plain text. What makes it so powerful i it simplicity, clear GUI and 
interface. For working on MS Word no one need any special training we can learn it 
on trail and error ba is. The first edition of MS Word was released on 25 th October 
1983. Ever since MS Word is the most commonly used word pr cessor. By focusing 
on the following points, we can understand why MS Word i mo t powerful word 
processing tool. 

Saves Time 

MS Word have a lot of tools and methods to make document quickly. We can copy 
text from anywhere in MS Word and can modify the same text as per requirement. 
Tools and function support in making document look m re professional. Using MS 
Word is much faster and efficient method of creating d cu meats. 

Quality 

MS Word is capable of creating error free document o the qua lity of document 
cannot be questioned a far as errors are concerned. Spell check and grammar check 
are features that enforce quality. 

Enhance Document Appearance 

In MS Word, ther are many formatting tools that are used for enhancing the 
appearance of a document. Like we can use various font frames , colourful fonts, 
images, etc. to mak a do um nt look more decorated. 
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Allow Sharing of Document 

We can share a document over internet, with friends, in office and anywhere we think. 
MS Word is supported by mo t of the OS so it makes it easy for us to open and read 
file without being worried about readability. We can also send MS Word files through 
e-mails and other digital mediums. 

Security 

MS Word offers strong security fi atures in order to protect documents. MS Word has 
password protection to invoked security. By using pa word, we can prevent the 
document from unauthorized a c ss. 

8.3.1 Starting MS-Word [F u r Methods to Open MS-Word] 

To open MS Word is very simple, all you need to do is to click on start button-> then 
select all programs -> then click on MS office, there wi ll be many programs under MS 
office package. Select "Microsoft Word" double click or press enter to open MS 
Word. Other than this there are few more methods available to open MS office. 

Method 1 

Click on start button type [word] without bracket in search box. Select "Microsoft 
word". 

Method 2 

Open window dialogue by pr ssing window key and 'R' key together. Type 
[WinWord.exe] in run dialog box. Remember this method is case sensitive. To have 
successful output type it exactly like as it's mentioned above. 

Method] 

Right-click on an empty area of the Windows 7 desktop. Hover the mouse pointer 
over "New" in the menu that appears. Click "Shortcut" . "Type or copy and paste 
"C :\Program Files\Mi rosoft 

Method4 

Click start menu select "All programs" point on Micro oft Office select "Microsoft 
Word". Double click or pres enter to open MS Office . 

8.3.2 Chief Elements ofM -Word Window 

There are various window elements in MS-Word. Each element has a specific task. 
Each tool has its own role in document formation . 

Title Bar 

This bar is used for showing the title of document. Title of any documer.t is the name 
given at the time of aving the file . If document is new or we have used no name while 
saving the file then title bar will show "untitled document". 

Control Buttons 

Along with title bar there exists control button to clos or to mm1m1ze or to max1m1ze 
the window. Maximize option will open window to display size. 

Menu Bar 

Using these drop down menus, w can do a lot of task Like to save a file or to open a 
file or to print a document et~. These drop . down menu will also have standard 
formatting options al . 



Standard Toolbar 

This toolbar exists just below the menu bar. It is a tool bar conta ining standard file 
operations like open new tile, browse folder, sear h, cap or lower case alphabets. 
Using this tool bar i ea y and is a quick alternative of drop down menus. 

Formatting Toolbar 

This toolbar is used for fonnatting text. By using this toolbar, we can change font, font 
size, make paragraphs, justify text (left, right or centre), etc. 

Workspace 

Workspace is the a tual working area of MS Word that we use for inserting text. 
Working area is located at the centre containing blinking cursor that moves as we 
type. 

Status Bar 

Status bar is used to display the current status of document. Thl bar is at the bottom 
of word window. This bar displays useful information like word count, page count, 
language of document, etc. This tab is particularly h lpful when we want to keep the 
track of document status. 

Scroll Bars 

Scroll bars are the horizontal and vertical rulers. Thes scroll bars help you to traverse 
through a document. The size of a scroll bar increases the number of pages in a 
document. 

Task Pane 

Task pane window is used for proving quick solutions. Ta k pane is at right most 
comer of window. 

Title B..­
Menu B~r ­
St11nd11NI -

Toolb11r ~ 

Formattint 
Toolb~r 

MS Word Window Classic tyle 

Component Functionality r Purpose of the Component 

Menu Bar Contains File. Edit, View, Insert, Format, Tool • Table. Window and Help menus. 

Standard Toolbar Contains i on ·· for shortcuts to menu commands. 

Formatting Tool Contains pop-up menus for style, font , and font size; icons ~ r boldface, italic and 
Bar underline; alignment icons; number and bullet list icons; indention icons, th_y 

border icon, highlight and fo nt colour icons 

Contd ... 
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Ruler Ruler on which you can set tabs, paragraph alignment, and other formats. 

Insertion Point Blinking vertica l bar that indicates where the text you type will be inserted. Don't 
confus the insertion point with the mouse I-beam. To move the insertion point, 
just click the mou e where you want the point moved. 

End-of-File Non-printing symbol that marks the end of the fi l . You cannot insert text after this 
Marker mark. 

Selection Bar Invisible narrow strip along the left edge of the window. Your mouse pointer 
(Gutter) chang s to a right-pointing arrow when it is in this area. It is used to select a line, a 

paragraph, or the entire document. 

Split Handle Double-click to split the window in two (to view different portions of the same 
file) . uble-click to return to one window. 

Status Bar Displays page number, section number, and total number of pages, pointer position 
on pag and time of day. 

Task Pane Displays and groups commonly used features for conv nience. 

Office Assistant An animated character that can provide help and suggestions. There are multiple 
characters to choose from, and it is possible to tum the Office Assistant off. 

Displaying and Hiding the Too/bar 

Method 1 

To show or hide the toolbar take the following steps: 

• Open MS Word. 

• Click on "View Menu" (drop down menu). 

• Click on the check box that you want to display. 

• Uncheck those toolbars that you wish to hide. 

Method2 

• Open MS Word. 

• Right click on the menu bar or toolbar depending on version. 

• A pop-up menu will appear. 

• Now select the toolb r that you want to display and uncheck those you want to 
hide. 

8.3.3 File Operations in MS-Word 

File operation encompasses a vast variety of operations that one can perform to gain 
maximum performance. File operations are as follows: 

New 

This operation lets you create new fi le. When we select the new option we get black 
template. If you made any ch nges in other fiie, it will get removed and settings will 
return to default. 

Open 

This option will let you browse the file saved on any location of hard disk. Using this 
operation, we can acce e temal drive also like pen drive, et . 

Close or Exit 

This option is used to clo e a currently open file. Using cross button, we can close 
currently open file. 



Save 

By using this option, we can save file on any location of computer. Save option by 
default saves file in "My Document". We can choose any location by browsing the 
folder. In save file option, there are two option "Save" and "Save as". Save as is used 
for saving file for first time. When we select save a option to save file, then it 
displays one pop-up window asking you to give some name to the file. From this pop­
up window, we can choose the location or a specific folder to save a file. Whereas 
"save" option is used to save the recent updates made in a file . 

Dialog Box to Save F ile 

Cut 

By using this option, we can cut a part of text. Ctrl + X is a shortcut key used for 
cutting a part of text. Ctrl + V is the shortcut used for pasting the ame text later in any 
part of the current document or any other text file. When we use cut option to cut a 
part of the text then thi operation takes hold in the memory temporarily. Once the text 
is pasted then it cannot be pasted again. And if system failure occurs then cut, paste 
goes back to its original file. 

Copy 

This option is used for copying a part of text or full text again and again. Ctr! + c is the 
shortcut key used for copying part of text. Ctrl + V is the shortcut for pasting the 
copied text. If system fail ure occurs l[[ike power fai lur or any other unnatural cause] 
then copied text is washed out from memory. If copied text is not saved then the 
copied text will get washed out of memory. 

Paste 

This option is used for pasting copied or cut text to any part of the file or any other 
file . This option is like a transport device that transports text from one part of file to 
another file. Paste option is program independent. Meaning we can use Cut, Copy and 
Paste option in any type of file. For example, copy or cut some part of text from MS 
Office to Notepad. 

Search 

This option is used for searching any file using MS Word earch. The searched file 
will get open in new window. To search any file we can u e task pane. 
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Print 

This option of file i used for getting hardcopy of document. Ctr! + P is used for 
printing document. ln MS Word, we have one option known as "Print Preview", this 
option is used for viewing document final look after being printed without actually 
printing it. If not happy with current look we can alway. go back to the document and 
make necessary changes and then have the printout. We can choose to print document 
in various size like A4, AS, A6, etc. We can also choose to have landscape or portrait 
printout. Having colourful printout is also possible if you have any image or any 
colourful font in a document. Make sure your printer have colour ink to bring 
colourful printout. 

We can make various changes in printout like number of pages wanted as printout, 
margin, etc. 

1t: 
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Print Dialog Box Containing Print ing Options 

8.3.4 Using Help OnJine Customizing Office Assistant 

Office Assistant is an animated character of MS Office that brings help for various 
topics. This office as i tant wa named as "Clippy". This feature was introduced in 
Office 97 and got discontinued in ffice 2003 . However, most of the users find it 
annoying hence it got discontinued. Office Assistant is a function that helps us to find 
help regarding anything in office su ite. 

It looks like you're 
writi1g a letter . 

Wau k:I yo.; like help? 

~ Get re lp with 
wr ltln;J the letter 

• .ust type the 
latter w ithout 
help 

r Don 't show me 
this tip again 

Office Assistant 



Demonstrating Help Dropdown and Other Options 

Online help is a feature of office suite to take help for various topics from internet. All 
the office suite programs have their own help function but if you are looking for some 
very specific solution then you can take online ass istance. For example, if you want to 
insert picture in a word document then you can brow e intern t to see the process and 
steps involved in inserting a picture in a document. Remember that using help search 
you can only browse offline help and for further references h Ip browser will redire t 
you to internet by itself. Online assistance is very helpful feature of office suite for 
beginners. To get instant help in MS office press shortcut key. 

Fill in the blanks: 

1. · Ms Word i - ----- tool. 

2. is the extension used for M Word file. ------
3. ______ menu is used for creating new file. 

4. Spelling heck i 

5. Status bar displays _____ _ 

6. ____ _ key is used for instant help . 

8.4 LET US SUM UP 

• In this lesson, we have seen what is MS Word what are the different menus of MS 
Word how to use various tools and menus of MS Word. 

• We have seen various file opera tions possible in M Wor . MS Word is a text 
processing tool having verity variety of tools to make professional documents. 

• The use of MS Word does not require any special kill, au r with basic computer 
knowledge can easily work on MS Word. 

• MS Word has strong online support to trouble hoot its users MS Word related 
problem. 

• You can print your document in Word by specifying your own specifications. 
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I. Create an MS Word document in all possible ways. 

2. Perform all file op rations on document. 

3. Try printing your document in landscape mode. 

8.6KEYWORD 
.DOC extension of MS Word file. 

GUI display area in which user makes entry and performs processing. 

HDD is short form of Hard Disk Drive. 

JD is short form of Three Dimension. 

Ctr/ is a key present in keybo rd used for word processing and it stands for control. 

A4, A5, A6 are sheet type u ed while printing a document. 

FI shortcut key is used for help in word. 

8.7 QUESTIONS FOR DISCUSSION 

I . What is MS Word? Explain. 

2. Compare other word pro es ing tools with MS Word. 

3. Explain the steps involved in process of printing. 

4. What do you understand by file operations'? Explain. 

5. Explain significance of help in MS Word. 

6. How to save a document? Explain. 

7. Write a note on hid ing tool bar. 

8. Explain all the element ofMS Word with diagram. 

Check Your Pr gr s: Mod l Answer 

I . Text editing pr gram 

2. .txt 

3. File 

4. Spelling validation 

5. Current state of MS Word window 

6. Fl 
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9.0 AIMS AND OBJECTIVES 

After studying this lesson, you should be able to: 

• Learn about text formatting 

• Explain the significance of text formatting 

• Discuss how to do te t formatti ng? 

• Describe how to in crt text and how to perform text manipu lation? 

• Discuss the signifi cance of pelling check and grammar check 

• Explain the various features of advance text formatti ng 

9.1 INTRODUC JON 

Formatting text or d cument stands for making changes in default settings. Tool bar 
have both text formatting and document formatting tool . These tools help us to 
design document more efficiently. Text fomrntting is u ed for making changes in 
written content wherea document formatting is for making changes in document 
appearance. Formatting helps us to make things look di fferent from usual. 

9.2 TYPING THE TEXT, SELECTING TEXT WITH A 
MOUSE, DELETING TEXT AND RESTORING THE 
DELETED TEXT 

9.2.1 Typing the T xt 

To insert text in a MS Word document is easy all you need to do is to open MS Word. 
Take the following st p to insert text in MS Word: 

• Click on start 

• Point on all "All Programs". 

• Select MS Office. 

• . Point to MS Word. 

• Press enter or double click to open MS Word. 

• Once MS Word get loaded then you will see MS Word GUl with menus, toolbar 
and a blank page with a blinking cursor on it. Th.i Linking cursor is called 
"Insertion Point". From th.i place, we start entering text in a MS Word document. 



Text Insertion Point 

Document Area 

MS Word Window Showing Text Area 

There are a few things need to be kept in mind while entering text in a document, first 
is that you need to pre s enter key to start a new line in MS Word, the text proce or 
will automatically take you to new line once it \: ill reach the end of the document. 

Second is to use tab key when you want bav more then one space between two 
letters. Through this way you can align text later much effici ntly. 

9.2.2 Selecting Text with a Mouse 

To select text u ing mouse all we need to do is to drag the mouse with holding click 
button to select the text. To select text all we need to do is to open MS Word, then 
open a file containing some text or create a fil e containing some text. By selecting 
text, we can do many ta ks at once like 

• Remove part of the text at once instead of using back space again and again. 

• Can copy or cut some part of text by selecting. 

• Can move text from one page to another. 

To select the text is easy and a very common task in word. All we need to do is a bit 
of practice to achieve perfection. When we perfonn text election using a mouse then 
mouse icon change from aero to "I beam" icon. 
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M usa,ptl 

H mlet., a rNn from Denma,~I 

Changed Cursor in MS Word 

Now all we need to do is to click hold the mouse pointer to select text. Drag the mouse 
pointer till the point y u want to make text selection. And release the mouse click 
when you are done. We an also use mouse aero keys to select text. Once you are 
done with selecting of text a per requirement then perform required formatting . 
Remember that if you click anywhere on the working area of MS Word while 
selecting text then the elected text will return to normal text and you need to select 
the text again to app.ly the e changes. 

Manuscrlp 

Hamlet from D nm.irk 

rd on watch were 

Highligh t T ext Selection Examp le 

Here are a few easy l ction techniques for mouse lovers: 

• To select a word, d uble-click it. 

• To select a single line of text, click in the left margin next to th line. 

• To select a sentenc , hold down [Ctrl] and then click anywhere in the sentence. 

• To select a paragraph, click three times in the paragraph. Alternatively, click twice 
in the left margin next to the paragraph. 

• To select the entire d cument, click three times in the left margin. 



9.2.3 Deleting Text 

This is one of the most common techniques used for removing content of document. 
We delete the text when ome mistake occurs. You can delete the text using ba k 
space key. When you use back the space key to del.ete text then on character at a time 
gets removed. This method of deleting text is very easy and safe. This method is safe 
because user carefully removes the text character by character. 

But when we wan t to delete a large amount of text then using the back space can be 
very time taking. 1n such cases, it is recommended to select a part of text that you wish 
to remove and then press delete button. By using this technique, we can remove a 
large amount of text at once. 

Use the above stated method to select text in order to perform group delete operation. 

Key deletion method 

Backspace 

Keep the insertion point ju. t aft r the character you want to delete and press the Backspace key. Word 
will delete the character immediately to the left of the insertion point 

Ctrl + Backspace 

Keep the insertion p int just after the word you want to delete and pn: ·s Ctr!+ Backspace key. Word 
deletes the whole word immediately to the left of the insertion p0iut. 

Delete 

Keep the insertion p0int ju ·t before the character you want to delete and press the Delete key. Word 
deletes the character immediately to the right of the insertion point. 

Ctr I+ Delete 

Keep the insertion point just before the word you want to delete and press Ctr! + Delete key. Word 
deletes the word imm diately to the right of the insertion poi nL 

Select and Delete Method 

Deleting text between two poin ts 

Click at the start of the block of text, hold down the Shift key, and click at the end of the block to 
select the portion of text and finally press either the Backspace key or the Delete key. 

Deleting a single word 

Double-click anywhere on the word you want to delete and fmalJy press ei ther the Backspace key or 
the Delete key. 

Deleting a paragraph 

Triple-click anywh re on th paragraph you want w delete and finalJy press either the Backspace key 
or the Delete key. 

Deleting a sentence 

Hold down the Ctrl key and click anywhere in the sentenc you want to delete and finally press either 
the Backspace or the Delete key. 

Deleting a column of text 

Hold down the Alt key, click and hold the mouse button, and drag o er the column you want to delete 
and finally press either th Backspace key or the Delete key. 

Deleting a line 

Bring your mouse in the el ction bar area and click in front of the lme you wont to delete and finally 
, press either the Ba kspace key or the Delete key . 

Deleting entire document con tent 

Press Ctr! + A keys to delete the entire document and fi nally press either the Backspace key or 
the Delete key. 

--
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9.2.4 Restoring the Deleted ext 

To restore the accidently lost text we perform undo operation in MS Word. Undo or 
redo operation is applicable lo all window base applicati n. This method will undo the 
last operation done. This is bow we can bring back the lost text in word document. 

In MS Word, we have two methods to restore text. This method is particularly helpful 
when we loose some urgent data. Jf there is a case Qf system failure then restoring text 
is not possible. Methods for restoring text: 

• Ctrl + Z are the short ut keys used for restoring text. 

• Click on Edit drop down menu then select undo option to re tore lost text. 

• Open recycle bin, find your lost document. Right click on document and then 
select "Restore" from properti s pop-up menu . 

9.3 TYPING OVER THE EXISTING TEXT 

Insert key on the keyboard allow us to replace text as we type. To make insert key 
work like this we need lo et it up in "Word advanced option" and check "overtype 
mode". 

When we type text in overtyp mode in word to the right of the insertion point, we 
type over the previously typed text. To invoke overt type mode take the following 
steps: 

• Open MS Word 

• Choose file drop down menu. 

• Select options fro m file drop down menu. 

• In word option dialog b x elect advanced . 

Word OptJons X 

l(j t-dva.nce<J op1,on, tor "or ng v,ith ;ord 

Ok C..nul 

M Word Adva nc Text Selection Dia log Box 

9.4 UNDOING/CANCELLING THE LAST ACTION AND 
REDOING/REPEATING THE LAST ACTION 

Undo and redo are two options availabl in word to repeat the most recent activity or 
to undo the most recent activity . B th options will pe orm the same task but in 
opposite order, like redo will bring ba k the text recently added in a document 

http:1Ol.ct.on


whereas undo will delete the text recently added in a document. Deletion or addition 
of text will be done in the same order in which they are added in a fi l . 

To perform redo or undo there exists two buttons on title bar. It looks like bended 
arrow just click on those button respectively to perform the action required . 

Redo and Undo Buttons 

To see how redo and undo work type some random text in a blank document and then 
click redo and undo button . Redo button will re at the same text recently typed 
whereas undo wi ll delete the text recently added in a docwnent. 

In MS Word, we have a shortcut key combination to perform redo and undo 
operations. To undo the previous action we use ctr! + z and for redoing the previou 
action we use ctr! + y shortcut key combination. Remember that if last action was 
undone then ctrl + y redo will not work. 

9.5 FORMATTI G FONT 

Formatting text is about hanging the default appearance of text content. While we 
format text we actually format font, and formatting i done only for current document. 
When you start a new document then the previously formatted ettings will disappear 
and word will again cti play default settings only. nee you fo rmat the font then it i 
applicable to entire document although you can al o fomtat specific part or character 
or letter also. Under font formatting, we will focus on the following topics: 

• Formatting font ize 

• Formatting font colour 

• Formatting font tyle 

• Turning font into bold, italic or underline 

• Formatting font case 

• Aligning font 

9.5. l Formatting Font Size 

Formatting font ize is about increasing or reducing th font ize. You can change the 
font size for entir document or for some specific pan of text. By default font size in a 
new document is eleven. 
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• To change the font ize select text you want to modify . 

• Click on the number dropdown to select size. 

• Size drop down is along with font style. 

• Choose the number a per requirement. 

• Press enter to see the changes. 
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Text Size Drop Down ti r Reducing or Increasing Text Size 

9.5.2 Formatting Font Colour 

The default font colour is black though we can change the font colour to add more 
decoration to a document. Font formatting option is available in the formatting 
toolbar. To modify fon t select the text that you wish to change, now click on font 
colour box drop down s lect colour from drop down. The moment you select colour, 
text processor will change the colour of the selected font that time itself. We can 
choose various colours in one document there is no limit for colour modification . 

.... 

Second 

Colour Selection Drop Down 

9.5 .3 Formatting Font Style 

Formatting font is used for changing font style. To format font t ke the following 
steps: 

• Select text you wish to modify. 

• Click on font style bo to hange font tyle. 

• Select one font styl that uits your requirement. 
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9.5.4 Turning Font into Bold, Italic or Under line 

To change font in bold, italic or underline select text that you wish to modify. When 
we make the font bold it looks thicker and darker, when we modi fy font in italic style 
then the text looks a bit starched, and when we make font underline then text will have 
line under it. We can make text bold, italic and underline all at once whereas we can 
choose one option oaJy. 

Pagil! Layout 

• 20 

)C 

bold , 

Font Style Button s 

9.5.5 Formatting Font Case 

To modify font case elect the text you wish to change. When we modify font case we 
actually change front from capital to small or small to capital. To change the font case 
click on "change case option". Select one from the fo llowing: 

Sentence Case 

This option will tum the entire text line by line removing all tab and paragraph. 

Lowercase 

It will tum the entire elected text in small character. 
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Uppercase 

This option will tum the entire selected text into capital letters. 

Capitalize Each Word 

It will tum the first haracter of a word into capital. 

Toggle Case 

It will tum the selected text' s first character in small and rest all will remain capital. 

I.' ln,e,t Page uyout ReclertnCt!l I I o~ 

Callbrl . 20 . . . ...., - . ·= A 1- -
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Text Case Drop Down 

9.5.6 Aligning Font 

Select the text that you wish to align select one option from the paragraph group, 
choose one option from the available four option . Avai lable options to align 
paragraph are as fo llows: 

Align Left 

This option will shi entire s lected text to the left margin. 

Align Right 

This option will shi entire text to the right margin. 

Align Centre 

This option will arrange text in centre of working area. 

Justify 

This option will arrange text in equal distance from left and right. 

=F-~ 1-rn ~ 

= = l ~-I 

Text Alignment Drop Down 



9.6 CUSTOMIZING SPELLING CHECK 

Customizing spelling ch ck is a feature of MS Word that allows you to create 
spellings of your own. % en you customize spell ing check, you actually add word to 
the dictionary of MS Word. 

Why we need to customize spelling check? We need cu tomization of spelling check 
because there are ituations where we want to use some word in a document and that 
word doesn ' t exists in a word dictionary then we need to add that word to MS Word 
dictionary. 

What if we don ' t modify dictionary? If we do not cu tomize spelling check then word 
processor will show the word as spelling mistak that doe n' t matches its dictionary. 
Words that are not standard English are termed as pelling mi take in word. 

· Imagine you want to use word "Ramanand" in a word, but it is not an English standard 
word, so it will be displayed as a spelling error in word document. 

To overcome this problem we need to add this word to dictionary. It is easy to locate 
errors in document as they are flagged with r d line under it. MS Word gives 
suggestion to correct error. But if you don't want to use that suggestion then you can 
either ignore error or can add to dictionary of MS Word. To add a word to dictionary 
take the following steps: 

• Open MS Word. 

• Create new file . Or you can choose any existing file al o. 

• Insert some text in a fi le. 

• Make some deliberate mistake. 

• Now right click on error word. 

• Choose Add to Dictionary option from the pop-up menu. 

• Now error word is a part of the MS Word dictionary. 

Ignore will ignore all current spelling m.istake. 

Ignore all option wiU ignore all the mistakes in current document. 

Add to Dictionary option will add word to MS Word library. 
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This is an additional to I of MS Word to find synonyms (different word with similar 
meaning) and antonyms (word with opposite meaning). This tool is particularly 
helpful when we want to create a complex document. Take the fo llowing steps to use 
thesaurus: 

• Open MS Word. 

• Insert text in file. 

• Click anywhere on working area to find synonyms. 

• To open thesaurus click on review menu. 

• Select proofing option from review menu. 

• Select thesaurus, pre s enter. 

• Now, thesaurus tas pane wi ll start. 

• You can search fo r to search word. This task pane will give the list of alternative 
word that can be u ed in a file . 
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Thesaurus Task Pane 

If you had selected a word in your document, the word you elect in the Research pane 
will replace it. If not, the word will imply be inserted into your document where the 
cursor was positioned. 

If you want to continue your research and look up further synonyms for another word 
in the list, click on it. That\\ ord will be placed in the Search for box and its synonyms 
will be displayed in the li t. 
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9.8 ADVANCED TEXT FORMATTING 

Advance text formatting is about enhancing the overall appearance of a document in 
order to make it look more professional. Under advance text formatting, we will focus 
on the following topics: 

9.8.1 Using Page Border 

We use page border to enhance the look of text and to create emphasis over specific 
text take the following steps to add border to text. 

• Select the portion of text or paragraph to which you want to add border. Use any 
selection meth d to do so. 

• Click on bord r and hading option available in formatting toolbar. 

• Select one option to draw border. Select by clicking it. Try adding different border 
by clicking diffi rent option available. 

• If you don't want border for the selected text you can undo the action or select no 
border option. 

llo<d~r Opt ic,n &order Buthln 

Border Buttons 

Home tlb j\pplled fiord r llo<d a.tttQn 

Border Button 
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Add Shades to Text 

To add shading to text take the following steps: 

• Select the portion of text on which you want to apply hading. 

• Click on the border button. 

• Select border and shading option available at border button. 

• Click on shading tab to apply shading. 

• By defau It "clear" is th shading style applied to text. 

• Select appropriate style. 

• Click on ok to exit dialog box. 

Hometib dlngtab 

Border nd Shading Dialog Box 

9.9 BULLETS AND NUMBERING 

In MS Word, it is very simple to create list. We make list using numbers or bullets in 
MS Word. In MS Word, Ii ts are created using toolbar. In toolbar, there exists a tool 
for inserting list. 

To create list first put the cur or to the place from where you want to start your list. 
Or you can select the t xt that you wish to get converted into list. Click on bullets 
button if you wish to make a li t without any numeric order. Click on numbering 
button if you wish to make an ordered list. You can also choose bu llet style. You can 
also choose number style (numeric, roman, alphabetic, etc.) in order to make efficient 
list. 
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Bullet and Numbering Drop Down 

You can create sub-lists. These sub-lists are called multi-lists. It is simple to create 
sub-list; press the Tab key to put items in sub-list. You can try it y urself. 

9.10 SETTING AND REMOVING TAB STOPS 

Tab stop is term used for de cribing the location at which the cursor stops after tab 
key is pressed. This tool is u · d to align text using tab key. 1n Microsoft Word, the tab 
selector, also called the tab indicator, is a button to the left of the ruler that supplies 
the user with a variety of tab marker options. It is very common to insert tab stop in 
word document. You can insert tab stop before or after inserting text. Tab stop 
changes from section to section within a single document. Each line can have its own 
unique tab stop. 

Types of Tab Stop 

• Left text is extended to the right of the tab. 

• Centre text is allied in middle. 

• Right text is extended to the left of the tab. 

115 
Tel(! Formatting and 

Document Formatting 



116 
Windows and MS Office 

• Decimal text before the decimal point extends to the left and text after the decimal 
point extends to the right. 

• Bar a vertical bar is shown on the tab. 

9.10. l How to Crea te a Tab Stop? 

The easiest method to create tab top is to double-click on the ruler, this wi ll open the 
tab window pop-up as shown b~low. From this tab window, you can specify type of 
tab stop and can also specify the positioning from tab ·ndow. 

F"":B 

- ! OI( 

Tab Stop Dialog Box 

9.10.2 How to Rem ove a Tab Stop? 

To remove tabs stops in Word from the ruler for a selected line (or lines), first click 
into the line of the document you wish to change, or select the lines you wish to 
change. Next, click and drag the tab stop you wish to remove from the horizontal ruler 
and drop it into the document area. That will remove th tab stop from the selection. 

9.11 MAKING WORD COUNT AND USING AUTO TEXT 

9.11.1 Making Word Count 

Word count is a very unique feature of S Word. using tbi feature we an keep track 
of words used in a document. Thi to I is specifically important when you have word 
limit to make a document. Word count is available at tatus bar of every MS Word 
window. This tool i n tu ed very often. When we cl i k on word count in MS Word 
we can see details of each and every charac ter used. 

How to Open Word ount? 

There are two ways to open word count in MS Word using tatu bar and by using tool 
drop down menu. By u ing any of me hod, we get details f fi le we get every 
information about fil e like as follows: 

W Coun• 
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Using Status Bar 

By this method, all we need to do is to click on "words" option a ailable at the bottom 
of word window. When you click on the word option then it wiU display all the details 
of character used in document. 

Using Tool Option 

Using tool drop down menu, we can extract information about word fil character 
usage. All you n ed to do is to click on tool menu and select "word count" option. 

9.11.2 Using Auto Text 

The auto text is a way to use some part of text that is used most often. Using auto text, 
we can save great deal of time. To insert auto text aU we need to do is press enter to 
word suggestion made by auto text. 

Auto text appears only when the current type text matches the library t xt of auto text. 
So in order to have your own auto text you must add phra es to auto text library. Take 
the following step to add words to auto text library: 

• Open MS Word. 

• Click on insert menu. 

• Select Auto Text. 

• Click on Auto text to insert word in it. 

• Enter phrase in "Auto text entry" text box. 

• Click on Add button to add phrase to auto text library. 

---
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Auto Text Tab in Auto Correction 

Take the following step to use auto text in MS Word: 

• Open any existing file or create a new file. 

• Insert text in file . 

• Insert phrase that you added previously in aut text library . 

• Phrase wi ll appear as suggestion made by auto text. 

• Press enter to accept auto text suggestion. 

-I ~ 
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Figure Showing How Auto Text Wor k 

Auto text option is he lpful in situation where you want to u, e a particular word 
repeatedly. Imagine you work £ r a finn and in every document you have to use the 
name of firm again and again, o it is much convenient to u e auto text instead of 
typing it again and again . 

Using Autocorrect 

MS Office auto correct i an automated feature that corrects spelling mistakes 
automatically. This method reduce the time of correction as perform correction by 
itself as it appears. We can di able Auto orr ct option by uncbecking the auto correct 
chec box available in tool menu. You can also add word to auto correct library. If 
you feel annoyed with auto correct option you can tum it off. To tum off the auto 
correct function fo llow the given tep : 

• Go t Tools menu, sele t options. 

• Click on " Spelling and Grammar" tab . 

• In spelling area check or un heck "check ·pell ing as you type'' check box. 

To add entries in auto coITect library take the following steps: 

• Go to tools menu. 

• Select autocorrect. 

• Click spelling and grammar tab. 

• Enter a word in '·replac •· text box. 

• In "with" text box enters the correct word that you want to get auto corrected. 

• Click on Add button. 

• Click on Ok to exit. 
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orginized 1 organized 
otehr -- other _J 

otu out ~ 

I 
P AutomatJca ly us 

Addin g to AutoC orrect through the dialog (Word ;-::P/2003) 

If you are doing speUing check then you can add entri through the right-click menu: 

• Right click th underlined word and select "Autocorrect' . 

• From sub menu elect the most suitable word. 

organi!ie 
organi!ied 
organi!ie!i 
organi!ier 

[gnore All 

8dd to Dictionary 

.6,ytoCorrect • 
Language 

'
1 

~pelling .. . 

C " 

Easte 

Word XP/2003 

• organi!ied 
organi!ie!i 
~gani!ier 

8UtoCorrect Options ... 

Deleting Entries from AutoCorrect 

9J.9 ani.ze 
organise 
organise!i 
organiser 

Ignore AB 
a_dd 

b.anguage ► 

~ ~elllng •• 

To delete entries from AutoCorrect take the foUowing step : 

• Go to the Tools menu and select AutoCorrect (Word 2000) or AutoCorrect 
Options (Word XP/2003). 

• Click the Spelling & Grammar tab. 

I I 9 
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• Scroll through th list at the bottom of the tab and c lick on the entry to be deleted. 

• Click the Delete button. 

• Cl ick the OK button. 

9.1 2 HEADERS AND FOOTERS 

Headers and footers are a very integral part of MS Word document. By using header 
and foo ter notes, you can add details to fil e and final reader wiU get a brief idea about 
conten t of file. 

Generally header notes like the name of company or Jogo, etc., 

Header note appears at the top of the document page. On the other hand, footer note 
are placed at the bottom of page and typically displays page number. Once header or 
footer notes are added to a document then they are applied lo all the pages of current 
document. MS Offi bas various styles of header and footer note. Take the following 
step to insert header or footer notes: 

For Header Note 

• Open MS Word. 

• Creat new file or open exi ting file. 

• Cl ick on insert tab. 

• Then click on header button. 

• This option will display built-in header select any style by simply clicking it. 

• All header note styles are editable. 

• Type header note as per your requirement. 

• Once done writing clo e ribbon. 

• Header will appear at right corner of th screen. 

For F oater Note 

For inserting footer note, the method will r main same as header note. But instead of 
header button cl ick on footer button, select the style of footer note. Commonly footer 
note have page numb rs. Footer note are also available in editable mode add details to 
foot r note if required. Close the ribbon. We can align footer note to centre, left or 
right comers. 

Ins rtingP g Numb ringandFormatting th ePage Numbcriag 

You can insert page number only to a document without in erting footer note to it to 
do ·o following the giv n step : 

• lick on insert tab. 

• Click on page number button avaiJabl at header and footer section. 

• You can set the page numb r on bottom, current, top po ition of document. 

• Use mouse point r to sec various available options for inserting page number in a 
document. 

• Choos style of page number from available various styles. 

• Once done with applying setting clo e header and footer mode . 

• Andy u will see that page number will appear at the applied po ition. 



In rttllb Option Menu 

... 
headt s, II 

c<Mtr ~lfl, and other ' . plcn-ei. chlrtt, 0t 

dlaarams. dleV also coor, ' !tl'Oct , Pave Nwnbt 

You can usily c:N,c• lhe form• nc ol selecced tell\ In te 
loolc f« the selKU<I tht fro,n de Sty! gall b. You can 1110 

son H 

Drop Down for Footer Note 

b Close Header end Footer 

lnSllfled P p Numbflr 

Footer Note Insertion Example 

9.13 MANUAL AND AUTOMATIC PAGE BREAKS 

Page break is a technique to control the end and beginning of a document. We ins rt 
page break to the point where we wish to end page. Page break i not a mandatory part 
of MS Word you can add and remove it. To insert page br ak take the fo ll owing steps: 

• Bring yow- insertion point immediately before the text that ha to appear on a new 
page. 

• Click the Insert tab and click on the Page Break button available tn the Page 
group. 

I 21 
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,,r-,m,u111 
illlllt.lll 

Example Showing Man ua l and Automatic Page Brea k 

Word inserts a page break and move all text after the page break onto a new page. 
You can also use manual method to insert page break, to do so use ctr! + enter key 
combination or use ctr! + return key combination at the pointed location. 

To remove page break automatically and manually take the fo llowing steps. Though 
you cannot remove page break that word inserts, you can only remove those page 
break that you insert d manually. 

• Click on the Show/Hid ymbol, which appear a a paragraph mark (,) on the 
Home tab. This will how hjddeo non-printing characters such as spaces and page 
breaks. 

~o .., . ~~ , . . ~,l,f'•(r""s .... "~·"--~i.i. ..,... . 

,,... ~ ~r I Itri .. • l(.r-4.,,,..,,..r: Y.•I.J-•J l r-.~"" ..... ,. , L.t.M .. "11 ,;,.~ ,J ., .. 

-------!lo-· 

Page Break 

• Double click th break you want to remove. 

• Press delete. Although you can't remove automatic page breaks, you can adjust 
where they land and thus keep specific paragraph or lines together. 



9.14 SETTING MARGINS 

Margins are spacing between text and the edges of MS Word page. By default, a new 
document's margins are set to normal , which means it has a one-inch space between 
the text and each edge. Depending on your needs, word allows you to change your 
document's margin size. There are five types of margin style avai lable under margin 
style tab namely : 

I. Nonnal 

2. Narrow 

3. Moderate 

4. Wide 

5. Mirrored 

TopM rein 

Example Showing Margin Options 

Take the follow ing steps to set margins in any word d cum nt: 

• Open any xisting document or create a new document. If you wish to apply 
margins to ·pe ific part of document then elect it. 

• Click the ''Page Layout tab". 

• Now click on "margins" button in page set-up. 

• This option will display the list of a ailabl style. 

• If available options are sufficient enough lect it, 

• Else select 'custom margins option" . 

• Using custom margin you c:.i11 control setting . 

• Custom settings will open "P, ge setup''. 

• By using thi dia log box 111 argin tab, we can set margin for top, left, right, bottom. 

• Select "Apply to opt ion" to set margin for selected text or for complete document. 

• If no specific text or page is selected then margin ettings are applied to entire 
document. 
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Margin Drop Down 
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A9ply to option 

Margin Dia log Box 

9.15 INSERTING DATE AND TIME 

0 

Sometimes it becomes ery important to insert date and time to a document. We insert 
date and time in document when we want to keep a track record of document creation. 



MS Office has option that allows its user to insert dat and time in a docwn nt. You 
can insert date and time to current working page or for entire document. Take th 
following steps to in ert date and time in word document: 

• Open MS word. 

• Create new document or open any existing document. 

• Click on ins rt ribbon. 

• Select "Date & time option" in insert tab. 

Select one option of date and time format from available options. 

• If you want date and time to get updat automatically tben check the "Update 
automatically" check box. 

• Once done with settings cl ick on OK to exit dialog bo .. 

9.16 USING GO TO 

Go to is an advanced feature of MS Word that allow you to end insertion cursor to 
any position, page or paragraph within current do um nt. Tbi option gives you 
convenience to send cur or to any location within a document, hence it save lot of 
time wasted in searching. Take the following steps to u c Go To option: 

• Open MS Word 

• Open any existing file containing some text in order lo understand func ion of Go 
to option. 

• Click on edit menu. 

• Point on find option of edit menu. 

• Click on Go To or press enter. 

• Now find and repla e window will pop-up. Unde;;r thi window. there exj ts a Go 
To tab . 

• Click on this tab. 

• Now insert page number or Lin e nu mber or any other option as per requirement. 

• Once you insert any appropriate entry then word contf I will take you lo th:11 
position of document and hence the task is a compli hed by Go To command. 

• Use Ctrl + G shortcut key to open find and repla e wind \ . 

Find nd Replace 

111 er p ge n mbtr. 

II I I 
Enter - illd - to o e tel Nf to 
ill! mo t lorw rd tout rtt 1 

Go To Tab in Find and Replace Dialog Box 
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You can control the cur or 1 10mcnt with keyboard also. Though using mouse is a 
fa ·ter method of traversing through the document text. But sometimes there are 
situati ns where we you need to clo ely watch the text at that time us ing keyboard 
cursor movement is the safe t option. To move cursor from one location to another 
aero keys are used. Tl1i · method i , lso known as sequential se rcb. B cause hy using 
th is tech nique, we go through content line by !me and word by word. Following are 
keys and key combination u ed for moving through text using keyboard. 

Keystroke 'hortcuts for MoviJ1g the Cursor in Word 

Key~trok c \ . hat It Does 

Up Arrow Moves the cursor up one line 

Down Arrow M vc the cursor d, wn one li 11e 

Left Arrow Moves the cursor left one character 

Right rrow Moves the cursor right one charucler 

Ctr! -t Up AJTow Moves the: cursor upw the beginning of the previous paragraph 

Ctr! + Do\ n Arrow Moves the cursor dtJWll to the beginning of the next paragraph 

Ctr! + Left Arrow M ves the cur~or le tt one word 

Ctr! 1-- Righi rrow Moves the ctir~or right one word 

Page Up Moves the cursor up one screen 

Page Down Moves the cursor clown one screen 

Ctr! Pnge Up I ves the cursor to the top of the previ us page 

Ctrl + Page Do wn Move the cursor to the top of the nex1 pngc 

Home Move the cursor to the beginning of rhe line 

Ctr! + Home Moves the cursor to th , beginning of a document 

End Mo e the \;Ursor to the end of thi: line 

Ctr! + End ves the cursor to tl1t· end of a do umenl 

Check Your Pro0 rcs: 

Fill in the blan 

----- is a ymbol of cursor. 

and are used for text selection. 

I. 

2. 

3. 

4. 

5. 

6. 

------ ------
comm and is u ·ed to delete text. ------

------ key i u ed fo r removing text. 

------ ______ , _____ are font tyl sin MS Word. 

and ar u d for auto correction. ------ - - - ---
7. _____ arc u ·ed for creating li st in M Word . 

8. l leader and fo ter arc ------

9. Go To command is u-ed for -----

9.1 LET US SUM UP 

• This lesson is al l about Le ' t fonnarting and document formatt ing. 

• ow, we know how to apply va rious s tti ngs on te t to modify it as per 
requi r ment. 



• Now we know how to modi fy various font t pes. 

• We an have variou style of font in documenL We can also specify margi ns 
and spacing. 

• We can apply header and· footer note to add brief de cripti o about document. 

• We can elect text using mouse and can mov arrow using keyboard keys. 

9.19 LESSON END ACTIVITIES 

1. Apply header and footer note in documen . Use date a header and ti me and page 
number as footer note. 

2. Make a list about MS Word fea tures using bullet buttons. 

3. Write a paragraph and align it in centr of page, make text bold, italic and 
underline. Keep font size IO and font colour as red. Make all alphabets capital. 

9.20 KEYWORDS 

MS shortcut is ed for Micro oft. 

GUI di play area in which users make entry and perform proce sing. 

Ctr/ is a key present in keyboard u fi r word pr cessing. 

Alt is a key pre ent in keyboard used for word processing. 

9.21 QUESTIONS FOR DISC SSION 

1. How to insert text in MS W rd? Explain. 

2. What are the different schemes available in S Word for text alignment? 

3. Explain all the methods to delete text. 

4. What do you under tand by redo and undo function · in word? 

5. How t:an we increa e font size and change its colour? 

6. Write a note on go to statement and auto correct. 

7. Write the method of applying borders in wor do ument. 

8. How to insert manual and automatic page break? Di cus . 

9. How many type of margins are availab le in MS Word? 

.heck Your Progres. : Model n. wer 

I. I 

2. Mou e, keyb ard 

3. Delete 

4. Delete 

5. Bold, Italic, Underline 

6. Spelling check, Grammar che k 

7. Bullet, 

8. Short Not 

9. Moving cursor lo p cific page 
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10.0 AIMS AND OBJECTIVES 

After studying this lesson, you should be able to: 

• Insert table 

• Modify and align table 

• Insert border and hades in a table 

• Know about the igni:ficance of drawing and in rting hape in a document 
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Tables are the horizontal and ertical arrangement of data in which we insert 
information in rows and columns. The si ngle uni t in which we insert data is called 
c II. Columns give information about table whereas rows contain detail infonnation. 

Tables are the most convenient way to represent information. lnfonnation represented 
through tables is easy to read and easy to understand. 

In MS Word, we can create table and an apply a vari ty of settings on tabl e. In thi 
lesson, we will learn in detail about MS Office table. We will also focus on how to 
insert drawings, shape and images in an MS Word document. 

10.2 CREATING TABLES 

To create a table in MS Word is very easy, all we need to· do is to click on the in et tab 
and then click on table option available in toolbar. specify the number of rows and 
columns required and the table will appear on working area of MS Word. Table com s 
in editable mode that m ans we can add detail to table after inserting it. If table is not 
big enough to hold iofom,ation. then you can add rows and column manually . To 
insert table take th fi llowing step : 

• Open MS Word. 

• Open any existing document or create a n w docum nt. 

• Click on insert tab. 

• Click on table button. 

• Ii ·k on small quare . Horizontal squ r ar fi r column nd vertical are for 
rows . These small squares are actually responsible for er ating table in current 
document. 

• You can select style for table by clicking n · Tabl ·tyle button". View gallery of 
table style and s !eel on that suits your table most. This i an optional step if you 
don't choose any 'tyle for table then Lhe table too will appear on current working 
pag or wherever the cursor is placed. 

• In create table. there ar two more opti ns vajlable on create table button to 
create the tabl namely: 

❖ insert table: Allo s you lo specify number of rows and columns manually. 
Yo I can also pecify the width of columns by yourself. 

❖ Draw table: Allows you to create table by dragging mouse. Thi. table ill 
only ha e on ro by default. 

10.3 ALCULATING NUMERIC DATA IN A TABLE 

rn S Word allows you to use mathematical formula in table ceU which can be used 
fo r adding number, finding average of numb r or to find malle tor larg t number i11 

a pec ific cell. There are many mathematical fi rmulae available in M Word library. 
You can choose any one ba ed on your requirem nt. 

l 0.3.1 Adding Formula to a Table 

The foUowing are the steps for inserting formula to tab le : 

• Consider the following table as exampl that we will u e for adding the two rows 
and output um of tw row m 3rd row. Click on the cell lhat should contain the 
sum frows. 



• lick on table layout. 

• Then click on formula bu tton. 

• This button will display "formu la dialog box '. 

• By default this will uggest a default formu la that is =SUM(L FT) in our case. 
We can select a number fo rmats using "Number fonnat list box" to display the 
result or you can change the fo rmula usi ng the "Formula List Box". 

• Click on OK to apply formula. You will observe that now formula is added and 
sum of two rows are put on the sel cted row. Repeat the same proce . to add other 
rows also. 

Sd~Formull 

Num Fonnill L.151 SOX 

Examp le for 1Dsert in° F rmu la in a Table 
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10.3.2 Cell Formulae 

Th formula dialog box provide · the following important functions to be used as 
fornmla in a cell. 

Sr . No. For mula & Descr :plion 

I. AVERAGE ( ) 

The average of a Lisr of cells 

2. COUNT () 

The numbc of items in a lis1 of cells 

3. M X () 

The largest voJue a list of cells 

4. Ml () 

The smallest value in a list of cells 

5. PRODUCT() 

Th multiplication of a list of cells 

6. UM () 

The um of a lis1 of cells 

10.3 .3 Deleting Columns and Rows 

MS Word allows you to remove extra rows or columns in table. All you need to do is 
to select the row or column that you wish to remove. If you haven't selected any the 
ro or column tben current row or column will get removed. You can select more 
than one row or column ot one tim for deletion. Both row and column can be deleted 
togeth~r. 

Del ting Row 

To delete a row take following steps. We assume that you are currently working on 
M. Word and u have alrea y created table. 

• Cli k on the row that you ~ ish to delete. 

• N w cl ick on layout tab. 

• It wi ll how you th fo llowing screen. 

N 

Example to Delete Row 



• Click the layout tab and then click the '·delete rows" option under the "Del te 
table button" to remove the selected row. 

llyoutlAl> 

Oocumetlil · 

Example to Delete a Row 

Deleting Column 

Tak the following step to remove column. The pro es of removing column wiU be 
same as removing the only difference will be you have to select the column that you 
wish to delete. 

• Click on column that you wish to de! te from table. 

• Click on "layout tab". 

• It will bring the following screen. 

Oeli!!te Columm op on 

Dele~Tabl~autton 

Example to D lete Column 

Layout b 
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• Cli k th Layout tab and click the Delete Column option under the Delete Tab! 
Button lo delete the selected column. 

10.4 FORMATTING A TABLE 

One table is created MS Office gives a variety of option to format it. It allows you to 
beautify it and mak it look more attractive. In table, you can add shades and border 
and have variety of font sty! . You can ven preview changes before dec idjng its final 
look. 

You can create custom look table by changing the d fault setting for xample using 
various settings you have a variety of cell size within one tab! . You can add and 
delete column, rows or entire table itself. You can have arne table format for entire 
docum nt. 

Formatti11g table i all about changing default settings and making things look like as 
per your requi rement. 

Using Table Style Tab to Format Table 

Once a table is creat d, you can format entir table with the help of " tab style". This 
tab ha: preview option to view actual table even b for inserting it. Take the fi Bowing 
teps to format tab! : 

• Click on the table you want to format. 

• Under table tool cLick on design tab. 

• In ''Tabl e Style group re t the pointer over each table styl until you fi nd a style 
that you wan t to u e. 

• Double cl ick the ·tyle to apply it to the table. 

Aligning and formatting text in a table is very integral part of table development. If 
text is not fom1atted aod aligned properly in table it will have no ffect on it 
productivity, but it will affect its look and reduce overall experi nc of end user. 
lm gine a table ha ing no proper fonnation but correct data in it. What wiU be the 
output? End user will not gain proper infomJation through u h table. So in order to 
make the table m re efficient we mu t align and format text properly in it. 

Text Formatting i11 Tab/ 

Text fonnatting is bout making ure that everything fit in giv n cell of tab l . We 
mu t mak ur th t by formatting table we enhance it effici ncy and looks. Take the 
following step o format tc l in a table: 

• S lect the cell or cell that you want to format. 

• lick on layout tab. 

• lick on propertie tool in table group. It wi ll isplay table property dia log box. 

• Sel ct cell tab. 

• lick on option button, word will display eel.I option dialog box. 

• Select fit te t heck box. 

• Click ok to exit propertie . 

• Word ill reduce the font ize o that text fits in ell of table. 

http:Formatti.ng


Text AligniJJg in Table 135 

Aligning text in a column and rows in MS Word is a matter of choo ing how you 
want the text to appear horizontal or vertical. To align text in a table take the 
fo llowing steps : 

• Select cells, columns or row with text that you wan to align. You can al o select 
entire table al . 

• Go to table tools in layout tab. 

• Click on "Align" button. 

• Foll wing figure show where align button i and how these option align text in a 
table. 

• MS Word provides nine diffi rent ways to align text in table. 

l :a.t 
l 

"" 

r ' 

Click an Align button 

natomy lo Align Table 

10.6 APPL YING BORDERS AND SHADES 

In MS W rd, you have facility to add border and shade to all four sides of table. By 
applying border and hading, we an create a great empha is on table and it brings 
more eye focus on table. Apart from everything it make the table look more beautiful. 

10.6.1 Adding Borders to a Table 

Take the following step to add border in tabl cell: 

• Sel ct th table to which you want to add borders. 

• To ·elect table click over anywhere on table. 

• Above step will make a,cro s icon visible at the top left comer of the table. 

• Click this icon to select entire table. 

• Click th border button to display a list of border options for selected table. 

• Cb ose mo t uitable one by clicking it. 

Tab! nd Gr.1ph ics 
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• Try di fferent options before making fi nal d cision. 

• [f you want to de lete border select "No Border" option from bord r section. 

• You can apply border to any cell column or entire table as well. 

Home tab 

Using B order Option 

rd Options Border Burton 

~eb S lary 
22000 
,0000 
1 000 

Example to In . er t Border in a Table 

Tot I 
1.000 

By taking following step you can apply border style to any table: 

• lick border button to di play the Ii t of av ilable options. 

• 
+ 



• Select "Border and shading" option available at the bottom of list ( hown in above 
screen short). 

• This will open ·'Border and shading" dialog box. 

• This can be used for applying borders around selected table. 

• Click on the border tab to revel border settings, tyle and other available option. 
Also check whether this border should be applied to the selected table, text or 
paragraph. 

• You can cllange border colour, border thickness, width, etc. under style section. 

Homl! Ulb llo<def U b 

Bo<de, Settinp Borde, Styles BOfclet Appl kl lion OpUons 

ilom t. Applied B«der 

17000 

8orw utton 

Fm I 
22000 
20000 
18000 

Bor der Op tion 

Total 
2.000 

♦ 
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10.6.2 Adding Shades to a Table 

You can add various colours to the table by applyin a variety of hades to a table. 
You can apply shades to selected row or c lumn in order lo make the table look more 
attracti e. To apply shad to a table take the followin° step : 

• S lect row or column in which you want to apply shades. 

ec,d,., Button 

Shading Border 

• Cli k n Border button to display a Ii t of ptions. 

• S I ct "Border and hading" option located at the bottom of Ii ·t. 

St.ade F Ill Coto,, tvl ShlldeApptl tlonOptlont 

Border Shading Dialog Box 

• Now ··Border and hading" dialog box will pop up. 

• Use this dialog box to set border and shading around selected rows or columns. 

• Use preview button t ee how new ettings look like before making final 
deci ion. 



l.ilyout t b 

Toutol row 

Border and Shading 

10.7 AUTOMATICALLY FO RMAT A TABLE 

In MS Word, we have th feature to format table quickly. To do o you can use auto­
format. You an create a table with your own pecificati n in auto-format. And can 
have same fo rmatting in1pJemented on all the futur tab! s. This method ·aves a lot of 
time and create con i tency acros, the document. 

How to Apply AutoFormat tyle? 

To apply AutoFonnat style take the follov ing step : 

• Select the table to which you want to apply Aut0Fom1at. 

• Click on table and then Autoformat. 

Ta le Autoformat 
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• Select a table style option from the Category list. 

• Select "table style'' that you want to apply. 

• Use "Apply Special Format to" section to tell word where the headers and totals 
are in your table so that they can be fo rmatted. 

• Click ok to exit. 

Creating New Table using AutoFormat Style 

You can create your own table with Autoformat style. Take the following steps to 
create a new table: 

• Click table, then cl ick on Autoformat. 

• Click new. 

• This will open The reate New Style from Formatting dialogue box that app ars . 
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• Enter a name in "Name text box". 

.:.I 

3 
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Total 
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• Select the section of the table that you want to format, use "Apply formatting to" 
drop down menu. 

• Choose the "only in thi do ument" option to restrict the table style to current 
table only. 

• Click OK to apply formatting. 

• Table created through thi method can be modified b clicking "modify button" of 
Autoformat dialog box. 

Removing Table's AutoFormat Style 

Take the following steps to remove Autoformat style: 

• Click table and then AutoFonuat. 

• Select a table style option from the category list. 

• Select the style that you want to remove from the Table Style list. 

• Click "Delete". 



~letfl T1ble Button Layout tab 

Example to Delete Table 

10.8 USING DRAWING & CREATING A SHAPE 

Creating Drawing 

In MS Word, we can create custom drawings. You can insert various shapes and 
figures also in MS Word. By inserting your own drawing and shape , you can give 
that personalized tou h to your document. You can insert ome pre defined shapes and 
can also insert your own shapes in a file. Take the following steps to insert drawing in 
document: 

• Click Insert at the top of the window. 

• Click the Shapes button then click e cribble icon in the Lines ction. 

• Click and hold down the mouse button, then move the mou e cursor to draw. The 
drawing will complete it elf once you let go of the mouse button. 

• Click the Format tab under Drawing Tools to make any changes to your drawing. 

Croating Shapes 

Pictures Online Shapes SmartArt Screen.shot 
Pictures 

Illustrations 

Drawing Option s 

MS Word gives us the facility to insert shapes in a docwnent. By inserting various 
shapes, we can accomplish various tasks like make fl w chart, make diagrams, make 
labelling, inserting text, etc. by using shapes, we can des ribe things easi ly. There is 
huge library of variou shape that we can use in MS Word. We can change size of 
shapes and can even add text t it. To insert shapes in document all we need to do is to 
click on insert tab and th n press shapes button th is will produce the list of various 
shapes available in th libr ry of MS Word. Select any hape as per requirement and 
insert it in document. To draw a shape drag mouse over the working area of document 
and click hold the mou e to draw the desired shape. You can adju t the ize of shape 
by clicking on it and tretching the edges. You can add mor than one shape in a 
document. 
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Shape Gallery 

10.8.1 Features of Sh.apes Button 

• Change shape: This option is used when you want to change currently inserted 
shape with some other shape . To do so you need to click on Format tab now Insert 
shape group c lick on >> Edi t hape point to >> Change shape. Now choose 
different shape. 

• Add text to shape: Click on the shape where you want to insert text. Now start 
typing. 

• Group sc/ect shnp s: Sel t multiple shapes at a time by press holding CTRL key. 
Click on Format tab>> rrange group>> click on Group>> now all the shapes 
will be treated like a single object. 

• Adjust the size of th shape: Select the shape or shapes you want to resize. On 
the Format tab, in th ize group, click the arrow or type new dimensions in 
the Height and W idth boxes. 

• Apply a style to a bape: In style shape group, rest your pointer over a style to see 
what your shape will look like when you apply that style. Click on the style to 
apply it. Or click Shape fill or shape outline and select the options that you want. 
If you want to apply a colour and gradient that aren't available in the Shape 
Styles group, sele t the colour fir t, and then apply the grad ient. 
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,-"'.,, Shape Fill• 

II~ v· Shape Outline • - Shape Effects • 
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Shape Styles r;, 

Shape Style Options 

• Delete shape: If you want to remove some shape from your document all you 
need to do is to select that shape or shapes which you wish to remove and press 
delete button to remove hapes. 

10.9 USING WORD ART 

Word Art provides us mechanism to add fancy text in document. You can have a 
variety of text forms in one document using Word Art, you can have various colour 
fonts in one document. Take the following steps to add Word Art in a document: 

• Open a MS Word>> open a new or any existing document. Click on the document 
where you want to have Word Art. 

• Click on insert tab >> now dick on Word Art option>> this will display the list of 
various Word Art a ailable list in Word Art Gallery. 

Location to iniert WordArt WonlArt Gan ry 

Word Art Galler y 
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• You can select any Word Art from the available Ii t by clicking it. You can 
modify the inserted text as per requirement. You can beautify text by using 
various available options. Try yourself to change the text by selecting vanous 
options . 

Shape tylM Options 

plctwe$. char 0t • 

In he documen te t by choosl • 

I ry on Hom tab. You can aJso format 

Hom ltb. M OSt cQl"\l/ols oH r • cholc c 
r~tJy. 

Inserted WordArt Text 

Example of Word Art 

10.9.1 Using AutoShapes 

Whil.e working with pictures you cannot insert text to it directly. So how to insert text 
to images? To do so we can use Auto hape option to insert text to images directly. 
This tool of MS Word makes imag more interactive and it becomes easy for us to 
explain some scenario. To in ert Aut Shape in a document take the following steps : 

• Select insert tool bar. 

• Click Drawing opt ion . 

• Click AutoShape on Drawing toolb r. 

• If you want to add colours to imag then click on colour button. 

• Navigate through the pictures in picture gallery and click on insert to enter a 
image in the document. 

• With the shape sti ll elected, right cl ick the shape and elect Add Text option. 

• Enter the text you want to display. 

• Change font if required by righ t clicking it. You can perfonn all text formatting 
operations on text in rted. 



AutoShape and Its Option 

10.9.2 Insert a Clip from the Clip Organizer 

Clip organizer is an inbuilt feature of MS Office that allow you to insert a piece of 
video, audio, animation, etc. By using this tool , we can make a document more 
int'!ractive. Clip organjzer tool exists under insert tab of MS Word. We can insert clips 
from various mediums like camera, folder , external drives etc. Take the following 
steps to insert clip from clip rgamzer: 

• Click on insert tab. 

• Select media button/Clip organizer depending on ver ion. 

• Open Clip Organizer. 

• Click Collection List. 

• In an Office program, click the picture you want to add to a collection. 

• Browse the folder or drive if inserting cl ip from external medium. 

• Drag the pictur to a collection folder. 

10.9.3 Inserting a Text Box 

A text box is an object that we add in a word document t et focus on a certain set of 
text. To insert a text box all we need to do is to click on the insert tab and select Text 
box option you can choose to draw a text box and can also elect some text box from 
available per styled text box. You can choose various style of text b x from available 
gallery. Take the following steps to insert text box in a document: 

Text Box Style 
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• Click insert tab. 

• Select text box. 

• Select one styl for the text box that suits you the mo t. 

• Once the text box is insert d in document it will contain some place holder text 
that you can replace with your custom text. 

• I 

Select d Text in Text Box 

• The custom text will disappear as soon as you start typing. It comes in selected 
mode by default. 

• If you wish to place the text box to any specific location then all you need to do is 
to drag and drop it in location you wish to keep it (drag the text box from its 
edges). You can re ize your text box using resize corners. You can even rotate 
your text box in 360 degree. 

10.10 WHAT IS DRAWING CANVAS? 

A drawing canvas i a pl ce holder where you can create your drawings. The drawing 
canvas can be accessed by navigating to the Insert tab and selecting New Drawing 
Canvas from the bottom of the Shapes dropdown. This will plunk down a blank 
rectangle in which you can cornpo e a diagram of shapes and images. This canvas, 
like other shapes, can al o be fonnatted to have a border, background, etc. 

The first benefit of the canvas is that it acts like a container to hold all of your 
diagram's shapes, allowing you to easily move the diagram around and even cut and 
paste it as a whole. In fa t, it can even be copied and past d to Paint which will paste 
it as an image - a ery u eful fea ire for taking snapshots of really large diagrams 
without having to resort to a screenshot. 

The other benefit is that it allows for connections to be made between the visual 
elements within the canvas using the connector shape tool. Thi makes the diagram 
behave more like Visio, whereby shape can be connected and will maintain their 
connections as they 're moved around. Since this isn 't possible without the drawing 
canvas in Word without resorting to a Visio diagram, it' a ignificant feature for 
those who need to er ate diagrams in Word with many inter-connected compcnents . 

The drawing canvas is of course not the be-all, end-all soluti n for diagrams. For 
instance, text wrapping is not available for the drawing canvas which limits text layout 
to the top and bottom of the canvas. Also, for more complex diagrams, an embedded 
Yisio illustration is a better way to go since Yisio offers a richer set of shapes and 
functionality that Word ever will. 



Fill in the blanks: 

1. Table is ____ and _ ___ representation f data. 

2. To insert a table you have to specify ____ and ___ _ 

3. 

4. 

____ formula is used for calculating sum in table. 

____ is used to align text in table. 

5. Shapes are available in ____ tab. 

10.11 LET US SUM UP 

• Tables are key tool for data representation. 

• Table has cells in which you insert data. 

• You must align table to make it look more attractive and to increa e readability of 
data. 

• You can insert formula in table to perform mathematical c lculation. 

• Use MS Office drawing feature to insert drawing in a do ument. Using various 
shapes and structure, you can create interesting effect in a docwn ent. 

• Using text box, you can create emphasis on speci fie piece of text. 

10.12 LESSON END ACTIVITIES 

1. Create a table having 8 rows and 5 columns. Make double line border for table. 

2. Create a table to perform any two mathematical function . 

3. Draw circle and colour it blue, square as red, and triangle as gr en. Insert text in 
shapes colouring the name of each shape respectively. 

10.13 KEYWORD 

MAX() math function to find largest number. 

MIN() math function to find smallest number. 

SUM() math function to find addition of two numbers. 

10.14 QUESTIONS FOR DISCUSSION 

1. What do you understand by table? 

2. How to insert a table? 

3. Write a note on how to inse1t a formula in MS Word? 

4. Explain the process of deleting row and column. 

5. Explain in bri f. How to format a table? 

6. What is auto shape and canvas in MS Word? 

7. Write short notes on the following : 

(a) Word Art 

(b) Text box 
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(c) Clip organizer 

( d) Creating drawing 

Check Your Progre s: Model Answer 

1. Horizontal, vertical 

2. Row, column 

3. Arithmetic 

4. Text formatting 

5. Insert 

10.15 SUGGESTED READINGS 

Jennifer T. Campbell, teven M. Freund, Mark Frydenberg, 201 6, Shelly Cashman 
Series Discovering Computer & Microsoft Office 365 & ... 

Gary B. Shell y, 1995, Microso.i 0/Jice. 

Advanced oncepts and Techniques expands on those projects, showing ou 
additional capabilities that help increase your productivity. With Introductory 
Concepts and Techniques, you'll gain a better unde landing of Microsoft Offi ce 
Manager. 

Joesph Habraken, 2001 , Micro oil Oflice XP 8-in-1. 
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11 
MAIL MERGE, VJEWS AND TEMPLATES 

CO NTE NTS 

I LO Aims and Objectives 

11. I Introduction 

11.2 Mail Merge 

I 1.3 Views in MS WorJ 

11.4 Overview of Templates 

11.4. I Using an Existing Template 

11.4.2 Creating a Document T mplate 

11.4.3 Create a Web Page bas don a Template 

11 .4.4 Modify a Document Template 

11.5 Ruler 

11.6 Zoom 

11. 7 Protecting Your Document 

11.8 Inserting a File into Another File 

11. Inserting Hyperlinks of a Web Page or a W rd D cument 

11.9 .1 Types of Hyperlinks 

11.9.2 In erring a Hyperl ink in Your Word Document 

11.l O Let Us Sum Up 

11. 11 Lesson End Activities 

11.12 Keywords 

11. 13 Questions for Discussion 

11.1 4 Suggested Reading· 

I 1.0 AIMS AND OBJECTIVES 

After studying thi le on, you should be able to: 

• Acquire the ability to operate mail merge 

• Create a document u ing templat 

• In rt various view in docum nt 

• Create your own template 

• Modify existing template 

• Create web page 

• Zoom, password protection and hyperlink 
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In this lesson, we will learn about mail merge. Mail merge i MS Office facility that 
allows you to share document ver the internet through e-mail. We will try to 
understand the significance of mail merge. We will also learn to create views and 
templates. Templates are like prototypes and based on these prototypes we can create 
documents. In this lesson, we will focus on di fferent techniques of protecting 
document from unauthorized access. 

1 I .2 MAIL MERGE 

This is one of the most commonly u ed utility of MS Word. Mail merge is a tool that 
simplifies the creation of a ·et of documents by linking a database that contains unique 
and variable data element by linking a da tabase that contains those data element to a 
document. Mail merge aves your time and effort by automating the process of 
entering standardized pieces of data like nam and address into a document. 

While perfonn ing mail merge all you need is a word document and a recipient list, 
which is typi ally an excel workbook. To use mail merg take the fo llowing steps: 

• Open an MS Word. 

• Create new docum nt or open any existing document. 

• Click on mailing tab, then click on St rt mail merg button and select Step by Step 
Mail Merge Wizard from drop down menu. 
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Mail Merge Options 
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The mail merge pane appears and will guide you through the teps inv lved in mail 
merge. The fo llowing example demonstrates bow to create a form letter and merge the 
letter with a recipient. There are basically 6 teps involved in creating a mail merge. 

• Step /: Choose the type of documeot you want to create. In this example, we will 
choose letter and pr ceed to 
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• Step 3: In this step, you will insert address list trom address book. Word will 
automatically place all address into document. Address Ii t can be an existing ti le 
like Excel Workbook or you can type a new addr ss list with a mail wizard. From 
Mail merge task pane select option " Use an xisting list" then lick on "Browse" 
t select file. Once a fil e is found click on open. If the addre s b ok is an Excel 
file then select the work heet that contains list and then click on ok. 
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Now from Mail merge task pane, click next: write your letter and move on to step 
4. If you do not have any existing Ii t then use option ''Typ a new list" button and 
click "Create". 
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Mail M er ge Opti n 

• Step 4: Now you can type y ur lett r. Each copy of thi letter will be same. Only 
receiver's name and address ill be different. Dependiag on your s lection a 
dialog box will appear cont ining various options. Select options as per 
requirement and click on OK. You can add option Ii e placeholder and greetings, 
Once done with selection click on ext: Preview your letter proceed to step 5. 
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• Step 6: Click Print to get hard copy of letter. You can choose to print specific 
letter rangin from some page number. You can choose various printing options 
by changing printing settings. 
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11.3 VIEWS IN MS WORD 

MS word gives you five different view· of a document, and each hav its own set of 
pros and cons. Views that MS Word gives us are Pr int layout Full ere n reading, 
Web layout, Outline and draft. By the given name itself, we can understand its 
importance. There are two ways of changing the views. 

I. Click on view tab and then choose a particular view that suits your requirements. 

2. Use view button next to zoom slider at the bottom right corner of the work space. 

Full Screen Web Outline Draft 
'--''-----_J Read1n9 t.ayou 

Do t 

Print Layout 

This is default layout of MS Word. This i the best layout to u e because it allows you 
to see document as h w it will be printed with page break. This view will help you to 
understand how page will look like when it will be printe . This view is suitable most 
when your documents have things Like headers, footers image , etc. 

Full Screen Reading 

This view is used when you are reading a document on computer conceal(Monitor). 
You have the option to view a document as it wi ll appear when printed on a page. You 
should view the document in full screen reading view to maximi e the pace available 
for reading or commenting on the document. 



Web Layout 

This view allows you to ee document as it will appear on a web page. In this view, 
you can see the background, text is wrapped to fi t the window, and images will appear 
as it will bes en online. 

Outline and Draft 

This view .allows you to see docurPent outlines only. This view is most suitable when 
deciding the outline for a document whereas Draft view will allow you to see 
document as a draft u ing this views you can quickly edi t text, some element like 
headers and footers are not available in this view. 

11.4 OVERVIEW OF TEMPLATES 

In MS Word, template is a tool for designing your document. This template gives a 
view on how to design various elements of MS Word. Template is a collection of style 
which describe the tyle of text, placement of paragraphs, levels of headings, etc. 
Templates are nothing but sample design to build a docum nt with symmetry. In MS 
Word, we have some existing templates. You can design your own template as well. 

11.4.1 Using an Existing Template 

We will see now how to use an existing template for a newly created document. A 
template is inserted at the time of creating a blank do ument. Take the following step 
to insert a template while creating a new document: 

• Open MS Word. 

• Click on File option and select New option from drop down. 

• This option will display th available Templates. 

Sample.Tempt.12s 

NewOpllon Office.com mpl.ltes 

• MS Office gives you a list of options in sample option of templates. 

• Choose one sample template for your document. Use MS O ice official page to 
download more sample templates. 
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AvallableTempl tH SilmpleTempl tesGallery Tempi te Preview 

A 
1Y -

I • 

r 
Eqully R port Document Opllon 

• Select one option by double-clicking them from sample template gallery. 

• While selecting a template for your document, you hould select the Document 
Option available in the third column. This opens your document with predefined 
setting with which you can modify document title author name, heading, etc. 
based on your docwnent requirement. 

11.4.2 Creating a Documen t Template 

MS Word allows us to create our own templates to m et speci fi c requirement. You 
can also modify existing t mp) Les. We use .dotx extension to ave modified template. 
To create new templates take the following steps : 

• To create a new template u ing an existing template, click on File menu and then 
select New option from File drop down. This will display the Available Templates 
to be selected. Select any of the available templates and open it with the Template 
option turned on. 

File b TemplneG1lll!fY 

--· 
• 

-·· 
.. 

... 
• -.. 



• Save modified template with extension .dotx. It is neces ary to save template so it 159 
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file tab T~mpi. Title wllJI .dollC ~ 1(1 on 
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• You can create a template for a new document as weU. All you need to do is click 
New option to open new document. Select Blank Document to create document 
template. Save file before exiting. When you c oo e blank document this means 
you are creating your own template, this also means that you can now have your 
own custom settings over a document. Design document as per your wish. You 
will not have any pre defined settings. 

11.4.3 Create a Web Page based on a Template 

To create a web page u ing MS Word is a very common and easy technique. Any one 
with general computer kill can create a web page for various topics like science and 
research, mathematical analysis, education, etc. To create a web page all you need is a 
basic knowledge of language called HTML. MS Office has special view for creating 
and reading web pages called web view. To create web page using MS Word take the 
following steps: 

• Open MS Word. 

• Click view and then 'web layout" in the "document view" secti n. 

• Start creating a web page. For example, for a web page with one picture, one left 
column with hyperlink section under the picture, one right column with text 
section we need four cel ls for this table. 

• Insert table with 2*2 dimensions. 

• Click on the first cell of the table. 

• Insert picture. in tbi cell with the help f "insert picture" dialog box. 

• Insert text des ribing picture. 

• Right click text and select Hyperlink. 

• Click on file menu ' Save As" and select "W b Page Filt red". This option is 
available at save dialog box drop down. 

• Click "Save option" or Ctrl + S to save an update of fi1 . 
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l l.4.4 Modify a Document Tem plate 

MS Word gives you the flexibili ty to modify a document template as per requirement. 
These templates are ju t a prototype that must meet user requirements. Take the 
following steps to modify document template: 

• Open the document that needs a new template to be attached. 

• Click the File tab. 

• On the File screen, choo e the Options command. 

• The Word Options dialog box appears. 

• Choose Add-Ins from the left side of the Word Options dialog box. 

• Choose Templates from the Manage drop-down list. 

• You will find the M oage drop-down list near the bottom of the dialog box. 

• Click the Go button. 

• The Templates and Add-ins dialog box will appear. You should see which 
template is attached to the document, such as Normal. 

• Click the Attach button. 

• Word displays the Attach Template dialog box, which looks and works like the 
Open dialog box. 

• Select the template you want to attach. 

• The templates listed are stored on your computer, so you don't see the full range 
of templates that you would find on the New screen. 

• Click the Open button. 

• The template is attached to your document. 

• Ensure that the option Automatically Update Document Styles is selected. 

• Updating styles means that your document's current tyles are changed to reflect 
those of the new template, which is probably what you want. 

• Click OK. 

The styles stored in that template are now available to your document, and the 
document is now attached to the template. 

Note that attaching a template doesn't merge any text or graphics stored in that 
template. Only the , tyle (plus custom toolbar and macros) are merged into your 
document. 

You can also follow thes steps to unattach a template. Do that by selecting Normal 
(normal.dotm) as the template to attach. 

11.5 RULER 

Gridlill!i □0 Multip!e Pages 
Zoom 100% 

€~ Page idth 

Zoom 

New Arrange Sprit 
1ndow All 



In MS Word, we ust: Ruler to control page margins, paragraph indent and more. This 161 

tool of MS Word remain same ever since introduced. To view ruler in new version of Mail Merge, Views 3
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MS Word click on view tab and select "Ruler" check box.. Ruler consists of following 
items: 

flrsl Lille Indent 
Hanging tnrenl 

Lan Indent ~ 
Tab ConlrOI Right Indent 

• First line indent used for indenting first line of the paragraph. 

• Hanging Inden t used for indenting second and subsequent lines of paragraph. 

• Left Indent set left margin of the paragraph a on opposite side of whole 
paragraph. 

• Right Indent set right margm of the paragraph a on opposite side of whole 
paragraph. 

• Tab Control used to add various tabs to the "Ruler" for indenting and otherwise 
consistently manage text within a paragraph or document. 

11.6 ZOOM 

Zoom is a MS Word tool used for increasing and de<:reasing size of MS Word 
document pages. You use zoom tool to view page more clearly. When we choose 
Zoom-out it reduces font ize. By using zoom tool , we just enlarge the font and 
various element, it have no impact on settings made once the document is closed then 
every thing returns to nonnal state. This tool works for current instance only. There 
are two ways to use zoom tool. 

l . Through view tab 

2. Through+ and - option vailable at the bottom of page. 

l. Zoom Through View Tab 

Take the following steps to apply zoom-in and zoom-out using view tab: 

Click view tab and click Zoom button as shown below. 

Voucat1e thefot"ffW"--4ofwecc..-d 
look fo, c1 tromu,• ou scvtes rv °"" twm..at 
! t d_.• aathetconlrohOI\ lheHcMne t..b~ of 

To d,.anp UM ~,..a~ of yourdocunMnt, d,.oo'M ntt•rh•m.ea .. ,nannOlftlh•P..-

uyovt tab To 1h41 "' l 
Quk::k $.fY1a Set r•H'l .. 

c:on~.d in yc,Uf o.an'9ftl te~•-

http:coof'dln.et
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When you cli k on zoom button Zoom dialog box will appear. This dia log box 
will display the zoom option box to select a value to reduce or increase. 

The default zoom form of any page is JOO% and the minimum zoom is 75%. You 
can Zoom-in till 200%. You an also choose "Many pages" option to display more 
than one page at a time. But mo t of the time user find it very annoying as it 
leads to confusion while reading or working with multiple pages. 

2. Using + and - Zoom Button to Zoom 

CDYf!'f p p , rid olht!r doa,m n l bulldin9 bloc.b.. Wh you ae t• ~ 

ctl 8'11J1U, lh"V ~lso coordln•'-" with your i;u , n, nr document IO<>k 

You n u;ly t.h11np thl!!' form .. tt lna o f w. loctt1d tut n the docum•;-

loo , 1he ..i«t1td ••• • fTom th 0.,1<:11 S1yt plle,y 011 1t,v Hom t 

tftl r ly by using the olh«r con trols o n rhe Hom• ab Molt cotter 
'1om lh C'ufTIJ-nl Lhem• o r uain9 • lornwJ lha1 you J.P .. 

loom-out. 

This is one of the mo t frequently used techniques to zoom a page. By using this 
option, you can zoom in or zoom out 10% each time. 

+ button will increa e zoom and - button will reduce zoom. 

10% is the mini mum zoom you can have for a docum nt whereas 500% 1s the 
maximum zoom that you can increase. 

11.7 PROTECTING YOUR DOCUMENT 

MS Word allows you to protect your document from unauthorized access. When 
working in shared nvironment it is ery important to protect your document or any 
file to be viewed by others. Even when you share PC with others it is necessary to 



have secured file sy tern in order to protect the personal in formation or data from 
outer world. One of the most common techniques used for protecting your document 
is through Password protection. 

You can make file read only file using file menu while saving a file. Or you can set 
properties of file u ing file menu then select properties option and click on the check 
box "Read only". By u ing this method, you can protect files from getting modified by 
any other user but what if you want your file not to be viewed at all by any user, then 
to do so we need password protection. 

We all know what i password and what impact it have when a fil e is protected using 
password protection. To password protect file take the followi ng step : 

• Click the File tab. 

• Click Info. 

• Click Protect Document, and then click Encrypt with Password. 

• In the Encrypt Document box, type a password, and then click OK. 

• In the Confirm Password box, type the password again, and then cl ick OK. 

Remember that pa sword is case sensitive. Make sure you remember the password 
because if you loose your password then you might not be able to access the document 
again. 

11.8 INSERTING A FILE INTO ANOTHER FILE 

In MS Word, you can link various types of file in a document like PDF file or excel 
file, etc. By using file linking, you allow other user to vi w fi le who use your 
computer. Changes also get automatically updated on linked file means if you make 
any changes in fil e that you link within word then those changes will be reflected. If 
you are embedding an object in a document then changes will not be updated. To 
insert a file in word document take the following steps: 

• Open MS Word. 

• Create new or open any existing file. 

• Click on insert tab. 

• Select Object button in text group. 
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• Now cl ick on Cr at from file tab. 

• Click browse button to in ert file from specific location. 

- .... ~. . .... ,.,_ -

1C {1 

1n, ..... ffM .... rt.MII " .......... ,_ 
.. ............ t'f\1111....., ...... _ • .,.,,.-. 

"""--..--............. ,.... ·-·· 
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• heck the Link to File box to link to the fi l instead of mbedding it into the 
document. If you edit th linked file, the changes are reflected in the Word 
document. 

• Remember that link fil is not a part of your document and if you hare a file then 
link will be broken. Linking file will only work in a enario where source fi le and 
linked file both are available at same PC. 

• Check the Display as Icon ch k box to display file as icon in document. 

• Click OK to insert the file into the Word document. To save the changes, 
press Ctrl-S. 

Over0ew of Wizard 

In MS Office, you can automate the process of creating document using Wizard. You 
can create memos, I tter faxe and many other busine documents. Th major 
difference between wizard and template is w izard walk you through text entry process 
in many part of document hereas template is just like a placeholder that tells you 
where to insert text. T plate is just like a prototype for a document whereas wizard 
is a process of creating a do ument. Wizard is an automated proce whereas template 
is a completely manual pr e . in computer technology, wizard is a part of a program 
that guides you through c rtain t p . 



Basically a wizarci is like a guide that helps you in er ating new fi les in any program. 
Wizard does not offer much customization features hence many users may find it 
useless as experienced u ers want more features in finished file . Apart from that 
wizard is only suitable at learning stage. Once you gain command over a product then 
wizard is not used at all. Be ure not to confuse between a "wizard" with a "template". 
A template is a pre-fonnaned document that has already been created whereas a 
wizard is a step-by-step guide that helps you to create your own document. 

11.9 INSERTING HYPERLINKS OF A WEB PAGE OR 
A WORD DOCUMENT 

Hyperlinks are basically location addre . inserted into a document that have link to 
another object or location. We all at some stage of Life u e hyperlinks while using 
internet. By using this tool, you can enhance the reader experienc by linking various 
resources to a document. Adding hyperlinks is a very simple process. Hyperlinks are 
clickable elements in a document and it takes you to the location or object they are 
mapped with. 

11.9.1 Types of Hyper links 

There are few basic types of hyperlinks that we can include in a word document: 

• Relative: Hyperlink is a shorter address that only includes the location details 
necessary to follow the path from the document' current location to another 
document within the same location. Thus, the hyperlink connects to another 
document relative to it current location. The linked document can be in the same 
location, or it can be in a subfolder, but it cannot be outside of the original 
document's location. 

• Absolute: HyperLink is a full address for the document to be linked to . It includes 
every location detail necessary to follow the path to the linked document from 
anywhere. The d cument linked to can be virtually anywhere your computer is 
able to access, from your hard drive to a location on the Web. 

• Anchor: Link connects I cations within the same document. For example, a table 
of contents might consist of anchor links that take the reader to specific chapters 
within the document. 

11.9.2 Inserting a Hyperlink in Your Word D ocument 

To insert hypcrlink in a document take the followin g step : 

• Open MS Word . 

• Open any exi ting file or create new document. 

• Insert some text. 

• Select the text you want to tum into hyperlink. 

• Right click the selected text and then sele t option Hyperlink. 

• This option will open hyperlink dialog box. 

• Embed the link by applying appropriate setting. Choose tab according to your link 
type. 

• Choose tab if link i a file or web, document or -mail address. 

• Browse the location of fil e or document that you wi h to link. 

• Click on ok to exit. 

• Test link by cli king it 
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• If suitable result is not achieved then repeat the process. 

• You can also use in ert tab to insert hyperlink in a document. Process will remain 
the same. 

Microsoft Word 
Righ t-Click M nu 

..... •• ~,.\. 11V 

·-...... ' .. .......... .... 

Fill in the blanks: 

Check Your Progrcs. · 

1. Mail merge is _ ____ _ 

2. There are ______ types of views in word. 

3. Templates are of document. 

4. Zoom is tool used for - - ----

5. _ _____ use for protecting document. 
• 

6. Hyperlink is ____ _ 

11.10 LET US SUM UP 

• Mail merge is a to I for sending a document to multjple people at a same time, by 
using maill merge ou can ave time. 

• By using view tool, you can chang the document appearance. 

• Templates are ready to use prototyp s by using the e template you can create 
document template lhat will have all predefined setti ngs which can be modified as 
per requirement. 

• Roo~nd ruler tool are u ed for getting better view of document. 

• Use password to protect your document from unauthorized access. 

11.11 LESSON END ACTIVITIES 

1. Create a document and protect it with password. 

2. Create a document template. 

3. Create a web page using MS Word. 

4. Create nested files. 



11.1 2 KEYWORDS 

PC is short fonn for per onal computer which ideally mean desktop computer. 

Wi.zard is a step by step process of problem solving. 

11.1 3 QUESTIONS FOR DISCUSSION 

1. Explain mai l merge. 

2. Write all the steps invol ved in er ating mail m rge. 

3. How to use zoom and ruler tool to change appearance of docwnent? Explain. 

4. Explain how to create a docume t template? 

5. Try different views of MS Word and explain them. 

6. What do you understand by wizard? 

7. How to insert hyperlink in MS Word? Explain its signific nee. 

8. Explain all types of hyperlink. 

Check Your Progress: Model Answer 

I. Group document mailing util ity too l 

2. Five 

3. Prototype 

4. Increasing and decreasing size of font 

5. Password 

6. Link to de tined address 

11.14 SUGGESTED READINGS 

Jennifer T . Campbell , Steven M. Freund, Mark Frydenberg, 2016. Shelly Ca shman 
Series Discovering Computers & Microsoft OfJice 365 & ... 

Gary B. Shelly, 1995, Microsoft OfJice. 

Advanced ncepts and Te hniques expan on tho projects, showing you 
addi tional capabilities that help increase your productivity. With Introductory 
Concepts and Techniques you'll gain a better under tand.ing of Microsoft Office 
Manager. 

J esph Habraken, 2001 Microsoft O!Ii.ce XP 8-in-1. 
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SPREADSHEET AND MS-EXCEL 

12.0 Aims and Objectives 

12.1 Introduction 

12.2 tarting MS Excel 

12.3 Spreadsheet and its Elements with Application Window and Document Window 

12.3.1 Menu Bar 

12.3.2 Titl Bar 

12.3.3 Status Bar 

12.4 Ce ll 

12.5 tandard Toolbar & Formatting Toolbar 

12.5. I Fonnatting Toolbar 

12.5.2 Standard Toolbar 

12.6 Workbook & Work beet 

12.6.1 Excel Workbo k 

12.6.2 Excel Wor h ets 

12.7 Handling Files 

12. Let Us um Up 

12.9 Lesson End A tivitie 

12. 10 Keywords 

12. 11 Ques tions for Di cu ion 

12.1 2 Suggested Reading· 

12.0 AIMS AND OBJECTIVES 

After studying this les on. you should be able to: 

• Define Excel and it application 

• Di cu s the significanc of cell 

• Explain the elements of Excel program 

12.1 INTRODUCTIO 

MS Excel is a software program used for storing, organising and manipulating data. 
MS Excel is a program come with MS Suite package. MS Excel is also known as 
spreadshe t program. Idea to develop MS Excel i based on paper spreadsheet used 
for accounting. Computerized preadsheets still u e same idea as t!ie paper one . Data 
is stor d in tabular format which ha e rows and columns where rows are represented 



by numbers and columns are represented by alphabets. Current versions of Ex el and 
other spreadsheet programs can store multiple spread beet pages in a single computer 
file. The saved computer file is often referred as a workbook and each page in the 
workbook is a separate worksheet. 

12.2 STARTING MS EXCEL 

To open MS Excel is very easy. Take the following step to open MS Excel: 

• Click on the start button. 

Example showing How t Start Excel 

• Click on All Program option availabl in start menu. 

E xample showing l-1 0\ to tart Excel 
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E amp le showing How to Start Excel 

• Now search for M Excel in ubmenu and double click it or pre ·s enter. 

· xample showin How to Start Excel 



• As soon as you click on MS Excel option computer processor wilJ launch Excel 
and the following creen wi ll appear 

MS Excel Window 

12.3 SPREAD HEET AND ITS ELEME TS WITH 
APPLICATION WINDOW AND DOC UME T 
WINDOW 

MS Excel is just like any other application in MS O ice suite package. The basic GUI 
is same as other application like it also have menu bar, title bar, tool bar, etc., but 
what makes it special i its functionalities that it ontains tool for data manipulation 
and calculation. The most unique and special tool of Excel i its additional formula 
bar. This tool all ws you to perform all mathematical calcu1 tion. Application 
window is entire GUI Lliat excel provides you to work in excel application window 
consisting of many elements like formu ita toolbar ribbon, tabs, etc. The following 
figure wiil show you how application window look like. Oocum n t window is a 
section of document which displays you actual content of file. Document window i 
also known as working area. Document window is a placeholder where users enter 
information ·and pe orm various operations. 

Quick Access Toolbar RlbbOO Foonuta Bar 

I 
-,-. ~x 

I . - . 1'. · ..,_ ...... . .... ... .... 
\I, ,. e-~ • f • l 

C ' 

I ., v H 0 

I c::::::J 
: 

Sratus Bar 

Applicat ion Window 
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R bar 

Elements of Spreadsheet 

12.3.1 Menu Bar 

This bar contains all drop down menus for file manipulation. This menu bar is below 
the title bar. This bar have options for customizing w rksheet. These menu bar have 
tool for sharing your work with other users. It have special help menu that help you to 
troubleshoot problems. 

Formula Too/bar 

By using this tool bar you can pcrfi rm mathematical calculations. For example, by 
using this tool bar, you can add two columns and can print output in third column. 
This tool bar is specially de ign d for MS Excel. Excel supports many math functions . 

Quick Access Too/bar 

You will find this t lbar just above the File tab and its purpose is to provide a 
convenient resting place for th Excel's most frequently used commands. You can 
customize this toolbar ba d on your comfort. 

Ribbon 

Ribbon contains commands organised in three compon 

I. Tabs: Appears at the top of wind w below menu bar and it contains groups of 
related command . Example: ome, Insert, Page Layout. 



2. Groups: They are like placeholder for related commands. Each group name 
appears below the group on the Ribbon. Exampl~ _g_roups command related to font 
or alignment. 

3. Commands: C mmand LS actual action we take on peci:fic object, it appears 
within each group. 

12.3.2 Title Bar 

This appears at the top of the window and it displays the name of the worksheet you 
are currently working. 

Help 

The help icon is us d for getting help related to Excel. lt provides tutorials on a variety 
of subjects related to e eel. 

Zoom Control 

This allows you to have closer look at text. It increases the size of font without 
effecting actual settings. You can zoom text in Excel by using + and - buttons. Zoom 
control consists of slider button to zoom in and zoom out. Pull lid r towards + sign to 
1increase zoom and towards - sign to reduce zoom. 

Sheet Area 

It is actual working area of Excel. In sheet area we insert data. It contains blinking 
cursor from where you can start typing. The flashing ertical bar is called the insertion 
point and it represents the location where text will appear when you type. 

Row Bar 

Row bar is represent d by numbers. This bar contain number starting from I and it 
keeps on increasing as you enter data. Maximum limit for row is l.048,576. 

Column Bar 

Column bar is represented by alphabets. This bar c ntain alphabet starting from A 
and it keeps on increasing as you enter data. Once olu.mn reaches all alphabets its 
count continues as AA, AB and so on. Maximum limit for columns is 16,384. 

12.3.3 Status Bar 

This displays an the information regarding sheet as well as the u.rrent insertion point 
location. This bar display information like total number of pages and word used in a 
worksheet, etc. 

Dialog Box Launcher 

This appears as a very small arrow in the lower-right comer of many groups on the 
Ribbon. Clicking thi button opens a dialog box or task pane that provides more 
options about the group. 

12.4 CELL 

In MS Excel, a cell i a re tangular box that appears at the intersection of row and 
column. Columns are represented by alphabets and r w are r presented by numbers. 
Cell is a unit for data insertion. Every cell in excel have unique coordinates or value in 
excel sheet such as A I. o if we are at A 1 coordinate thi mean that you are at 
column A and row. Thi is bow cell gets its unique value every time. 
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Cell in Excel 

Each cell in excel can store one piece of information at a time such as data, formula, 
text, numbers or date value. There are many ways in which you can format a cell in 
Excel such as change it font, number format, background, alignment, etc. 

12.5 STANDARD TOOLBAR & FORMATTI G TOOLBAR 

12.5.1 Formatting Toolbar 

Formatting Toolbar 

This entire toolbar could become floating window by double-clicking on the control 
bar at the far left end of this toolbar. That gives the following window, which can be 
placed anywhere on the creen: 

□ Formatti !I 

Geneva • 9 • ~ ~ :ii m 
$% , 

Formatting Toolbar 

This toolbar can be restored to its original position by clicking in the gray bar at the 
top and dragging it back to the top of the screen. Push tbe top of the window up to the 
bottom of the menu bar. 

Function of commonly used buttons 

G .. neva . Change · the fom of the selected 9 • I Change the size of selected text and 
text numbers 

B Makes selected text and I Makes selected text and numbers 

- numbe bold - italic 

:u Underl in selected text nd = Aligns to the left with a ragged right 
numb rs - margin 

-- --
Centres the selected text Aligns to the right with a ragged left = = = margin 

~ 

m Merge and Centre - Merges two $ Currency tyle - Formats selected 
or mo selected c lls and tex t to display currency style 
centres the entry 

% Percent tyle - Formats selected , l Comma Style - Fonnats selected cells - ce ll to display pe ent -- to display commas in large numbers 

+.o Increas Decimal - lncreas the .oo Decrease Dec imal - Decreases the 
,O() number f d cimal di played +.o number of decimals displayed after 

after the decimal point the decimal point 

Contd. .. 



-- - -Decreases the indent the Indents the lected paragraph to the •• to _.;.. 
::;- previous tab ·top ~ next tab stop -----

Adds border , Mark that it is highlighted 

□ · 
or removes a ,{I. text so 

around selected text or objects and stands out 

A Formats the selected text with 
• the colour you cl ick --

Carefully review the function of each of the button above. When you think that you 
are familiar with each of the buttons take the short quiz below (The Fonnatting tool bar 
has been included as a reference). 

• 9 • B I 1l 

Formatting Tool Bar 

A B C D 

I. #. You wish to call attention to a portion of your 
worksheet by making the text bold. 

Which button do you select? 

2. :§ You want to c ntre the entrie in elected cells. 

Which button do you select? 

3. Cell Al is to be stretched so it covers 6 cells . 

Which button do you elect? 

4. I ; . To call attention to text, you want place a block of 
colour behind the text to highlight it. 

Which bullon do you seJect'? 

S. 
12 #. Another way to call attention to a block of cells is to .. 

plac a border around them. 

Which button do you select? 

6. $ 
A column of numbers repre ents money and you want 
to apply currency tyle. 

Which button do you select? 

7. ;d8 A. • A column of numbers has too many decimal places 
afaer the d imal point . 

Which button do you sel c t. 

Button and Their Function 

12.5.2 Standard Toolbar 

Standard Toolbar 

This entire toolbar could become a floating window by doubl -clicking on the control 
bar at the far left end of thi toolbar. That gives the following window, which can be 
placed anywhere on the screen: 

Standard · 19 

- ~ ~ Jt ~ 

~ :t t- tl il 
G) 

,,;_ 

Standard Toolba r 
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This toolbar can be restored to its original position by cl icking in the gray bar at the 
top and dragging it back to the top of the screen. Push the top of the window upto the 
bottom of the menu bar. 

Function of commonly used buttons 
--

Creates a new blank document Opens or finds a file . CJ 
~. 

based on the default template. 
--

Saves the active file with its Prints the active file - for more print options go '-I ~ current file name, location and to the File menu and select Print. 
file format. 

--
Print preview - Shows how the Spelling, grammar and writing style checker. 

I [9. ••s.·· 
document will look when you V 

print it. 

i Cut - Removes the selection 
~ 

Copy - Copies the ·elected item(s) to the 
from the document and place clipboard. 
it on the clipbo rd. 

--
Paste - Places th content of Format paint r - C pies the format from a I§ <J 
the clipboard at the insert ion selected object or text and applies to other 
point. objects or text. 

--
Undo Reverse the 1 st Redo - Reverses the acti n of the Undo button , 

"1• 
- \lol • 

command, u e pull-down use the pull-down menu to redo several steps. 
menu to undo several tep 

I: Auto Sum - Adds numb rs u Sort Ascending - Sorts selected items from the 
automatically, and suggests the beginning of the alphabet, the lowest number or 
range of numbers to be added. the earliest date. 

I -- --
i+ Sort Descending - Sorts 0 1 Chart Wizard - Gu.ides you through the steps 

selected items from the end f for creating an embedded chart (graph). 

I 

the alphabet , the highest 
number or the lat t date. 

--
Displays or hides the Drawing 75% Zoom - Enlarge or reduce the display of the 

- tool bar. active document. 

Carefully review the function of each of the buttons above. When you think that you 
are familiar with each of the buttons take the short quiz below. The Standard toolbar 
has been included as a reference. 

r:Dri;liJ €,~ ~ -

A B 

I. 
~ :y 

2. I: i 

I 

--
3. DI ""J 

4. :~-
5. ~ 

6. CJ 

i ~ 

C D 

~ ~. 
~ 

1009'1 • ~ i 

You have completed the worksheet and want to make 
certain that you have not made p Hing or grammar errors. 

Which button do you select'? 

Text is highlighted and you wam to remove the selection 
from the active document and place it on the clipboard. 

Wh ich button do you select? 

Y u have made a change to the active document and want 
to make {:Crtain that tho e changes arc saved. 

Which button do you select? 

You want lo get a quick sum of a column of numbers. 

hich button do you select? 

he worksheet had been checked for spelling errors. it has 
been saved, and now you arc ready to print. 

Which button do you select? 

worksheet which has been saved into a folder on your 
com ut r is Lo be opene o changes can be made. 

Which button do you elect? 

Contd ... 



7. 0 1 The worksheet had been checked for spell ing and has been 
saved. Before sending ii to the print r you want to see how 
it will look. 

Which button do you select? 

12.6 WORKBQOK & WORKSHEET 

12.6.1 Excel Workbook 

A workbook is just an additional name given to excel file . A workbook is a file of 
excel contains us r data and information. Like word file is also known as document, 
excel file is known as workbook. A workbook is a place holder where you have menus 
and tools for data manipulation. Excel workbook is a combination of rows, columns 
and cell. Excel wi ll open up something called the back tage view. The backstage view 
is used to manipulate fil es, and contains functionality that will allow you 
to Save, Open, Close and Print your workbooks . 

8 ' wo,U, .. • .. ·lnd·~hffl -.c, [JCd C!I - 0 X 
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Excel W or kbook 
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Start a New Workbook 

• "File" menu on the top left of your screen. 

• Click the "New". 

• Select the type of file you want to create (usually "Blank Workbook") and press 
the "Create" button. 

Shortcut: Try pres ing Ctrl + N 

• Click "File menu" on the top left of your screen. 

• Click the "Open" option. 

• Navigate through your computer's fi lders to the fi le you want to open, then click 
"Open". 

Shortcut: Try pres ing Ctrl + 0 

Close a Workbook 

• Click the "File menu" on the top left of your screen. 

• Click the "Close". 

• Bear in mind that Excel can have multiple workbooks (fi les) open at once; 
pressing the "Close" icon will only close the current workbook, and will keep all 
other workbooks open. 

Shor'tcut: Try pres ing Ctr!+ W 

• Click the green "File menu" button on the top left of your screen . 

• Click the "Save". 

• Navigate through your computer' fo lders to the location in which you'd like to 
save your workb ok. then click "Save". 

Shortcut: Try pres ing Ctr!+ Son Windows. 

Print a Workbook 

• Click the green "File menu" on the top left of your screen. 

• Click the "Print" . 

• Edit the settings that appear until the prev iew in the right-hand pane appears as 
yo'u would like it to print, then press the "Print" button. 

Shortcut: Try pre ing Ctrl + P on Windows. 

12.6.2 Excel Worksheets 

MS Excel allows its user t have multip le worksheets in a single workbook. 
Worksheets are created in tabs . These tabs are located at the bottom of each 
workbook . Each worksheet have its own unique name, by defau lt every work book 
will contain three worksheets namely she t i , sheet2, sheet3. You can freely add and 
remove sheets from w rkbook. To navigate through these tabs all you need to do is to 
click on them. Or use Ctrl + PgUp or PgDn shortcut keys. To open option/property . 
menu bar right cl ick on worksheet. Using this property menu, you can perform a 
variety of functions on work heel 
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Worksheets of Excel 

Here are some more operations that you can accompli b on work beet: 

Add a Worksheet 

• Right click the name of any worksheet tab. 

• Click "Insert ... ". 

• Ensure "Worksheet" i selected and press "OK". 
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Delete a Worksheet 

• Right click the name of the worksheet you would like to delete. 

• Click "Delete". 

Rename a Worksh ct 

• Right click the name of th worksheet you would like to rename. 

• Click "Rename". 

• Type the new name of th worksheet on your keyboard, then press Enter to 
commit. 

Move a Worksheet 

• Right click the name of the wor sheet you would like to move. 

• Click "Move or Copy". 

• If you would like to move the worksheet to another pos1hon in the same 
workbook, click the name of the worksheet befo which you would like to move 
it. 

• If you would like to move the worksheet to another workbook, select the new 
workbook from the "To book" menu, then click the name of the worksheet before 
which you would like to mov it. 

• Bear in fT!ind that if you move a worksheet to an ther workbook, it will be erased 
from the current workbo k. 

• Press "OK". 

Copy a Worksheet 

• Right click the name of the worksheet you would like to copy. 

• Click ''Move or Copy". 

• If you would lik to copy the worksheet to another po ition in the same workbook, 
click the name of the work ·heet befo re which you would like to copy it. 

• If you would like to copy the worksheet to another workbook, select the new 
workbook from the "To book" menu, then click the name of the worksheet before 
which you would like to copy it. 

• Press "OK". 

Hide a Worksheet 

• Right click th name fthe worksheet you would like to hide. 

• Click "Hide". 

• This will make th worksheet invisible and remove it from the tab list at the 
bottom of your creen. 

Un hide a µ/orkshe t 

• Right click the name of any worksheet. 

• Click "Unhide ... ". 

• Select the nam of the work beet you would like to unhide, then press ''OK" . 



12.7 HANDL ING F ILES 

File operation encompasses a vast variety of operations that one can perfonn to gain 
maximum performance. File operations are as fo llows: 

New 

This operation lets you create new file. When we elect new option we get black 
template. If you made any changes in other file will get removed and ettings will 
return to default. 

Open 

This option wilJ let you to browse file aved on any location of hard disk. By using 
this operation, we can access e temal drive also like pen drive, etc. 

Close or Exit 

This option is u ed to close a currently open file . By using er ss button, we can close 
currently open file. 

Save 

By using this option, we can save file on any location of computer. Save option by 
default save file in "My Document". We can choose any location by browsing fo lder. 
In save file option, there are two options "Save" and " ave as" . Save as is used for 
saving file for fir t time. When w elect save as option to save fiJe, then it displays 
one pop-up window asking you to give some name to the file. From this pop-up 
window, we can choose the location or a specific folder to save a file whereas "save" 
option is used to save the recent updates made in a file. 

Cut 

By using this option, we can cut a part of text. trl + X is a shortcut key used for 
cutting a part of te t Ctr! + V is the shortcut us for pasting the ame text later in any 
part of current do ument or any other text file . Wh n we use cut oplion to cut a part of 
text then this op ration takes hold in m mory t mporarily . Once the te t is pasted then 
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it cannot be pasted again and if sy tern fai lure occurs then cut paste goes back to its 
original file. 

Copy 

This option is used for copying a part of text or full text again and again. Ctrl + C is 
the shortcut k y used fi r copying a part of text. Ctr! + V i a shortcut used for pasting 
the copied text. [f system failure occurs (l ike power failure or any other unnatural 
cause) then the copied text i wa hed out from memory. If copied text is not saved 
then the copied text wi ll get washed out of memory. 

Paste 

This option is used for pa ting copied or cut text to any part of file or any other file. 
This option is like transport d vice that transports text from one part of file to another 
tile. Paste option is program indep ndent. Meaning we can use Cut, Copy, Paste 
option in any type of file. For example, copy or cut som part of text from MS Office 
to notepad. 

Search 

This option is used for earching any file using MS Word search. The searched file 
wi ll get open in new window. To earch any fi le we can u e the task pane. 

Print 

This option of file is used for getting hardcopy of document. Ctr! + P is used for 
printing d cumeot. In MS Word we have one option known as "Print Preview". This 
option is used fo r viewing documents final look after being printed without actually 
printing it. If not happy with current lo k w can always go back to document make 
n ce ary changes and then have printout We can choose to print document in various 
ize like A4, A5, A . We an al so choose to have land cape or portrait printout. 

Having colourful printout i al o pos ibl if you have any image or any colourful font 
in a document. Make ure your print r have colour ink to bring colourful printout. 

We can make variou chang in printout like number of pages wanted as printout, 
margin, t . 
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1. Excel is a programs. 

2. Excel fil es are called 

3. Worksheet is 

4 . Workbook i 

5. Cell is 

6. Excel have and 

riQlPles: 

7. is used for inserting calculation. 

12.8 LET US UM UP 

ties 

( Frig Printer,.. I 
OPrWtof 

wP 

toolbars. 

• Excel is a data processing software program that is far more capable than just data 
process mg. 

• Excel is a sheet base program which contains rows and columns. 

• Cell acts as a container unit that stores data in it. 

• It has a variety of tool and menus for data manipulation. 

• It has one very unique formula bar that allows u to create a variety of formulae 
for data manipulation. 

12.9 LESSON END ACTIVITIES 

1. Create a exc I file and explore all available option. 

2. Try inserting imple formula in fommla bar. 
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3. Try to increase and decrease zoom in excel file. 

4. Find out extension of excel file . 

12. 10 KEYWORDS 

Ctr/ key available on keyboard perfonns various operation on document. 

Pg. Up key is used for bringing cursor on t p of a page. 

Pg. Down key is used for bringing cur or at end of a page. 

A4, A5, A6 typical sheet i:ze i us d while printing a page. 

12.11 QUESTIONS FOR DISCUSSION 

I . What is Excel? 

2. Explain fonnula bar. 

3. Explain in detail the significance of cell. 

4. What do you under tand by fi le handl ing? Explain. 

5. Di ferentiate b tween workbook and worksheet. 

6. Explain all elements of Excel pr gram. 

Chee Your Progress: Model An swer 

I. Spreadsheet 

2. Workbook and work she l 

3. Actual table hold ing data 

4. Additional name given tow rkbook file 

5. Place holder to ins rt data 

6. Formatting, standard 

7. Formula bar 
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13.0 AIMS AND OBJECTIVES 

After studying this lesson you should be able to: 

• Formatting sheet text 

• Inserting border and shading to cell 

• Editing and fonnatting cell content 

• Using find and replace for text manipulation 

• Inserting spell ing check and grammar check in order to make workbook error free 

• Applying vari u function on worksheet 

• Understanding different types of in-built fun lion in excel 
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In this lesson, we will learn about excel worksheet formatting. You will see in the 
following topics how to modify excel worksheet as per requirement. We wi ll learn to 
insert data in excel sheet, formatt ing fo nt, apply border around cell, etc. 

Worksheet formatting lets you have custom settings and it also allows you to modify 
the entire look of excel beet. In excel, there are around I 048576* 16384 cell . In an 
excel sheet, you can ins rt both text and numeric data. A cell in excel can hold upto 
32000 characters. 

13.2 ENTERING TEXT DATA 

To insert data in ex el sheet aU you need to do is to select the cell in which you want 
to insert data. Activate cell by clicking it, now type text or number and press enter to 
move to next cell or u e navigation keys to insert data. It is not necessary to follow 
any sequence in excel, you can insert data to any cell you wish to. 

.. 
7 

I 1 
Ad.Ive cell for loJertlna ~u 

Example fo r Text Data 

13.3 ENTERING FORMULA 

♦ 

MS Excel allows you to insert formu la in a worksheet. By u ing formula toolbar, we 
insert formula in workbook by creating formula we can perform many mathematical 
operations. Formula can range from imple calculation to complex calculations. In 
Excel, simple user defi ned formula always tart with = to sign, fo llowed by contents 
that are numeric and then comes operator like +, -, *. 

For example, when you insert a formu la like =8+9*4 in this formula excel will follow 
the rule of BODMAS al o known as perator precedence. Excel will multiply the last 
hvo numbers and will add it to the first number. 

Click on the cell in which you want to insert formula. If you have inserted number in 
cell then select row or column in formula for calculation, for example =A I +A2. In this 
example, Excel will add values of cell Al to cell A2 and the output will be stored in 
cell A3 by default. 



EntfflQJ formut. n MS Excel 

For mula Bar 

13.4 EDITING THE CELL CONTE T 

You can modify elJ content in excel. To do so all we need to do is to click on the cell 
to activate it and enter new value in it, press enter to navigate to next cell. You can 
also modify the font type of worksheet or for specific cell. 

Formatting the Cell 

MS Excel cell can contain different type of data like number, currency, date, etc. You 
can change cell type in the following way: 

• Open Excel. 

• Click on cell you want to change. 

• Right click on the cell. 

• Select Format cell option from pop menu . 

• This will open fonnat cell dialog box. 

• Now click on type of value you want to set in cell, general is a default value. 

Formattin g Cell Dialog Box 
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13.4. l Various Cell Formats 

Gi ven below are the variou ceJI formats: 

• General: This is the default cel l format of ell. 

• Number: This display cell as number with separator. 

• Currency: This displays cell as currency i.e. with currency sign. 

• Accounting: Similar to Currency, u d fo r accounting purpose. 

• Date: Various date format are avai lable under this like 17-09-2013, 17th-Sep-
2013, etc. 

• Time: Various Time formats are available under this like 1.30PM, 13.30, etc. 

• Percent::ige: This displays cell as percentage with decimal places like 50.00%. 

• Fraction: This display cell as fraction like 1/4, 1/2, etc. 

• Scientific: This displays cell as xponential like 5.6E+O I. 

• Text: This display • cell as normal text. 

• Special: Special formats of cell like Zip code, Phone Number, etc. 

• Custom: You can use custom format by us ing this. 

13.5 FORMATTIN FONT 

MS Excel allows its user to apply various types of font and font style in worksheet. 
You can always choose different font size pattern, type, etc. You can format font 
from home tab. Changing font in excel is similar to word font formatting. To format in 
cell or cells font take the following steps: 

• Open MS Excel. 

• Click on the cell or cells of which you wish to modify the font. 

• Select font option available in home tab. 

• Select font type from font gallery. 

• Select size from size chart place next to font type. 

• You can also choose to make font b Id, ital ic or underline. 

• To modify the colour of font click on colour button. 

• Select colour that suits your specification or theme. 

• You can use right cli k m thod to chang font {Right c)jck on cell » Format cells 
» Font Tab }. 

• Right click the cell in which you want to insert different font style. 

• This will open cell tting dialog bo . 

• Click on font tab to change the etting . 

• Apply font. 
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Font Formatting 

13 .6 SETTING BORDER AROUND CELL 

In Excel, you can apply border to a specific cell to crea . emphasis on specific data. 
By applying border, you can make a cell look special. To apply border to a cell take 
the following steps: 

• Open MS Excel. 

• Click on the cell or cells to which you want to apply border. 

• Right click to pen formatting dialog box. Sel ct "Format cell" option {Right 
Click » Format cell » Border Tab » Select the B rder Style} . 

• Click border tab to apply border. 

• Select border style. 

• You can have more than one border style in a workbook. 

• Click Ok to exit. 

• You can use home tab also to apply borders. 
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Format Cell Dialog Box to Insert Border to a ell 
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Set Border !Tom Home Tab 

I 

in 

Example for Cell Border 

13.7 USING FORMAT PAINTER 

This function is not very commonly used in excel. This tool copies the formatting Gf 
one cell to another. For example create cell B2 containing some settings. 

82 5 
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On home tab, in clipboard group, lick Format painter. 

Cut 

[m, Copy ~ 
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Forma t Painter 

Now select D3 in order to copy same ti rmatting of B2. Thi tool will now apply same 
colour formatting and border fonnatting to selected cell. 

This tool saves a lot of time when you want to use same formatting multiple times. 

Double click format painter to apply same setting to other cells. After the pointer 
changes to a paintbrush, lick and drag to select the shape, text, or worksheet cell that 
you want to format, and then release the mouse button. 
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13.8 HIGHLIGHTING GRIDLINES 

In Excel, you can change the colour of gridlines. Gridlines are the grey lines 
intersecting between cells. By changing colour of gridline, we can add more freshness 
to workbook and thi makes work look more interesting. 
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Highlighting Grid Exa mple 

Take the following step to change colour of gridlines: 
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• Select worksheet in which you want to change the colour of gridline. 

• Click hold the MS Office button and then select Excel option. 

G 

• In the Advanced category under Display option for this work h et, make sure 
that the Show gridlines check box is selected. 

• In Grid line colour box, select the colour you want to keep. 
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Grid Colou r Option 

• Hence colour of gridlines are changed now. 

13.9 FINDING AND REPLACING THE TEXT 

This method is extremely u ful while working wi th text . Find and replace method is a 
technique of finding a piece of string and replacing it with ome other string. For 
example, in an excel fil e, you want to change all " the'' with " they" one way is to do it 
manually which is very error prone and time taking. 0 th r way i lo use find and 
replace method. In find text box enter '"they" and in replace with text box enter "they". 
Take the following steps to implement find and replace. 

• Open MS Excel. 

• Open an Excel fi le containing some text in it. 
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• Click on Edit menu. 

• Select find option. 

• Select Replace option from find sub-menu. 

• In find text box enter the sting you want to find and in replace text box enter the 
sting that you wish to replace it with. 

• You can use * and ? wi Id character in search textbox. 

• Use the asterisk to find any string of characters . For example, s*d finds "sad" and 
"started". 

• Use the question mark to find any single character. For example, s ? t finds "sat" 
and "set" . 

• You can define your search by selecting appropriate options. 

• Use match case check box to find case sensitive string. Se rch output depends a 
lot on case of string. 

• To search for cells that contain just the characters that you typed m the Find 
what box, select the Match entire cell contents check box. 

• If you want to search for text or numbers that also have specific formatting, 
click Format, and then m e your sel ctions in the Find Format dialog box. 

• While replacing Excel giv s you two options "replace'' and "replace all". 

• Replace option wiJI update one string at a time whereas replace all will replace all 
string at a same time. 

To search for cells that contain just th characters that you typed in the Find what box, 
select the Match entir cell contents check box. 

If you want to search for text or numbers that also have specific formatting, 
click Format, and then make your selections in the Find Format dialog box. 

Using Spelling and Grammar 

In Excel, spelling che k and grammar check is not a defauJt feature. Excel allows you 
to have your own text no matter it's a correct spelling or not. To make sure there are 
no spelling errors in excel sheet, take the following steps to perform spelling check. 
Unlike MS Word spelling errors or grammatical errors will not appear as red underline 
or green underline. 

For Single Sheet 

• Open Excel. 

• Open workbook in which you want to perform spelling and grammar check in 
Excel. 

• Or create new Excel workbook insert text in it. 

• Click where you want to tart th sp 11 check. 

• If you click in the first cell (A 1) it wi ll check the entire heet. 

• If you click in cell ZZ9 it will start ·pell checking from there. 

• If you select a range of cells only those cells will be checked. 

• Go to the ribbon and elect Review tab. 

• Select Spelling. Button to perform spelling check. 



To Spell Check for All Sheets in a Workbook 

• Right click on a sheet at the bottom of your Excel spreadsheet. 

• Click to select all sheet . 

• Go to ribbon and select Review tab. 

• Select spelling button. 

• If you use spelling check very frequently then add spelling button to quick access 
tool bar. 

13.10 FUNCTION AND OPERATOR 

This is one of the most u ed feature of excel. By using excel inbuilt function, we can 
perform various mathematical tasks. Users can create there own functions. For 
creating any funct ion all you require is operator and operand. Operator are 
mathematical signs such as {+ *,-,%,etc.} and operand are the variable to which we 
are applying calculation. For example, 22+33=55 here in this example 22 and 33 are 
the variable= and + are the operator that will perform addition. 

13.10.1 Entering F unctions 

MS Excel allows you to insert formula in a worksheet. U ing formula toolbar, we 
insert formula in workbook by creating formula we can perform many mathematical 
operations. Formula can range from simple calculation to complex calculations. In 
Excel, simple user defined formula always start with= to ign, fo llowed by contents 
that are numeric and then comes operator like +, -, *. 

For example, when you insert a formula like =8+9*4 in this fornmla Excel will follow 
the rule of BODMAS also known as operator precedence. Excel will multiply last two 
numbers and wiH add it to fir t number. 

Click on the cell in which you want to insert formula . If you have in erted number in 
cell then select row or column in formula for calculation for example =Al +A2. In this 
example, Excel will add values of cell Al to cell A2 and output wiJl be stored in cell 
A3 by default. 

' 

- ~ t-t .,.. Ent~rillll fonnu.11 MS &eel 

Formula Bar Example 

Formula are the key feature of excel without formula excel i nothing. In Exe l, there 
are more than 500 in-built formulas. User can insert there own fonnulas and functions 
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to serve specific task, A formula consi ts of special ode which is entered into a cell. 
It performs some alculations and returns a result, which is displayed in the cell. You 
have a variety of formula in Excel like you have formula for text manipulation, you 
have formula for mathematical formulas, etc. 

13.10.2 Element of Formulas 

Formula consist of the following elements from which you can opt one element for 
creating formula in one cell , you can only insert one formula: 

• Mathematical operators, such as +(for addition) and *(for multiplication) 

• Values or text 

• Cell references (including named cells and ranges) 

• Worksheet fu nction (such as SUM or AVERAGE) 

As soon as you complete a fo rmula entry, Excel calculates the result, which is then 
displayed inside the cell within the worksheet (the contents of the formula, however, 
continues to be visible on the F rmula bar anytime the cell is active) . If you make an 
error in the formula that preven ts Excel from being able to calculate the formula at all, 
Excel displays an Alert dialog box suggesting how to fix the problem. 

13 .10.3 Editing Functions 

To edit a formula all you need to do is to select the cell that contains formula and type 
over it to modify the fonnula . You can edit formula ju t like you edit any other cell of 
excel. You can also use formula bar to edit any existing fonnula. You can select, cut, 
copy, paste or del te, format cells containing formula just like you do cell labels or 
values. By using Autofill, you can copy formula to adjacent cell. 

Copy and Paste Formula 

Select the cell that contains the formul a you want to copy . 

• Click the Home tab. 

• Click the Copy button. 

• Select one or more cells wh re you want to paste the formula. 

• Click the Paste button or cLic the Paste button arrow, point to an option to display 
a live previe of the paste, and then click to paste on the item. 

---

xample of Editing Formula 



Example of Editing Formula 

Excel Built in Funch·ons 

MS Excel has many built-in functions that we can incorporate in our formula. In 
Excel, we have functions for mathematical operation text manipulation, etc. By us ing 
these functions , we can save lot of time and effort. Excel has of more 500 functions 
for various purposes. Excel functions have some predefined functionality we just call 
these function in our excel worksheet. To use these function take the foll owing steps: 

• Open Excel. 

• Select cell in which you want to insert formula. 

• To call any function there is a prototype for it . 

• Syntax to use any formula in Excel workbook = {Function name}(argument) 

• Example: =ADD(22, l 1) or ADD(Al,A3) 

• Use function tab to see all available formula in xcel. 

• Excel funct ions are divided into following sub category. Some of the commonly 
used functions are given below. 
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Using Mathematical F unctions 

Mathematical functions are u ed for performing some very common mathematical 
calculation like addition, conditional addition, sum and product, etc. there are more 
then 100 mathematical functions available in excel. 

ABS: Returns the absolute value (i.e. , the modulus) of a supplied number. 

SJ GN: Returns the sign ( + J, -I or 0) of a supplied numb r. 

SQRT: Returns the positive quare root of a given number. 

MOD: Returns the remainder from a divi ion between two upplied numbers. 

Using Statistical Functions 

By using statistical functions we can perform complex statistical operations, these 
function reduce time and effort of calculation. 

MAX: Returns the largest value from a list of supplied numbers. 

MIN: Returns the smallest value from a list of supplied numbers. 

AVERAGE: Returns the Average of a li t of supplied numbers. 

COUNT: Returns the number of numerical values in a supplied set of cells or values. 

COUNTJF: Returns th number of cells of a supplied range), that satisfies a given 
criteria. 

SUM: Returns the sum of a upplied list of numbers. 

Using Dc1le & Time Functions 

These functions can return current date and time to selected cell. 

DATE: Returns a date, from au er-supplied year, month and day. 

TIME: Returns a time, from au er-suppl ied hour, minute and econd. 

DATEVALUE: Converts at xt string showing a date, to an integer that represents the 
date in Excel's date-tim code. 

TIMEVALUE: Conve a text tring showing a time, to a decimal that represents the 
time in Excel. 

NOW- Returns the curr nt date & time. 

TODAY Returns today's date. 

13.11 CHANGING THE DEFAULT DATE FORMAT 

If none of the predefined Excel date foanats is suitable ti r you you are free to create 
your own. 

In an Excel sheet, sei ct the cells that you want to format . Press Ctrl+ l to open 
the Format Cells dialog. 

On the Number tab, sele t Custom from the Category list and type the date format that 
you want in the Type box. 



Format Cells 

LN':Jml>_e.~.] Ii nm"" Font Bord.tr Flit Pro tdion 
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Type the number torlDilt code, using one of the existing codes u a sbrtmg point 

ot J [ uncel 

Format Cell Dia log Box to Mod ify Default Date 

When setting up a cu tom date format in Excel you can use the following codes: 

Code Descr iption Example (January I, 2005) 

M Month number without a leading z ro I 

Mm Month number with a leading zero OJ 

Mmm Month name, hort form Jan 

Mmmm Month name, full form January 

Mmrnmm Month a the first letter J ( tands for January, June and July) 

D Day number without a leading zero 1 

Dd Day number with a leading zero 01 

Ddd Day of the week, short fonn Mon 

Dddd Day of the week, fu ll form Monday 

Yy Year (la t 2 digits) 05 

Yyyy Year (4 digits) 2005 

When setting up a custom time format in Excel. you can use the following codes: 

Code Description Display a 

H Hours without a leading zero 0-23 

I 
Hh Hours with a leading zero 00-23 

M Minute without a leading zero 0-59 

Mm Minut s with a leading zero 00-59 

s Secon without a leading zero 0-59 

Ss ! Seconds with a leading zero 00-59 

AM/PM Periods of the day AM or PM 
(if omitted, 24-hour time format i u e 
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Text Function 

By using these func tions, we can p rform text manipulation and many more. Some 
commonly used text function re: 

LOWER: Converts all characters in a supplied text string to Jower case. 

UPPER: Converts all characters in a supplied text string to upper case. 

TRIM: Removes dupl icate paces, and spaces at the start and end of a text string. 

CONCATENATE: Join together two or more text strings. 

LEFT: Returns a specified number of characters from the start of a supplied text 
string. 

MID: Returns a specified number of characters from the middle of a supplied text 
string. 

RIGHT: Returns a 'pecified number of characters from Lhe end of a supplied text 
string. 

LEN: Returns the length of a supplied text string. 

FIND: Returns th position of a supplied character or text string from within a 
supplied text string (ca e- n itive). 

Logical Functions 

Logical functions are tho e that return to ne condition either true of false. 

AND: They test a numb r of u er-defin d onditions and returns TRUE if ALL of the 
conditions evaluate to TRUE, or FALSE otherwise. 

OR: Tests a number of user-defined conditions and return TRUE if ANY of the 
conditions evaluate to TRUE or FALSE otherwise. 

NO T: Returns a logical value that is the opposite of a user supplied logical value or 
expression i.e., return FALSE if the supplied argument is TRUE and returns TRUE if 
the supplied argument is F AL E. 

Financial Function 

Financial functions are for finance related calculations. 

Functions What i1 Does 

FV Return th future v lue of n investment 

PER Return th numb r of periods f, r an investment 

PMT Return th pen die payment for an annuity 

RATE Return intcre t rate per period of an annuity 

Operators 

Operators are the basic elements through which we perform various calculations. Any 
operator needs atleast one operand to perform proces ing. Some operators require 
more than two operand . 

Arithmetic Operators 

These operators are used for ari thmetic caJculations. It require two operand and they 
are solved in the ord r of there pre edence. 



The Excel Arithmetic Operators and the order in which they are evaluated are shown 
in the table below; 

Operator Meaning Preceden e 
()=most ; 3=leasl) 

% The percent operator I 
I\ The exponentiation operator I 

* The multiplication operator 2 

I The division operator 2 

+ The addition operator 3 

- The subtraction operator 3 

Excel Comparison Oper tors 

The Excel Comparison Operators are used while defining conditions (for example 
when using the Excel If Function). These operato are listed in the table below: 

Operator Description 

= Equal to 

> Greater than 

< Less than 

>= Greater than or equal to 

<= Less than or equal to 

<> Not equal to 

AutoSum 

AutoSum is a function in Microsoft Excel and other spreadsheet programs that 
automatically enters the appropriate formula or function into your spreadsheet. For 
example, if you want to add the values of cells Al through AS, highl ight cells Al · 
through AS and click the AutoSum button, a shown in the picture to the right . 
Clicking this button after highlighting the cell creates the formula =SUM(Al :A5) in 
cell A6 (first cell after last highlighted cell) and gives you the total of all those cells . 

The AutoSum feature makes entering formulas ea y without the need to memorize the 
syntax for each fonnula. 

Function Wizard 

The Function Wizard is a pop-up tool that helps you to write the expressions that 
define the data and models entered in LEAP's Analy is View. The Function Wizard 
can be invoked when creating an expr ion by clicking Ctrl+F or by 
selecting Ftmction from the drop-down menu attached to every expression in the 
Analysis View data tables. It can also be invoked in a similar way from 
the Expression Builder tool. The function wizard can also be invoked by clicking a 
function in an exi ting expression and pressing Ctrl+ pace or Ctrl+F. 

The function wizard is displayed as a pop-up dialog box containing a series of 
selection and edit boxes. 
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Function Type: This election box is used to select among different classes of 
function . LE P has over one hundred func tions tha t you can include in your 
expressions divided into five main categories: modelling functions, mathematical 
fu nctions logical functions, tati tical functions and financial functions. 

Fun tion: The functi n election box is used to select a specific fu nction from a drop 
down menu. The functions are listed alphabetically and filtered by the class of 
fu ncti ns selected in the Function Type selection box. To see all functions, 
ch ose All in the Func tion Type selection box. 

Once you have selected a specific function , the wizard display a short description of 
that fu nction. Mor detailed help on the function inc luding detailed syntax and 
examples of how it can be applied arc available by cl icking the More button to expand 
the window. When the Function wizard is invoked with the cursor placed wi,thin an 
existing fu nction, then the Fun tion Wizard wiJl be displayed with the function wizard 
p pulat d w ith the param ter for that function. 

l"he1.:k Your Pro!.!res~ 

Fill in th blank : 

l. Text is inserted in ___ _ ____ _ 

2. 

3. 

_______ _ operator is u ed bef re inserting a formula. 

tab is u ed for inserting border around cells . --- -----
4. Format paint is u ed for ___ _____ _ 

· 5. Find and repl ce perfonn _ ____ _ _ _ operatioo. 

6. perator is ___ _____ _ 

7. Math expression i olved on the basi of _______ _ 

13. 12 LET US SUM UP 

• Excel is great tool for olving complex problems. 

• It repr ents data in mosL efficient po ible way. 

• It has a vari ty of t ls forte t and data manipulation. 

• It support ti ature like uto um and Functioo Wizard which help a lot in data 
proce. ing. 



• Excel have huge Library of built-in function to support data processing. 

• You can create your own fu nctions using perators supported by Excel. 

13.13 LESSON END ACTIVITIE 

1. Use math function to calculate data of student studying in your class. Make a list 
of all student enter all ubjects enter recent core of each student in each subject 
and find out who is leading. 

2. Try to modify the grid colour choose any colour of your choice. 

13.14 KEYWORDS 

ABS is excel math function for finding absolute value of number. 

MOD is excel math function for finding modular valu of number. 

SQRT is excel math function for fi nding the square root of number. 

MAX & MIN are excel math functions for finding smalle t and largest number. 

COUNTJF is excel function to count number if given condition is true. 

UPPER is excel text function to conv rt all alphabets into capital letters. 

LOWER is excel text function to convert all alphabet into mall letters. 

LEN is excel text function to find total number of character in given text. 

MID is excel text function to find mid of text. 

CTRL key available on keyboard is u d for data manipulation. 

13.15 QUESTIONS FOR DISCUSSION 

1. How to insert text in Excel? 

2. Explain AutoSum and Function Wizard. 

3. How many types of operator are avai lable in xcel? Explain all. 

4. Differentiate between math function and text function with example. 

5. Differentiate b tween fu nction and fo rmula. 

6. How to apply find and replace in Excel? 

7. How can we change the colour of gridlines? Explain in steps. 

8. Write a not on fonnat painter with example. 

9. Explain in brief about various cell formats. 

10. What is function wizard? 

Check Your Progress: Model Answer 

1. Text box 

2. Mathematical 

3. Border 

4. Copy fonnatting of one object to another 

5. Text replacement 

6. Special character or mathematicaJ expre 

7. Operator precedence 

10n 
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14.0 AIMS AND OBJECTIVES 

After studying this lesson, you should be able to: 

• Explain the significance and types of chart used in excel 

• Create a chart 

• Define OLE control 

• Understanding cell referencing 

14.1 INTRODUC TION 

Charts are pictorial way of representing data. By using chart, we can how variation in 
data. Excel is all about data so when you want to how data in prices manner we u e 
chart. In Excel, we have a variety of charts like pie hart, bar chart, Gantt chart, etc. 
Charts are a very p werful way of showing group of information. By using chart, a 
user gets better view of info rmation. It is a great tool for data proce ing. It is a visual 
representation of numeric data. 

14.2 TYPES OF CHAR TS 

There are variou · types of charts available in Ex L Below we can e chart gallery of 
MS Excel. By using any of this, we can represent numeric data in Excel. 
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Excel Charts 

ollowing is a li st of chart type available in Excel: 

Column: Column chart displays data changes over a period of time. It describes 
comparisons am ng items. 

Bar: A bar chart display comparisons among individual data items. 

Pie: A pie chart show the ize of items tbat make up a data eries, proportional to the 
sum of the items. It always shows only one data series and is u eful when you want to 
emphasize a significant element in the data. 

Line: A line chart describe and bows trend in data at equal intervals. 

Area: An area chart illu trates the magnitude of change ver a pecific time period. 

X Y Sca tter: An X Y (scatter) chart shows the relationships among the numeric values 
in several data series, or plots two groups of numbers as one eries of x y coordinates. 

Stock: This chart oft n is used for stock market data, it can al o be used for describing 
science data like temperature change. 

Surfac : A surface chart is u eful when you want to find the optimum combinations 
between tw ets of data. in a topographic map, colours and patterns indicate areas 
that are in the same range of values. 

Doughnut: This chart is omewhat Like pie chart and is also used to display the 
relationship of data with whole data. It can contain more then I eries of data. 

Bubble: Data that is arranged in columns on a worksheet, so that x values are listed in 
the first column and corresponding y values and bubble size values are listed m 
adjacent columns, can be plotted in a bubble ch rt. 

Radar: A radar chart compare the aggregate values of a number of data series. 

14.3 CREATI G A QUICK CHART SHEET 

To reate a chart in excel is very easy. Take the following steps to create a chart in 
Excel: 

• Open Excel and then open or er ate a file containing ome data . 

• Sele t group of data for which you want to create chart. 



• Click on insert tab. 

• Select chart using chart button or click on chart group. 

• View chart gallery and select one type of chart . 

• 

Inserting Quick Chart 

Editing Chart 

Chart created in Ex el can be modified. Take the fo llowing steps to modify charts: 

• To modify chart open excel file . 

• Modify the data u ed for chart input, Right click on chart » Select data. 

• This option will update chart as per new data. 

• You can modify X and Y axis of chat to modify hart. 

Inserting Q uick Chart 
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14.3.1 Parts of a C hart 

Charts are visual repr entation of data in a worksheet. By u ing chart, it become easy 
to see comparison, patterns, etc. Every chart is made of some element which acts as a 
key ingredient in formation of chart. Every chart is different in its essence but the 
basic idea remains same, every chart must deliver vi ual information. Elements of 
every chart as follows : 

In 1111s &kJn,pl,; , 
11\B Y E,~IS 1$ th.-

\/ IUt' ~~ i ~ 

.. 13,50000 5 3.ooo:oo 
o 2,500.00 

E 2,000.00 
ct 1,500.00 

1.,goo.00 
;,.;,00.00 

$-"' QI 

l 

1st Quarter Sales - T,11e 

Salespeople 

Parts of Chart 

Leger,d 
I 

■ January 

■ February 

M arch 

In 111 1s ,;~ 1111ple, ht1 ,; Axis. 1• 
111.- ( a1tn1ory A~,s 

Source data: Based on source data chart are created. Every time when source data is 
changed chart also get updated automatically. 

Title: This displays the name of chart or that information for what chart is created for . 

Legend: This displays the colour scheme. It shows what is the significance and 
meaning of various colour used in a chart. 

Axis-: Charts are built on horizontal and vertical lines. Where horizontal lines are 
referred as X axis and vertical lines are referred as Y axis. 

Data series: This demonstrates the actual value on which chart are prepared. Usually 
display value is picked from data source. 

Values axis: The axis that represents the values or units of the source data. 

Category axis: The axis identify ing each data series. 

14.4 CREATING A CHART USING WI ZARD 

The chart wizard is a eries of dialog boxes guiding you on how to insert chart in a 
workbook, following are teps in the wizard to create chart: 

Chart type: Allows you to choose from over 14 diffi rent chart styles. You can 
preview chart before inserting it. 

Source data: Allows you to choose cells and define range of data to be used in a chart. 
You can also choose whether you want to plot columns or rows for your data series. 
There are two tabs "Data Range" and "Series". The Series tab plits up the actual data 
range into individual. 

Options: Allow you to define certain options for chart like ti tle, gridlines, axis, data 
labels, etc. 

Location: Allow you to put chart on ·pecific location of worksheet. Basic advantage 
of using chart wizard i.s that it Uows you to go back to any step in case of 
modification . 



14.4.1 Using Pivot Table 

Pivot table are dynamic tool to generate report for databa e. You can pick DB from 
worksheet or any xtemal drive. This tool helps you in transforming bulk data into 
meaningful information. This is one of the most powerful tool for summarizing and 
analysing data. To open pivot table click insert tab then select 'pivot table dropdown". 

Example of Pivot Table 

Suppose you have a huge data of voters and you want to summarize information as per 
party, in this case, you can use pivot table. Choose insert tab then select "pivot table 
dropdown". MS Excel wiU select data for table by it If you can specify pivot table 
location. 

Pivot Table Example 

This will bring pivot table pane as shown below. In thi pane. you will get various 
options to generate pivot table. 

Drop Value F" Ids Here 

Pivot Table 
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Column labels: A field that has a column orientation in the pivot table. Each item in 
the field occupies a column. 

Report filter: You can set the filter for the report as year, than the data gets filtered as 
per the year. 

Row labels: A field that ha a row orientation in the pivot table. Each item in the field 
occupies a row. 

Values area: The cells in a pivot table contain the summary data. Excel offers several 
ways to summarize the data (sum, average, count, and so on) . 

14.5 OBJECT LINKING AND EMBEDDING (OLE) 

OLE is a technique of inserting data from one program to another. Output of one 
application can be used as an input for another application, using OLE controls we can 
save lot of time. All we need to do is fo llow following process. In following example, 
we will insert excel sheet in word application and once we will update excel sheet 
word file containing excel sheet will also get updated it elf. 

If you don't want the data to update in Word, for example, it's called Embedding; if 
you do want the data to update, it's called Linking. We're going to do Linking. For this 
exercise, you need Word 2007 to Word 2013 as well as Excel 2007 to 2013. 

• First, create the simple spreadsheet given below, and enter the formula shown in 
cell E3: 

/, =El• U 

A B C D E 

Click inside Ce ll El and enter a number 

Your number multiplied by U is: ol 3 

4 

__ ._ ___ _ 
Example of OLE 

• When you enter any number in cell E 1 the answer will appear in cell E3 { wait for 
a while}. 

• Highlight cell A I and E3. 

• Click and copy c lls. 

• Open MS Word 

• Now paste special copied cells. 

Pasting Options 



Home 

• Format Painter 

Paste Options: -CID - --[;;I A 
Paste ~ecial .. 

Set DEf~ult Paste ... 

Pa sting Options 

• When you use paste pecial following dialog box will appear. 

P~s te Spec·a! 

Source; icrosolt Excel Worksheet 
Sheet1 1R1O:R3C5 

1 f'aste: 

•-[ii"asie-,i~k;1 Formitted Ttl!t (RTFJ 
Unformathid Text 

Result 

Picture 1'W'lndow1 MttafileJ 
Bitmap 
HTML format 
Unformatted Unicode Text 

!me the contents of the Clipboard as a picture. 

.,. LJ .Qisplay as Icon 

~➔~ Paste lm ae:ates a shortcut to the source file . C ngei to tile source file Ill be 
reflected In your document. 

___ o _ ___,l ~' __ ,_el~ 

Paste Special Dialog Box 

• Select Microsoft Office Excel Worksheet Object from the dialogue box. On the 
left hand side, select Paste Link. Click OK. 

14.6 LINKING CELLS AND LINKING FORM ULA 

Linking Cells and Linking Formula is also known a relative cell reference, absolute 
cell reference and mixed reference. When we insert a formula in excel we create 
reference in it. These references insert data dynamically in cells or range. If you didn ' t 
use references in your fonnu las, you would need to edit the fo rmulas themselves in 
order to change the alues used in the formulas . When you use cell linking or formula 
linking it can be done in three ways relative cell reference absolute cell reference or 
mixed cell reference. 

Relative Cell Reference 

The row and column references can change when you copy the fonuula to another cell 
because the reference are actually offsets from the current row and column. By 
default, Excel creates relative cell references in formulas. 

209 
Chart and Web Object 



210 
Windows and MS Office 

Exampl of Relative Linking 

Absolute Cell References 

The row and column references do not change when you copy the formula because the 
reference is to an actual ceU address. An absolute reference uses two dollar signs in its 
address: one for the column letter and one for the row number (for example, $A$5) . 

Examp le of Absolute Linking 

Mixed Cell Referenc s 

Both the row or column reference is relative and the other i absolute. Only one of the 
address parts is absolute (for e ampl , $AS or A$5). 

Hyper Links 

Hyperlinks are same as what we studied in MS Word. Following is the process of 
inserting hyperlink in Excel : 



• On insert tab, in link group click Hyperlink. 

~ ~ EJ LJ 4 C2J 
SltC£r Timeline T Heolder WordArt Srgnaturc Object 

Box & Footer lincT 

Filter, links re 

Hyperlink Option 

• "Insert Hyperlink" dialog box will appear. 

• To create a link to an exi ting Excel file, select fi le by browsing it. 

• To create a link to a place in this document, execute the following steps. Click 
'Place in This Document' under Link to . Type the Text to display, the cell 
reference, and cl ick OK. 
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Previewing Charts and Printing 'harts 

• Click the worksheet that contains the chart which you want to print. 

• On the View tab, in the Workbook Views group, click Page Layout or Page Break 
Preview. 

CusLm s 

g_l Full Screen 

Printing Options 

• To move the chart, drag it to the preferred location on the page that you want to 
print. 

• To resize the chart, do one of the following: 

❖ Click the chart, and then drag the izing handles to the size that you want. 

❖ On the Formal tab in the Size group, enter the size in the Shape 
Height and Shape Width box. 

t ' " 
3 

.... 
.J ... ... 

.. .. 5 ~ 
s. 

If a worksheet contains more than one chart, you may be able to print the charts on 
one page by reducing the size of the charts. 

• Click the worksheet. 

• Click the Microsoft Office Button , and then click Print. 

• By default, Activ heet( ) is selected under Print what 

• You can click Preview to see how the chart will look on the printed page. 

Print a Chart without Work ileet Data 

• You can print one chart without worksheet data per page. 

• Click the chart that you want to print. 

• If the chart is on a eparate chart he t, click the chart beet tab. 

• Click the Microsoft Office Button and then click Print. 

• By default, Selected Chart is selected under Print what. 

• You can click Preview to see how the chart will look on the printed page. 

Set Page Options for a Chart 

On the Page Layout tab, in the Page Setup group, click the Dialog Box Launcher@ . 
To quickly specify the orientatJOn of the printed page , on th Page Layout tab, in 
the Page Setup group, click Orientation, and then click Portrait or Landscape. 



P rin ting Option 

Change the print quality of a chart 

• Click the chart that you want to print. 

• On the Page Layout tab in the Page Setup group, click tbe Dialog Box 
Launcher ~. 

Pr inting Options 

• On the Chart tab under Printed quality, select the Draft quality check box 
the Print in black and white check b x or both. 

• To see the result of tbe print quality ettings that you lect, click Print Preview. 

• Click Print. 

Fill in the blanks: 

1. Chart is 

Cltu:k Your Pro 11 ri:s~ 

--- ---
2. You can create quick charts with the help of _____ _ 

3. For chart editing we el ct _____ _ opti n. 

4. Every hart has _ _ ____ and _ _ _ ___ axi . 

5. Pivot tables are used for ------

6. OLE stands for ------

7. Linking formula and cell is also known a 
and - --- --

14.7 LET US SUM UP 

• Charts are organi ed view of data Lhat display information in precise and well 
organised manner. 

• Excel provide a variety of charts to its user. 

• You can select any of tbes chart to represent bulk data in most efficient way. 

• Every chart is built on X and Y axis and have data source on which chart i 
prepared. 

• Excel also supports report generation tool called pi ot table. 

• Excel supports OLE tool . By using this tool, we can insert data from one program 
to another program. 
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1. Create a database of passing percent in your institution and then make a graph for 
finding out which year ha highest passing percent. Give name to this graph as 
passing percent. • 

2. Create a word and excel document and update excel file using word program. 

3. Print excel sheet without gridlines. 

4. Print chat from excel without printing any other thing. 

14.9 KEYWORDS 

OLE stands for object linking and embedding. By using thi control, you can link two 
different programs and both programs can exchange input and output. 

Axis length and breadth on which charts are created. 

14.1 0 QUESTIONS FOR DISCUSSION 

1. Explain with example about OLE t ol of excel. 

2. How to modify chart? Explain in tep . 

3. Wri te a note on pivot table. 

4. Wbat is chart wizard? How to use it? 

5. Explain all the elements of chart. 

6. Discuss the various types of chart. 

7. Explain in detail with example about cell referencing. 

8. How to insert hyperlinks and page break in excel? 

Check Your Progress: Model Answer 

1. Pictorial representation of data 

2. Chart wizard 

3. Select data 

4. X, Y 

5. Generating re rts for database 

6. Object Linking and Embedding 

7. Absolute, mix d, relative 

14.11 SUGGESTED RE DINGS 

Jennifer T. Campbell, Steven M. Freund, Mark Frydenberg, 2016, Shelly Ca shman 
Series Discovering Computers & Microsoft O/Ece 365 & ... 

Gary B. Shelly, 1995, Micro ofl O/Ece. 

Advanced Concepts and Technique expands on tho e projects, showing you 
additional capabilities that help in rease your productivity . With Introductory 
Concepts and Techniques you'll gain a better understanding of Microsoft Office 
Manager. 

Joesph Habraken 200 1 Micro oil Oflice XP 8-in-l. 
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15.0 AIMS AND OBJECTIVES 

After studying this lesson, you should be able to: 

• Explain the basics of presentation 

• Discuss the element of Power Point 

• Use AutoContent Wizard 

• Create a blank presentation 

• Define templates 

15.1 INTRODUCTION 

PowerPoint presentation is a powerful tool used for creating a presentation. File 
created in PowerPoint are saved with extension. PPT, typical presentation of 
PowerPoint are made on slides. A slide is a place holder that can contains animation 
sound, audio or video dips etc. PowerPoint contains a vast vari ty of tools to help us 
in making presentation. 
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PowerPoin t i a presentation tool used for creati ng presentations, it have many 
elements. It is a package that combines text and animation to create interesting and 
creative professional presentations. The following are the chief elements of 
PowerPoint: 

Menu and Tools 

Thi i the most important element in any MS Office application menu and the tools 
are true essence of any MS Office program. By using these tools and programs, we 
can perform a lot of tasks in a much professional way. 

Navigation Tab 

This is a r latively new feature of MS Office. This option allows you to find 
appropriate tool in a much easier possible way. 

Slide 

Slide are like place holder that contain infom1ation about what presentation is about. 
In any presentation, you can have m re than one slide and each slide can contain 
different data. 

Slide Working Area 

This is the place where y~u actually insert slide with pre entation content. 

fide Pane 

This pane di play the list of slides wl1ich you inserted in a ppt. By using this pane, 
you can select any slide at any time for modification. 

Help 

This option provides help regarding any topic in context to PowerPoint. 

Slid 'how 

Sl ide how is a tool u. ed for viewing presentation. Once you click on slide show 
button it will start slide show on full s<--reen mode. If you move your mouse, click it 
press any key on keyboard the presentation will stop at that point itself. Slide show 
gives th actual preview of pre ntation. You can always go back and modify slide. 

TARTING POWERPOINT 

To start your PowerPoint presentation make sure MS Office 1s installed m your 
computer properly. To tart a PPT take the following steps: 

Step I: Click Start Button. 

E~ample to Start Power Point 



Step 2: Select all program from start menu. 

Example to Start Power Point 

Step 3: Select MS Office from sub menu and click on it. 

Microsoff Office 

Example to St rt PowerPoint 

Step 4: Search for MS PowerPoint, select and click iL 

Micro oft PowerPolnt 2010 

Examp le to tart Power Point 
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This will launch your PowerPoint application and the following creen will appear. 

Click to add title 

PowerPoint Window 

15.3. l Creating a Pr e entation 

Once you launch your MS PPT application all you need to do is add content to slide. 
You can add more than ne slide in presentation. You can have a variety of animation 
sound effects to make pres ntati n more interesting. Take the following steps to create 
a presentation in PPT: 

• Open MS PowerPoint. 

• Click file menu and select new option. 

• Select design that suits your r quirement. Go through aU the available options. See 
preview of applied de ·ign so be sure how it looks like. 

• Add slides in your presentation. To add slides in your presentation click on slide 
pane, left click current slide and choose option "add slide" this will open slide 
dialog box from this, elect design for new slide and press ok to exit slide dialog 
box or press enter. 

• Add animation and ound to your presentation, if required. 

• To add transitions in between your slides, click the 'Animali ns' tab at the top of 
the page. 

• Once you have all y ur lides made, you can change the order of the slides. To do 
this, click and drag the slide from where they are to where you want them in the 
order. 

• Once you have aU your slides completed and in the order you want, view your 
slideshow. Click th 'Slide how' tab at the top of the page and select 'From 
Beginning'. 



Click to add title 

Click to add notes 

Power Point Ribbon and Menus 

Menu Category Ribb on Commands 

Home Clipboard functions, manipulati ng . tides, ~ nts, paragraph settings, drawing 
objects and editing functions. 

Insert Insert tables, pictures, images, shapes, charts, special texts, multimedia and 
symbols . 

Design Lide setup, slide orientation, presentalion themes and background. 

Transitions Commands related to slide transi tions. 

Animations Commands related to animation within the individua l sl ides. 
. -

Slide Show Commands related to slideshO\ set up and previews. 

Review Proofing content, language selection. comment and comparing 
pre entations. 

View ommands related to presentation views, M te r lide , colour settings and 
window arrangements. 

15.3.2 Creating a Presentation with AutoContent W izard 

The AutoContent Wizard guides you by providing tep by step process for creating 
presentation. AutoContent Wizard is very much b lpful in when you want to create a 
presentation quickly. U ing this method, you can save a lot of tim while. All you 
need to do is to i ert slide content. It takes followjog tep : 

• Open PowerPoint. 

• Click file dropdown menu and select new opti n. 

• Click on Aut Content Wizard, this will open AutoContent di log box. Select your 
presentation type and press next to continue. 
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en:.i < 

start.db-, 
forycu 

□ C 
C 

Sn 

PowerPoint AutoContent Wiza rd 

Erish 

• Click the butto to brow e the different presentation type categories. 

• Select the output type of your presentation. And click on next. 

PowerP int utoContent Wizard 



• Give name to your presentation. Also select appropriate options for the footer 
note. And cl ick next. 

c.ul I 

Power Point AutoContent Wiza.rd 

• On final screen click fini h to end. 

Now your presentation is ready to use, replace the content with your own content. 

15.3.3 Creating a Presentation Using a Design Template 

One way of creating a presentation is to start from scratch. However, you can save 
time and effort if you ba e your new presentation on a template. A template defines 
the background, font styles, colours and sizes for y our placeholders as well as selected 
bullets that match the template. Using a template means that you don't need to worry 
about defining tho e aspect yourself. PowerPoint ome with a number of stylish 
templates built-in that you can use immediately 

To create a presentation u ing design template, follo the e steps: 

• Open MS PowerPoint. 

• Click new option from fil e menu to choose designs from template gallery. 

• Or click on design tab to insert des ign. 

• Select design that suits your requirement. 

• Double-click the de ign to insert. 

• Remember that you can have one template design for one pre entation. Different 
slides cannot have different designs. 

Design Template 
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15.3.4 Creating a Blank Presentation 

When you choose to create a presentation with blank mode, then you get freedom to 
design your own template, you can do things from scratch. Take the following steps to 
create blank presentation: 

• Open PowerPoint. 

• And choose blank template to make blank presentation. 

• Or open file menu then choose new option and from t mplate gallery choose 
blank. 

• Use the Slide Layout pane to spe ify which placeholders will go on a slide. 

)SMdelayout 

Apply •hde layout: 

Tr.ld:Layoutt" 

BD 
~,=El·= == == 

Content l1'youl5 

□[TI] 
rn]]m] 
~~□" l~ol!~LJI., @!ii'<,,, __ ..._ __ 

Apply•~ ternpWe: 

Click to add title 

Click to add subtitle 

PowerPoint Blank Presentat ion 

• Choose blank slide layout to mak blank presentation. Though this process can be 
very time taking becau e you have to do things from cratch . 

• In a blank PowerPoint presentation, each new slide you create is completely free 
of any design elements wh tsoever. 

• Keep adding slid to your presentation to add content to your design 

• By default every presentation must a have title to it. 

• Make sure you Save your pre entation before exiting. 

15.4 POW.ERPOINT WINDOW AND ITS ELEMENTS 

MS PowerPoint i one of the mo t common tools used for creating professional 
presentations. By us ing PowerPoint window, you can display ideas to audience in 
most creative possibl way. Thi is a very important tool of MS Office suite. It also 
contains menus and toolbar lik any other application of MS Office suite. But PPT has 
a variety of unique tool that no oth r application bas like lide show, sl ides, etc. 
Following are the elements of P werPoint window: 



Fjle Tab 

File Tab Honie 
Ribbon 

Slide Tab Notes Section 

Quick Access Toolbar 

Titl Bar Slide Area Help 

Click to add title 

Tr 
Slide View Zoom Options 

Anatomy of Power Point 

These tabs allow you to manage files and ttings in PowerPoint. By using these tabs, 
you can open, close, save etc. pr sentation. 

Ribbon 

The ribbon contains three components: 

Ribbon Control 

1. Tabs: They appear across the top f the Ribbon and ontain group of related 
commands. Home Insert, Page Layout etc are example of ribbon tabs. 

2. Groups: They organize related commands; ach group name app ars below the 
group on the Ribbon. For example, a group of commands related to fonts or a 
group of commands related to alignment, etc. 

3. Commands: ommands appear within each group as mentioned above. 

Title Bar 

It i.; on the top of the window and it displays the name of curr~ntly open file . 

Slide Area 

This is the actual working area in which you insert ontent in a pr~entation. 
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Help 

This option supply help regarding Power Point issues. Click "'. " icon or press F 1 for 
help. You can also use the help menu. 

Search Bar 

PowerPoint 

Browse PowerPoint Help 

Wh sn 

Acti 1n9 PowerPornt 

F,lem gemen 

• 

• orlang rth tables 

Sm 

• sh pcs 

nd form ng 

Usingma ers 

o ng with an,matio11 

• o ng t m ,es 

Browse by To p ics 

• Insta lling 

• 

Gettlng help 

Gett.mg start~ r h 
Po mJoint 

Spellrng. 9 m r, and 
esaurus 

orktng with charts 

h ptctures 

U:;ing templates 

Wotlcmg 1th sounds 

orlcing h h)'pffltn 
and acbon buttons 

h transmom. Rrvt 

P erPo:int Hep 

Help Window 

Zoom Options 

This option allows you to have a closer look at text. Use + and - buttons to increase 
and decrease zoom respectively. + button is used for increasing zoom and - button for 
decreasing zoom. Defa ult zoom is 100%. 

Quick Access Too/bar 

The Quick Access Toolbar is located just under the ribbon. This toolbar offers a 
convenient place to group the most commonly used commands in PowerPoint. You 
can customize this toolbar to uit your needs . 

Slide Tab 

This section is available only in the ormal view. It displays all the slides in sequence. 
You can add, delete and reorder lide from this section. 



15.5 USING HELP ONLINE & CUSTO MIZI G OFFICE 
ASSISTANT 

Office Assistant is an animated character of MS Office that brings help for various 
topics. This office as istant was named as "Clippy". This feature was introduced in 
Office 97 and got discontinued in Office 2003. However most of the user find it 
annoying hence got discontinued. Office Assistant is a function that helps us to find 
help regarding anything in office suite. 

..... 

It looks like you're 
writing a letter. 

Would you like help? 

e Get he:lp with 
writing the letter 

e Just type the 
letter without 
help 

r Don't show me 
th is tip again 

1 

. 2 

You muat cloae and then reopen Excel 
2003 for the change tu uike erfect 

~ 

.J 

• X 

Se also 

l 
~~ t~-~--~ -~--

:-:-~ ========;;;;;;;;-;-:-l•;::I ====~~:-~.~,r 
Online Help Window 
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Online Help 

It is a feature of office ujte to take help for various topics from internet. All the office 
suite programs have ther own help function but if you are looking for some very 
specific solution then you can take online assistance. For example, if you want to 
insert picture in a word document then you can brows internet to see the process and 
steps involved in in erting a picture in a document. Remember that using help search 
you can only browse offline help and for further reference help browser will redirect 
you to internet by it elf. Online assistance is a very helpful feature of office suite for 
beginners. To get in tant help in MS Office press F 1 shortcut key . 

Chi:ck Your Pro~rcs. 

Fill in the blanks: 

l. PPT stands for --- ---
2. PowerPoint makes presentation on _____ _ 

3. You can insert ______ and ______ in presentation. 

4. PPT templat is ___ __ _ 

5. Slideshow butt n i u ed for ------

6. Design template aid in ___ __ _ 

15.6 LET US SUM UP 

• PowerPoint presentation i a mo t powerful tool for creating presentation and 
putting your idea infront of everyone in most creative po sible way. 

• PPT is the extension u ed ti r PowerPoint file . 

• You can use tempi e and wizard kind of feature of PowerPoint for quick 
modelling of presentation. 

• PowerPoint has a variety of tools and m nus for easy and flexible working. 

15.7 LESSON END ACTIVITIES 

1. Create a presentation using blank presentation mod 

2. Create a presentation using wizard. 

3. Explore menus and tools of PowerPoint 

15.8 KEYWORDS 

PPTextension is used for PowerPoint fi le. 

Templates are like prototype model available in editable mode. 

Slide acts as a placeholder in which you insert your presentation content. 

Slideshowis a button used for executing presentation in full screen mode. 

WiZJrd is a step by step proce of problem solving. 



15.9 QUESTIONS FOR DISCUSSION 

1. Explain the importance of PowerPoint. 

2. What is PowerPoint Wizard? How can we use a template to create presentation? 

3. Explain all the element of Power Point window. 

4. How to get online help in PowerPoint? Explain. 

5. What is a slideshow? 

6. How to use zoom option in slide? 

7. What is slide and how to add slide in a PowerPoint program? 

Check Your Progres : Model Answer 

I. PowerPoint pre entation 

2. Slides 

3. Animation, ounds 

4. Design prototype 

5. Executing pre entation 

6. Quick fonnation of presentation 

15.10 SUGGESTED READINGS 

Jennifer T. Campbell , Steven M. Freund, Mark Fryd nberg, 2016, Shelly Cashman 
Series Discovering Computers & Microsoft Office 365 & ... 

Gary B. Shelly, l 995 Microsoft Qffjce. 

Advanced Concept and Techniques expands on tho e projects, showing you 
additional capabilities that help increase your productivity. With Introductory 
Concepts and Techniques, you'll gain a better understanding of Microsoft Office 
Manager. 

Joesph Habraken, 2001 , Microsoft omce XP 8-in-l. 
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16.8.1 Creating a Table 

16.8.2 

16.8.3 

16.8.4 

16.8.5 

Chart 

16.9.1 

16.9.2 

16.9.3 

16.9.4 

Creating an Embedded Word Table 

Adding Columns and Rows, Deleting Columns and Rows 

Changing Table B rders 

Using AutoShapes 

Inserting a Clip to Your Slide 

Using WordArt and Inserting a WordArt 

Working with Drawing Toolbar and Creating Shapes 

Inserting hap in PowerPoint 

Let Us Sum Up 

Lesson End Activities 

Keywords 

Questions for Discussion 

Suggested Reading 

16.0 AIMS AND OBJECTIVES 

After studying this les on, you should be able to: 

• Make use of drawing object 

• Format text using WordArt 



• Use spelling check 

• Insert and customize table 

• Create Charts and Data source 

16.1 INTRODUCTION 

In this lesson, w will learn to format PowerPoint presentation. We will also learn to 
insert tables and other drawing objects in presentation. Tables are very important to 
store and retriev data. By using tables, we can display data in a very organized way. 
PowerPoint has tools for inserting table so that you can demonstrate data and 
information in an ea y way. 

16.2 ADDING TEXT TO SLIDES AND 
EDITING TEXT IN A SLIDE 

Having quality text in a presentation is essential for good slideshow and very 
important from design prospective. PowerPoint has extensive tool for text formatting. 
For having a variety of text style and fonts in PPT we use home tab under home tab, 
there is font group offering a variety of fonts and text tyle. You can also modify text 
style and font style by right-clicking on slide. 

Home Ribbon 
Foo t Grou p 

Cilek to dd till 

• Sample Text to ba cut/ copl 
• Sample Text error 

•Orr•~ 

Click 10 dd title 

• .S.mpk Ttxt"' be r:uv coplrd arul pa.i,, 

• Sample Tm In..,,,.. 

• Orpnrttd 

Adding and Inserting Text in a lide 
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This opens up the Font dialog which contains all the font management features 
available under the font section in the Home ribbon. 

Font 

~ 

B 36 

Font!;Olol" 

Effi!m 

[:] ~ OIOf[g 

-:; S~ttnugh 

r' Doub[e Slnkethto.ioh 

0 _t 0% 

sm Caps 

~ Caps 

E~ Olaracter Heq,t 

Font Dia log Box 

PowerPoint has w II defined system for inserting text in a pre ·entation to make sure 
easy readabili ty. To add text in a PowerPoint presentation is simple, all you need to do 
is click on te t box provided by PowerPoint and start typing in ide it. Every text box 
comes with it default setting all though it can be modified. Below is a sample of 
default textbox used for text in rt ion. Every slide in PowerPoint have one title box 
that desc ribes what slide is about, but it is optional you can alway choose blank side. 

Title Box 

! 
Click to add t it le 

o add ub, le 

t 
ubtille Box 

Tit le Box and Subti tle Box 

Title Box 

This is typically found n slide with the title lay ut and in all the slides that have a 
title box in them. This box is indicated by "Click to add title" . 

Subtitle Box 

This is found only io slid with the Title layout. This is indicated by "Click to add 
subtitle''. 



Text Only Box 

This is not a default content box available in PowerPoint but you can create it by using 
Slide Master, if required. This is also indi ated by "Click to add text". The only 
difference between the Text Only Box and the Content Box is that Lhe former only 
supports text in the content area. 

To Edit Text on slide all you need to do is to select text and pre s remove text that . 
you want to modify rewrite new text. To edit text in any existing file you need to open 
that fil e. All standard text manipulation functions are po sible while editing text n 
slide. Text manipulation functions are same as what we saw in lesson MS Word. You 
can use Cut, Copy, Paste, Delete functions while editing text. 

16.3 USING FORMAT PAINTER 

Format painter i a tool of MS Office uite. This tool is available in all programs of 
MS Office. It allows you to copy the formatting from one object to another object. To 
copy formatting u ing format painter, fo llow the following steps: 

• Select the text that ha formatt ing a per your requirem nt. 

• Click the format painter button on the standard toolbar 

• Mouse pointer will turn in bru h like icon J!.I 
• Select the text to which you wish to apply fomiattiog. 

• Double-click the Format Pai nter button to opy formatting to more than one piece 
of text. When you have fi nished copying, click the Format Painter button again to 
tum it off. 

16.4 SETTING PARAGRAPH INDE TS 

Paragraph indent are u ed fo r beautifying text. By using paragraph indents , you can 
make it easy for reader to understand content. Following is a procedure us d in PPT to 
insert paragraph indent. 

Select text cont nt to which you want to insert indents. 

Indenting on text work for whole par graph it will not disturb your text s ttings at all. 
You can select more than one indenting for various paragraphs . 

Go to paragraph group under home ribbon. 

Paragraph Indent 

Select one of the indentation options. You wi ll notice that by default the text is s t at 
the lowest indentation level, so you wiU not be able to decrease it further. You must 
increase indentation th fir t time you use it. 
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Increase Inden t op tion enabled 

Click to dd title 

Sample text for paragraph indentation 
demonstration. Sampf text for par gn,ph 
Indentation demonstration. Sample text for 
p ragr ph ind ntation demonstration. Sample 1 

text for paragraph indentation demonstra Ion. 
Sam pl text lor p ragraph indent lion 
demonstration. 

-0 

Indenting O ption 

One you have increased the indent, decrease indent option gets enabled. 

Decrease Indent £nab)ed Increase Paragraph Indent 

- - -
e "'"' ror par r p1unden ,on tnt!On. 
~ or pa,1p•pt, ,ric1111t on~•• 

mpl I xt for par IV ph indentafion 
demonstratio . Sample textforparagn1ph 

' Ind nt tlondemon~uation. Sampl t xtfor 
, paragraph indentation demonstration. 
I 

Inden t ing Opt i n 

:: 



16.4.1 Line Spacing in a Paragraph 

While working with a lot of text content, it is considered as good practice to keep line 
spacing. Line spacing tool of PowerPoint helps you to change the spacing between 
lines in the text. Take the fo llowing steps to insert line spacing in a paragraph: 

• Select the text to which you want to apply line spacing. 

• Select paragraph group button under home tab. 

roup 

Line Spacing Option 

• Select one of the line spacing option from the dropdown list. 

Line Spacing Option 

Sample te.xt for paragraph Indentation 
demonstration. Sample text ra paragraph 
indentation demonstration. 

Sam le text for paragraph indentation 
demon tration. Sample t xt for p gr ph 
indentation demonstration. Sample text for 
paragraph Ind ntation d mon a ion. 

Line Spacing Opt ion 

• If you want to customize the spacing choose "Line Spacing Option' . 

• This will open Paragraph dialog box. 
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Indents and paong 

General 

Alq-.nent: 

Indentabon 

Befute rext: O on 

I 

7.63 p 

Op 

B 

~ dal: 

~ uoe Spacing: SirlQte B 

Par agraph Spacing Line Spacing 

Paragraph Dialog Box 

cancef 

• The spacing secti a in the Paragraph dialog has two settings. The Before and 
After are the spacing for paragraph a a whole, while Line Spacing is the spacing 
for lines within the paragraph itself. 

16.5 SETTING AND REMOVING TAB STOPS 

Tab stop is a term used ford scribing the 1 cation of the cursor stops after tab key is 
pressed. This tool is L ed to align text using Tab key. ln Microsoft Office, the tab 
selector, also called th tab indicator, it i · a button to th left of the ruler that supplies 
the user with a variety f tab mar er options. It is very common to insert tab stop in a 
word document. You can insert tab stop before or after inserting text. Tab stop 
changes from ection to ecti n within a ingle document. Each line can have its own 
unique tab stop. 

Types of Tab Stop 

• Left text is extend d t the right of the tab. 

• Centre text is allied in middle. 

• Right text is ext nded lo the left of the tab. 

• Decimal text before the decimal point extends to the left and text after the decimal 
point extends to th right. 

• Bar, a vertical bar is shown on the tab. 

16.5.l How to Crea te a Tab Stop? 

Easiest method to ere te tab top is to double-click on the ruler th is will open the tab 
window pop-up as shown b low. From th is tab window, you can specify the type of 
tab stop and can also pecify the po it ioning from tab window. 



Ta 

.:J 

Defaul tab stops: 

Alignment 
r 1,.eft 

r k_entf:r 

r BJght 

Leader 
r . 
r 2 ..... 

Tab s!Dps to be cleared: 

r Q..ecJmal 

• [ar 

(" 3 __ 

r 

OK Cancel 

Tab Stop Alignment 

16.5 .2 How to Remove a Tab Stop? 

:B 

To remove tabs stop in Word from the ruler for a elected line (or lines), first click 
into the line of the document you wish to change, or elect the lines you wish to 
change. Next, click and drag the tab stop you wish to remove from the horizontal rul r 
and drop it into the do ument area. That will rem ve the tab t p from the selection. 

16.6 CHECKING PELLING OF THE TEX 

Spelling check is a feature of PowerPoint that check errors for an entire presentation. 
To use this feature, you need to first set the Pro fing Ian age from the Language 
section under the Review ribbon. 

L nguag Secti on Recv1ew Ribbo n 

Click to add t ti 

• Sample Text to be cut/ cop,ed and pasted 

• Samr:> 1 T t In erorr 
• Orpnlsed 

Proofi ng Langu a 0 e S tting 
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Through language dialog box you can select languag for presentation. If you want 
same language for every pre entation then mark it as default. 

Languag 

selected text as: --------------, 
~ English (Canada) 

Afi"1kaans 
Abanian 
Alsatian 
Amharic 

A 

Language Dialog Box 

Once the proofing language is set you can see it at the bottom of the PowerPoint 
window. If there are proofmg errors in the presentation, you will also see an icon of a 
book with a red cross on top of it. 

Cl ic t o add title 
. - ----

• Sample T xt to be cut/ copied and pasted l 
• Samp I Txet In erorr 

• Org.anlsed I 
I 
I 
I 
I 
I 
I 

~ 
I 
I 
I 

I 
I 

Errors in pre enta tion Selected Proofin g Language 

Spelling Check Option 



If there is spelling error in presentation then it will be shown as red underline text 
indicating that word you in erted do not match the prototype of existing dictionary. 
From spelling dialog, you can take necessary actions to correct it or to ignore it or to 
add as a new word in dictionary of current language. 

I 

Spelling 

Not ii Dictionary; 

0,ange to: 
Suog,es ·ons: 

Setting Dia lo Box for Spelling Check 

Spelling Dialog Option & Descrip tion 

Ignore 

Ignores the error for the current instance. 

Ignore All 

Ignores the error for all the instances in the presentation. 

Change 

Accepts the suggested change for the current instance. 

Change All 

Accepts the suggested change for all the instances in the presentation. 

Add 

Uses the first suggested word ea b time you click Add. 

Suggest 

Includes this word in th PowerPoint dictionary . 

AutoCorrect 

Automatically correct imilar errors going forward. 

Close 

Closes the Spelling dialog. 

Options 

Sets up how PowerPoint should proof the presentation. 

16.7 FINDING AND REPLACING THE TEXT 

~i 

-

Find and replace i an integral tool of MS Office uite. This tool allows you to find 
specific string (text) and replace it with another strin (text) Thi tool is very useful 
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while working with large am unt of text. Take the following steps to apply find and 
replace text in PowerPoint: 

To Find Text 

Under editing section click "Find". 

Home Ribbon Editing Sec tion "Find" enu 

Sli de #3 

Sam le Word Art 

F ind and Replace Option 

Type the text you want to earch in "Find what" text box. 

Find 

only 

Find Dialog Box 

You can refine your earch by checking the "Match ca e" check box and "Find whole 
words only" check bo . 

Click "Find next" to find next occurrence of text. 

The Find dialog box does not di appear after finding the fir t instance, so you can 
keep pressing "Find Next" multiple times till you reach the end of the search. At this 
point, you will rec i ea me .. age from PowerPoint indicating the end of the search. 

chng presien lion, 

Comp let ion Notice 



To Replace Text 

Under editing section click "Replace" option. 

Hom e Ribbon Editing Section "Replace" Menu 

Slide #3 

• Compare Tellt 1 • Compare Text 2 

• 0----------0--------Q 
9S le 

Replace Text Option 

Enter the text you want to replace in find ''Find what" text box. In Replace text box, 
enter the text you want to replace it with. 

Repl e ~ 

FIQdwhat: 
Art 

Rei;tla~ th: -------------=<' Smart -------------~~--=-
Matdigsse 

E]Fild words only 

Replace Dialog B x 

You can narrow your earch by sele ting "Match Ca e" and "Find whole words only". 

The Replace dialog does not disappear after find in° the first instance, so you can keep 
pressing "Find Next" multiple times till you reach the end of the search. At this point, 
you will receive a message from PowerPoint indi ting the end of the e rch. 

239 
Texl Formaning in Slide Along 

with Inserting Table and 
Drnwing Objects 



240 
Windows and MS Office 

Moving Slides 

Arranging slide is important when you want a very well organized presentation. 
Keeping proper sequencing among slides is very important to make ·successful 
presentation. To do so we move slides from one part of presentation to another part. 
You can rearrange slides from two views in PowerPoint. 

l . Normal View 

2. Slide Sorter View 

Take the following rteps to rearrange slides using different views: 

Normal View 

Select slide to be mov d. 

Drag and drop slide to the position or sequence you want to keep it. 

Slide#2 

• mple1i xt 1 

• Only lel<t bO>< content 

Selec t e d Shd Inse rt Position 

View of Slide 

You can also use cut and paste method to move slide from one location to another. 

Slide#2 

,le Text 2 

tellt box ontent 



... 
Click to add title 

• Click. to add text 

.. ' 

View of Slide 

16.8 CHART AND OTHER DRAWING OBJECTS 

Charts are very important tool of data representation. PowerPoint allows you to insert 
a variety of charts in presentation. While working with huge data it is important to use 
charts to display useful information. Presentation charts are used for information 
representation. Drawing object is another feature that allows you to make you 
diagrams, charts, etc. 

16.8.l Creating a Table 

Table 

Tables are a very important and powerful tool of data repre entation. This tool keeps 
information intact at one place which makes it easy to read. PowerPoint allows you to 
insert table in pre entation and these tables are compatible in xcel al.so. You can 
format table in PowerPoint like in any other appl ication of MS Office. In your 
presentation, you can insert table by taking following steps: 

• Click Insert tab then select table to insert table. 

• Describe table dimension from table matrix using table drop down button. 

• PowerPoint table is a sim ple table that does not supports the mathematical features 
of an Excel spread heet. If you want to carry out ome calculations, you can insert 
an Excel spreadsheet in tead of a regular table. · 

16.8.2 Creating an Embedded Word Table 

You can create a table in PowerPoint itself or you can call table from some other 
application using technique such as: 

Object linking: This mean the table has been created in another application, maybe 
Word. There is a connection between the two files and the de tination file can be 
updated when the original fi le is updated. 
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Embedded object: This mean the table ha been created in another appli ati n, may 
be Excel. nee embedded the object becomes a part of the destin tion fi le and no 
longer has a link to Lhe original file. Any changes made are only reflected in the 
destination fi t . 

To create embedded word table take the fo llowing steps: 

• Click insert tab elect object under insert ribbon. 

• This will open object dialog box a king you to select option. 

• Sekct Word document. 

• Or you can choose any existing file that have table of your interest. 

• This will open the application that you are trying to embed in your presentation. 

• Create a table in word a word has m r table fomiatting options. 

• Save file and exit word. 

• Once you do this tab le will appear in your presentation that you reated in word. 
When you embed a Word table into a PowerPoint presentation you wi ll need to 
double-click it to open it. The toolbars and drop-down menus w ill change 
automatically wh n the table is active allowing to you to edit it. 

16.8.3 Adding Columns and Row , Deleting Colu mns and Rows 

While making table thj happen very often that the table run hort of rows or columns 
or sometime both in that situation we need to add rows and columns to table manually 
to do this take fo ll wing teps: 

To Add Row 

Click a table to cell in the row above or below where you want the new row to appear. 

Under "Table Tools" on the Layout tab in "Rows & columns" group do one of the 
followi ng: 

• To add row bove selected cell use option "Insert Above' . 

• To add row below 

Delete Insert ln5ert Insert Insert 
Above Below Left Right 

Rows & Columns 

Table Op tions 

Rem mb r tha.t To add multiple rows at once, using your mouse, drag to select an 
equal number of r ws to the amount that you want to add. and then click Insert 
Above or Insert Below. For example, select three existing rows, click Insert 
Above r Insert Below, and three more rows will be added. 

To Add Column 

Click a table cell to the right or the left of the column where you want th new column 
to appear. 



Under "Table Tool " on the Layout tab in "Row & columns" group do one of the 
following : 

• To add column to the left, select "insert left" option. 

• To add column to the right, select "insert right" option. 

Delete Insert Insert 
Above Below 

Insert 

Left 

Row s & Columns 

Table Options 

Insert 
Right 

Remember that To add multiple columns at once, using your m use, drag to select an 
equal number of column to the amount that you want to add, and then click Insert 
Left or Insert Right. 

Deleting Columns and Rows 

Click a table cell in the column or row that you want to delete. 

Under Table Tools, on the Layout tab, in the Rows & Columns group, click Delete, 
and then click Delete Columns or Delete Rows. 

Insert Insert 
Above Belo 

~ J 
O-lete Co ns 

., 
DelEteBo .. 5 

Table Deletion Op tion 

Or you can select the row and column that you want to delete by holding mouse click 
and dragging mouse over the table to select more than one row or column. Now press 
delete key available on keyboard. Or left click mouse to open property dialog box now 
select "Delete" option to remove rows and columns. 

16.8.4 Changing Table Borders 

In MS Office, you have fac ility to add border and hades to all four side of table. By 
applying border and shading, we can create a great ernpha is on table and it brings 
more eye focus on table. Apart from everything it makes the tab! look more beautiful. 

Go to Design > Table Tools >Table Styles > Borders, and then click the border option 
that you want to change. 

Add Borders to a Table 

Take the following step to add borders in table cell : 

• Select the table to which you want to add borders. 

• To select table, click over anywhere on table. 
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• The above step will make a cross icon visible at the top left comer of the table. 

• Click cross icon to elect entire tabl . 

• Click the border button to di play a list of border option · for selected table. 

• Choose the most suitable one by clicking it. 

• Try different options before making final decision . 

• If you want to delete border select "No Border" option from border section. 

• You can apply border to any cell col umn or entire table as well. 

• Go to Design > Table Tool . Select one of the following in the Draw Borders 
group. 

• Use Pen Colour to change the colour of the border. 

16.8.5 Using AutoShapes 

While working with pictures you cannot insert text to it directly. So how to insert text 
to images? To do so we can use AutoShape option to insert text to images directly. 
This tool of MS Word makes image more interactive and it becomes easy for us to 
explain some scenario. To insert Auto hape in a document take the following steps: 

• Select insert toolbar. 

• Click Drawing option . 

• Click AutoShape on Drawing toolbar. 

• If you want to add colours to a graphic then click on colour button. 

• Navigate through the pictures in picture gallery and click on insert to enter image 
in a document. 

• With the shape still electe right-click the shape and select Add Text option. 

• Enter the text you want to display. 

• Change font if required by right-clicking it. You can perform all text formatting 
operation on text in erted. 

• Insert AutoShape by clicking the Drawing too)bar at the bottom of the 
PowerPoint screen. A Ii t of options appears. 

Click Insert Picture -t AutoShapes 

AutoShapes 

I.hes 

CO(Ylectors 

~asie Sh.-pes 

Block ,'\rrows 

Elowchart 

:;:tars and Banners 

~olb.ts 

Act[on Buttons 

Mere AutoShapes ... 

' ', D O 



16.9 CHART 

Charts are an efficient way of information representation . In PowerPoint, we have 
tools to insert charts in presentation. Take the fo llowing steps to insert chart in 
Power Point: 

• Click insert ribbon. Select charts option available under chart button. 

• Click chart button and select chart type from chart gaUery. 

b1ur1 Ribbon lllutrrall ons Group 

Types of Charts Available in PPT 
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• Double-click on hart that you want to insert in your presentation. 

• As soon as you cl ick the above option along with this an excel worksheet will get 
launched. This worksheet will act as a data source for your chart. You can modify 
various fi elds and values as per requirement. 

.!l 

2 category 1 

t &OfV 2 

c.te1ory3 

~ Clle 4 

(, 

7 
!! 

9 

0 

Jl 

Ch•tt In M,ao oft P ,n>omt • Mi<rosoft b.cel 

4 .3 

2.5 

3.5 

•l.5 

2.4 

4.A 

18 
2.8 

2 

2 

3 

5 

To l'tiile d'lart data range, drag lower r;gt, t comer ot 111 

S ur ce Data fE xcel to Modify Chart 

• You can also source table values to modify chart. 

16.9.1 Inser ting a Clip to Your Slide 

ti 

PowerPoint upports multim dia in slides. Y u can add audio and video clippings to 
your presentation in order to make it more interesting and interactive. Take the 
fo llowing teps to in. ert audio and video clippings in presentation: 

• Cli k insert ribb n and select media group. 

loser! Rlbhou Media Group 

Clip Inserti n 



• To insert video select video media type, to insert video from file within a 
computer select "video from fi le" option. Browse location to in ert video in 
presentation. 

Video options Video media 

17 

Cl ip In rtion Options 

• Now you can view video from your slide. 

• T insert audio follow the same procedure, ju l sele t audio as media type and 
then browse I cation of fi le to insert it in pre entation. 

247 
T xt Formatting in Slide long 

with lnsening T:ible :ind 
Drawing Objects 



248 
Windows and MS O ffice 

Audio a nd Yid o Op tions 

16.9.2 Using WordArt and nserting a Wor dArt 

WordArt provides us mechani m to add fancy text in pre entation. You can have a 
variety of text fonns in one presentation u ing WordArt you can have various 
colourful font in one PPT. Take th following steps to add WordArt in a PPT: 

Open MS PowerPoint>> open a new or any xisting PPT. Click on PPT where you 
want to have WordArt. 



Click on insert tab >> now click on WordArt option>> this will display the list of 
various WordArt available Ii tin WordArt gallery. 

[)· Signature Lrn IC Equation 

Date & Time Q Symbol • 

□ ObJ~ct • W Number 

WordArt 

You can select any word art from the available list by clicking on it. You can modify 
the inserted text as per requirement. You can beautify text by using arious available 
options. Try it your elf to change text by selecting riou options. By using word art 
you can add a variety of effects to text like flying, c ed etc. Do it yourself to learn . 
more options. WordArt i a quick way to make text stand out with special effects. You 
pick a WordArt style from the WordArt gallery launched fr m the Insert tab, which 
you can then customize. 

16.9.3 Working with Drawing Toolbar and Creating Shape 

In MS Office, we can create custom drawings. You can al o in ert arious shapes and 
figures in PPT. By inserting your own drawin and shap , y u can give that 
personalized touch to your presentation. You can in ert ome pre-defined shapes and 
can also insert your own sh pes in presentation. Take the fo ll wing steps to insert a 
drawing in PPT: 

• Click Insert at the top of the window. 

• Click the Shapes button then click the Scribble icon in the Lines section. 

• Click and hold down the mouse button, then move the mou e u or to draw. The 
drawing will compl te it elf once you let go of the mou button. 

Drawing Too/bar in Microsoft Power Point 

The following table lists the Common Commands in the Drawing Toolbar. 

Item Name Description 

D[aW • Draw Display a menu to flip and rotate, order, change auto 
shape of graphi s. 

[fil Sci ct Objects Button to select any object on the ·lidc. 

A!,LtoShapes • Auto hapes Button to display a menu of pre-defined shapes. 

Draw Lin Button to draw a line. 

~ Draw Arr w Button to draw an arrow. 

□ Draw Rectangle Butt n to dra, rectangle 

Contd. .. 
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Window:, and MS OffiL-c 0 Dm Oval Button to draw an oval. 

~ Dmw Text Box Button to draw a textbox. 

WordArt Button to select a word art sty le for the tex t. 

.. 
0 • lnsert Chart Button inserts a chart into the slide. ... ., 
[a] Insert Clipart Inserts a clipart into a lide. 

~ insert Picture Inserts a picture into a slide. 

. Fill Objc t Colour Colour ticker for th fill olour. 

.I. • Line Colour Colour ticker for line colour. 

A . fon t Colour Button fo r displaying colour ticker for fonts. -- Line Style Button fo r selecting the line styles, thickne. s -
... Dash Style Button for selecting dash sty les. 

.::::t rrow Lyle Button fo r diffi rent arrow Lyles. -
Shadow Sty le Button for different ·hadow ryles. 

30- ryl Button for different 3D effects. . 

16.9.4 Inserting Shapes in Power Point 

To insert shape take the foUowing steps: 

• On insert tab click Shape . 

17 ' Shapes.,,. 

• Cl ick on the shape that you want. 

Shapes 
.... 

• C lick on slide and drag over the mouse to draw shape. 

• For example this 

Check Your Prol!rcss 

Fill in the blanks: 

1. ______ _ b x I used for inserting text. 

2. Format paint is for ___ ___ _ 

3. Paragraph indents ar for _ _____ _ 

4. Line spacing option is available in _ _____ _ 

5. Tab stop is important because _ _ _ _ _ _ _ 

6. AutoShape option is available in ______ _ 

7. Charts in PPT are u ed for - - - ----

f lines. 



16.10 LET US SUM UP 

• This lesson is all about formatting custom settings on PowerPoint presentation. 

• By using various tool and methods, we can in ert charts and table in PPT to have 
better data r presentation. 

• PPT have fi ature · like WordArt and AutoShape to make text and presentation 
more attract ive. 

• Now we know bow to add and remo e slide in PPT. 

• We also saw the significance of text box and t xt content in PowerPoint. 

16.11 LESSON END ACTIVITIES 

1. Create a PPT presentation containing chart and word art. You can insert any chart 
of your choice and WordArt of your choice. 

2. Insert a word table in presentation by embedd d object method. 

16.12 KEYWORDS 

PPT: Short form used for PowerPoint presentation. 

Ctr/: lt is a key available in keyboard, full fonn is control key. This key is used for 
performing various operations. 

Esc: It is a key available in keyboard, full form is escape key. This key is used for 
perfonning various operations. 

16.13 QUESTIONS FOR DISCUSSION 

1. How to insert shapes in slide? Explain how to customize them. 

2. Differentiate between drawing toolbar and WordArt. 

3. Differentiate between a chart and a table . Explain the various methods to insert 
chart and tab le in PPT. 

4. Explain the significance of textbox in PPT. 

5. How to move slide from one place to another explain with example. 

6. Write a short note on find and replace, spelling check. tab stop and text and 
paragraph formatting. 

Check Your Progress: Model Answer 

1. Text 

2. Copying style 

3. Text formatting 

4. Under borne ribbon within paragraph group 

5. Under insert tab within drawing toolbar 

6. It helps you to find location of curs raft r text in ertion 

7. Data repre£entation 
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17.0 AIMS AND OBJECTIVES 

After studying this 1 sson, you should be able to : 

• Learn slide feature 

• Know about different views of PPT 

• Insert animations and effects 

• Execute custom show and custom an-imation. 

• Upload PPT's on web 

17.1 INTROD CTION 

This lesson is all about functionalities of PPT. We will explore different views that 
allow you to gain maximum utilization of GUI. We will al o I arn about web content 
and how to upload web content using PPT. PPT's are about animation and effects. 

. , 
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By using animation and other effects, we can increa e the productivity of PPT 
presentation. 

17.2 POWERPOINT VIEWS 

PowerPoint supports multiple views. Every view has it own fu nction and features, 
using these views you can change entire look of presentation. Views can be accessed 
from two locations . 

I. From the bottom of page next to zoom slider bar. 

2. From the presentation view section under view ribbon. 

Title Slide 

Cl C O d SU I I 

PPT Slide 

Presenta tion Vi w R ibbon 

View Ribbon 

t 
; 



17.2. l Types of View in PPT 

Normal View 

This is the default view of PPT. It is used for cceating and editing sl ides. By using this 
view, you can perform all slide manipulation functions uch as create, delete, edit, etc. 

Click to add title 

• Click to add te><t 

Normal View Icon 

View Button 

Slide Sorter View 

t 
; 

By using this view, we can rearrange slide, this view is well suited to resort slide as it 
gives more compact look for lides. 

illddl 

Slide Sorlo,rVlew I on 

Slider Sorter View 

2SS 
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Reading View 

This view is new to PowerPoint 20 IO and it was created mainly to review the 
slideshow without losing acce ·s to rest of the Windows applications. Typically, when 
you run the slideshow, the pr sentation takes up the entire screen so other applications 
cannot be accessed from the taskbar. ln the reading view, the taskbar is still available 
while viewing the slidesbow which is convenient. You cannot make any modifications 
when you are on th is view. 

Sl ide#2 

• Sample Text 2 

• Only text box content 

Reading View 

Notes Pages 

Sample Text 
in a shape 

The notes page view enables you to view speaker notes in slide. You _can print these 
notes for your own reference while executing a presentation . These notes do not get 
displayed while ex cuting a pre entation. 

B 

C 



To access the Notes Page view (without having to print them) select the View tab on 
the Ribbon, and click the Note Page button. 

Notes Page Option 

17.3 USING HANDOUT 

Handout are basically thumbnails of slides printed together on a sheet of paper. 
Handouts are often printed to be sent for review to those wh matter before an actual 
presentation is sho to an audience. During the pre ntation its If, Handouts can be 
distributed to the audience. PowerPoint 97 provides layout for only 2, 3 and 6 slides 
per Handout page - while PowerPoint 2000 allows - , 3, 4, 6 and 9 slides per Handout 
page. 

Unlike slides, Handouts are almost always intended or print so it might be a good 
idea to edit the Handout Ma ter based on that assumption. You need to be sure of 
using content that prints well to both black and white and coloured output. 

c:i file £ dit Yiew Insert FQrmat I ools Sl i.Qe S how 

Window tlelp Acro]2at A font .. . 

Header Area 
~ Slide Des ign .. . 

LJ Handout Master 1,ayout ... 

Handout Background ... 

Cl ose !\·laster View 

Footer Area 

Handout Master Default Design 

Handout Op t ion 
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PowerPoint has the facility to insert header and footer notes in a slide. Having footer 
note helps you to keep tra k of slides but having header in presentation is not quite so 
very useful because in presentation main slide will contain title note of presentation. 
Take the following step to insert header and footer note in PPT: 

• In insert ribbon click on Header and Footer button. 

lnserl Ribbon H eade.r & Footer 
Menu nem 

Slide #3 

PPT Header and Footer Option 

• This will open new h der and footer dialog box having two tabs. 

(i) Slide tab: You can add footer notes using slide tab. 

(ii) Handout tab: This tab is used for creating handout. 

Slide Tb 

Pr 

--- ---- -·----' ' 
; :: : 
: :: 
' ....... ,' --. --· 

Header and Footer Dialog Box 



You can choose various options while inserting header and foot r notes. Foil owing 259 

table describe the various available options. Slides, Views, Notes and Handouts 

Slide Footer Op t ions & Description 

I. Date and time 

Add date and time to the footer. 

Specify the format of the date and time entered. 

Set up the footer to update automatically or use a fixed number. 

2. Slide Number 

Insert Slide number in the footer. 

3. Footer 

Add designated text to the footer - a good example of this i the confidentiality clause or 

4. 

copyright clause. 

Don't show on tit le slide 

Decide on whether the footer information should be displayed on the title slide or not. 

~~Foo~ 

Side Notl!s and Handouts 

tndudeonpage 

';/ Qjltl! and lime 

l,i)dilte automabcaly 

15/01{2!)1-l 

Lar9Jage: 

~ 

JS 

J ~ader 

Englsti{Canada) 

14 

./ ~a,gerunber 

./ Eoo . 

I 

Notes and Handout tab 

I - - - - - - - i 

' . 
' : 
' ♦ -- - - --- - - , 

' ' ' ' ' ' 

Header and Footer Dialog Box 

Following table shows various options available for han out notes. 

Notes and Handout O ptions & Description 
-

I. Date and time 

Add date and time to the footer. 

Specify the format f the date and time entered. 

Set up tbe footer to updat automatically or use a fixed number. 

2. 1 Header 

Add the header information for every page on the handout. 

3. Page Number 

Insert page number in the footer . 

4. Footer 

I 

· Add designated text to the footer - a good example of this is the confidentiality clause 
copyright clau 

or 
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In PowerPoint, you can set slide tr nsition. By using this funct ion, you set slides 
change over during slid how. Take the fo llowing steps to set slide transition . 

• Select slide to which you want to apply transition. 

• Click transition ribbon and then select transition scheme. 

• Select one scheme from the available list. PPT will show you the preview of how 
transition will look like. If you are not happy with the current scheme choose 
another scheme. 

• You can change the effe ts on the selected transition scheme from the Effect 
Options menu. Every scheme has a unique set of ffect options. You can also 
modify time of slide transition. 

• Preview before you apply. 

17.5.1 Custom Show 

Custom show is a very important feature of PPT. By using th is feature, you can 
choose to run some specific tide during presentation. Slide with some common idea 
are usually selected. Custom show i executed by clicking hyperlinks. There are two 
kinds of custom shows option available. 

Basic Custom Shows 

Use a basic custom show to give separate presentations to different groups in your 
organization. 

Hyper/inked Custom Shows 

Use a hyperlinked custom show to organize content in a presentation. 

How to Create a Custom Slideshow? 

To create custom slide how take the following steps: 

• Open the presentation that have more than one slide. 

• Select slide show tab. 

• Click on custom slideshow to expand menu and now select cu tom show. 

lid 

,amma ls 

Birds 

~ 
5-et Up 

Slide Show 

ore facts about foxes 

m Sho_ s ... 

C ustom Show 

Hide 
Slide 



Custom Shows 

Birds 
More f11ds about ro.res 

C ustom Show Dia log Box 

• Click new to er ate a new custom show or you can modify an existing custom 
show. 

• Give a distinctive name to your show, select the appropriate slides and click 
the Add button. Use the arrows on the right if you want to change the slide order 
in your custom show. Then cl ick OK to apply changes. 

5"ha~, ,n .11.rr,.nuhal\ 

D I. Anlmal s 

g 2. Slide Z: Wott 

~ 3. Sltdt 3: f ox 
0 (4) , HJdd•n slide. FOll. More f1ru 1 

0 f5j. H dden !lode: Fo Mort F1c1, 2 

0 7. Slide Si H.nolk 

0 8. Sli d~ 6; Sta-<;iull 

0 9, Shd< 7: ~o1 

Define Custom Show 

_ dd 

SJtllft on twto111 1no 

I. Slldt 2; loll 

2.Stld~3; f<>s 

Defi ne Custom Show Dialog Box 

How to Play a Custom Slide how? 

Right-click on text of shapes and then elect Hyp rl ink. 

Link 1: Mamma 

E xecuting Slideshow 

Select place in this document option. 

? 

0 C•n<d 

Scroll down the list until you ee custom show and seJect the one you need. 

Click Ok to apply. 
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17.5.2 Assigning C ustom Animation 

Adding animation to your presentation is a special feature of PowerPoint. By using 
this feature of PPT, you can make your pre entation more interesting and lively. You 
can apply animation to any object on slide and can insert trigger points for animations. 
By default animation will execute automatically. If you are having more than one 
animation in PPT make sure you keep timing fractions between two effects. Take the 
following effects to insert animation in presentation: 

• Click Animation ribbon and then click on Animation pane to display the 
animation sidebar. 

• Select any object from a Lide and lick on "Add Animation' menu option. 

Selected Obj ect 

PPT Custom Animation 



• Choose any one animation option. 

,..... f ... 

* -· -
C61~fllutY! 

r.•~•~lffab 
., -flllll!O(! *----

* fll'l>I 

.... ,. .... bn.l•lb<, .. -
, ...... 

Animation Gallery 

❖ Entranc will cau e the object to appear in the creen. 

❖ Emphasis will cause the object to empha is without appearing or leaving the 
screen. 

❖ Exit will cau e the object to disappear from the screen. 

• Once animat ion i in erted it will be displayed in animation pane. 
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• By default, all the animations are initiated by a click, but you can change this. To 
change the trigger, right-click on th animat ion obje t on the pane and choose an 
alternate trigger. 

An1ruatJon Timing opUon 

p.,,. 

EJ 

Anunation Tngger options 

Time Sett ing fi r C u tom Show 

❖ Start On 1ickwil1 cau e the animation to start when you click the mouse. 

❖ Start With Previou will cause the animation to begin with the previous 
animation; if thi i the first object, it w ill begin as soon a you reach the slide 
during the slide show. 

❖ Start Aft r Previous will cause the animation to begin after the previous 
animation ends. 

• You can set time du tion for any animation, to do so s lect timing section. 

• Use play option avai lable in animation pane to preview animation. 

17.5.3 Adding a Motion Path 

You an apply a motion p th animation effect to various objects in s iide . Motion path 
de cribes how animation will tart how, low and long it will be e ecuted for and how 
it will exit form slide. Motion path al ode cribes the whole path proce s object will 
go through while executing anim tion. Here in below given example, you can see an 
aeroplane is an object that you can insert i.n slide. Below example di play dotted line 
shows how the plane animation will be executed. 

Motion Pa th 



How to Insert Motion Path? 

To insert in presentation take the following steps: 

• Select object on slide to which you want to insert animation. 

• Click Animation tab and then select "Add Animation". 

s 

Adding Animati n 

• Select one motion path . 

... 

Choosing Path for M otion Path 

• By choosing cu tom path option, you can draw your own animation. Press Esc 
key to stop drawing custom path. 

Custom Path 

17.5.4 Animat ing a Chart 

By animating a chart, you can make a chart more intera tive. Animation makes it ea y 
for its audience to understand data. Following i a step by tep process on inserting 
animation in chart: 

• Add a cha graph, select the proper symbol on tbe "Fonnat'' tab in the toolbar. 

• Select the chart/graph on the slide. 

• Select the "Animations" tab in the toolbar and ele L the anin1ation that you want 
to use. 

• Now by default Pow rPoint will animate the whole chart/graph thus all elements 
will appear at once. To change this behaviour click on ·Effect Options" ( on the 
right side of the different listed animations) to the option of your prefer: 

❖ "As One Object"(selected by default) 

❖ "By Series" 

❖ "By ategory" 
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❖ "By Element in Series" 

❖ "By Element in Category". This option will guarantee that each element will 
get an animation. 

17.6 PUBLISH A PRESENTATION FOR 
HTML FILE TO THE WEB 

Publishing presentation on HTML allows you to access presentation dynamically from 
any pa1t of world using internet. To publish a presentation take the fo llowing steps: 

• Select A1ticulate tab and then select Publish. 

Op ions 

Hdp 

Tool5 

PRESENTER'13 

WEB~ 

ARTICULATE 
ONLINE. 

LMS 

co 

WORD 

ICU TE 

ppor • 
Pr er 

Pubh5h 

Uploading PPT on Web Option 

TD,: aJld l.oalfJon 

./ l~H1M.S 01.1ip,it 

' ~le 1'laWc Pla-,.er Ca- ()Sat Android 

/ Ale,., dcmriDlldng for eftlne w:wlnQ 

fo, 

Pleytt : ~· l'l.,,e, 

~: r.,,,-.; 

l'tesion1'!t": (!ae_ wa_ ~ ~~~-

Uploadin.g PPT on Web Option 

---~ 

5J 



• This will open publish dialog box. From this window, select web tab located on 267 
the left comer of window. lide-, Views, NC11es and Handouts 

• Check the text that appears in the Title field, and customize it if y,ou like. This text 
defaults to the name of your Power Point file . 

• Browse the folder that contains your presentation. 

• If you publish your content for use with the Articulate Mobile Player app, the 
presentation title is also used on the HTML launch page and th list of content 
names in the Articulate Mobile Player library. 

• In the Folder field , indicate where on your computer you want the Presenter to 
create your published output. Click the ellipsis button ( ... ) to browse to a specific 
location. Presenter will create a new folder in that pot with all the files required 
to play your pre. entation. 

• After you publish your presentation to a local folder upload the output to a web 
server to test it. 

17.6.1 Preview a Presenta tion as a Web Page 

You can test the new Web Page at just about any time. You don't even have to save 
your presentation to view it as a Web Page. For a quick preview, select the Web Page 
Preview from Pow rPoint's File menu. PowerPoint ill open the pr scntation, slide by 
slide, in your default browser. 

Slide Show 

Slide show is an ultimate step for any presentation. We create PPTs to execute them as 
a slide show. At the bottom of every PPT window there is a slide show button, by 
clicking it we can execute slide show. All the features related to presentation are 
grouped under slide show tab using this tab you can execut your presentation m 
various style. Check the following table to understand the e features. 

Section 

Start 
Slideshow 

Set Up 

Menu I tem 

Broadcast Slidcshow 

Custom Slideshow 

Set Up Slide how 

lide Show Ribbon 

Slide Show Ribbon 

Description 

us ing Micro oft' s 

Bui lds a cu:;t in, lidl!'lhO\~ by pick ing the slides you want to 
run. 

Help~ set up the ltdeshow including brow ·eri full s.: reen 
display, show optioru, \\ 1th or without narration/animation. 
pen and lu,cr col ur during rhe. lid.: h,m and the , tide IO be 
p ~ ented during the shu\\ . 

Co111d ... 



268 
Windows and MS Olli c 

Hide Slide Helps mark/unmark the slide as bidden, so it is skipped or 
shown during lbi.: slideshow respecti vely. 

Rehearse Timing I lows users tu rehe 1rse the Liming on each slide and the 
ent ire s lideshow. 

Record Slide how R.:wrds the slide~how i11cluding narrat ion and animation. 

Slideshow Chcckboxe Helps set or avoid the use of narrative audio and rehearsed 
timings during the sh w. Displays media controls in the 
sl ideshow view. 

Monitors Resolution Defines re olution in slideshow view. 

Show Presentation on Picks the monitor to display the pr¢Sentation one - in case of 
mu ltiple monitors. 

Use Presenter View Runs presentation in Presenter view rather than just 
s lideshow view. 

17.7 PRINTING SLIDES 

Sometimes it becomes o important to print slides and share it with audience. Imagine 
a situation that you ar addres ing ne r about 100 people, in this scenario if you 
distribute handout to audience it become easy for you to explain presentation to every 
one, because all I 00 audience can't concentrate on your presentation at same time and 
visibility will also be one challenge. With the help of printed I ides audience can take 
notes. To print slide. , you must go to the Backstage view under the File tab and click 
on the Print menu. 

To print slides, you mu t go to the Backstage view under the File tab and click on 
the Print menu. 

The following table de cribes the various printing options available in PowerPoint. 

Main Settings Options Des ription 

Printing Slides Print All !ides Prints all the slides in the presentation. 

Print electi n Prints just the selected objects. 

Pnnt Current Slide Prints just the selected slide. 

Custom Range Defines the slides you want printed. 

lides This is same as the Cu tom Range. 

Print Layout Full Page !ides One slide per page. 

Note Page Slide and notes for every slide printed one below 
another - one sl ide per page. 

Outline Print Slide outline. 

Handouts Prints I or 2 or 3 or 4 or 6 or 9 slides per page -
aligned vertically or horizontally. When you print 
handou " with 3 lides, you get the slide and the notes 
print d next to ea h other. 

Collation ollating Options Prints tides in sequence or prints multiple copies of 
each slide one after another. 

Printing Colour olour Selecb colour, g yscale or black & white printing 
ptions. Although you can e lect any colour settings, 

l1 

th output will depend on the kind of printer you use . 
A non-colour printer cannot print colour slides. 



Fill in the blank : 

l. PowerPoint have and view. 
----- ----- -----

2. Handouts are - ----

3. Page notes are inserted at _____ of lide. 

4. Custom show opt;on is available at ___ _ _ 

5. Animation are in erted on -----

6. 

7. 

_____ adding motion path requires. 

___ __ button execute presentation. 

17.8 LET US SUM UP 

• In this lesson, we saw how to insert animations to pre entation. 

• Now we know how to create motion path; this -. ill give a very personalised touch 
to your presentation, 

• We also saw how to upload PPT to web so that it will be avaHable to us even from 
remote location. 

• Creating handouts and notes can be a very useful element for audience watching 
presentation. 

• Executing a slideshow is an ultimate goal for PPT pre entation. 

17.9 LESSO END ACTIVITIES 

l. Create handout and take printouts. 

2. Create a PPT contaming different animation for various objects. Animation 
should come after 45 seconds, every time add note to every slide describing its 
content. 

3. Create a PPT and upload it over web. 

4. Make a PPT having custom motion path. 

17.10 KEYW ORDS 

PPT: It is a short form used for PowerPoint presentation. 

GUI: It stands for Graphic User Interface. 

HTML: It is a language used for creating web page ii tands for hyper text mark-up 
language. 

ESC: It is a key available in keyboard full form is e cape key. This key is used for 
performing various operations. 

17.11 QUESTIONS FOR DISCUSSION 

l. Write a not on handouts and notes. 

2. What is custom animation and custom show? Explain. 

3. How to run slide show? Discuss the various option . 
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4. How to create a web ba ed PPT? Explain. 

5. Explain the significance of motion path. 

6. Write step by step proce s of inserting animation on various objects. 

7. How to insert header and footer in PPT? Discuss. 

Check Your Pr gress: Mod I Answer 

I. Normal view, Slide Sorter view, Reading 

2. Printable page for user reference 

3. Slideshow tab 

4. Bottom 

5. Slides objects 

6. Defined path fo r object 

7. Slideshow 

17.12 SUGGESTED READINGS 

Jennifer T. Campbell , Steven M. Freund, Mark Frydenberg, 20 16, Shelly Cuhman 
Series Discovering Computers & Microsoft Office 365 & ... 

Gary B. Shelly, 1995, Micro oft o mce. 

Advanced Concepts and Techniques expands on those projects, showing you 
additional capabilities that help increase your productivity. With Introductory 
Concepts and Techniques you'll gain a better understanding of Microsoft Office 
Manager. 

Joesph Habraken, 2001 , Microso.i Qffjce XP 8-in-J. 
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18.0 AIMS AND OBJECTIVES 

After studying this less n, you should be able to : 

• Define a Outlook Expre 

• Discuss the features of Outlook Express 

• Explain the concepts of CC and BCC 

• Define newsgroups 
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Outlook Express is a maiHng utili ty of MS Office suite though it is a discontinued 
feature of MS Office Suite. This is one of the oldest and most ommonly used tool in 
earlier days. Outlook is recently got updated with windows mail and windows live 
mail. 

18.2 WHAT IS OUTLOOK EXPRESS? 

Outlook Express is an e-mailing too l u sed for sending and receiving information from 
remote location. This tool uses Si mple Mail Transfer Protocol [SMTP], File Transfer 
Protocol [FTP] and POP protocol to send and receive data. To use outlook all you 
need to do is to get r gistered w ith outlook express like you do with any other mailing 
service. The basic benefit of this too l is that whenever your c mputer gets connected 
to internet it will prompt you about new mail received, you don' t have to login again 
and again to access you own inbox. This tool offers very high level of security so you 
can completely depend on this tool for sending and receiving e-mails . The reason why 
it got discontinued is becau e of it complicated GUI and less modem features. 

18.2.1 Features o f Outlook Express 

Outlook Express is an inbuilt e-m ii system of Windows operating. It gets installed in 
PC while installing MS Office Suit . This was one of the most popular e-mail systems 
once but ever sine mail and other mailing system came into being, it lost its glory 
that it had in 80s and 90 . Windows also replaced Outlook Express with Windows 
Mail and Windows Live mail. Some of the common feature of outlook are as follows: 

Calendar: This feature lets you c nfigure all upcoming events so that you can plan 
activates accordingly. You can et up reminder that will pop-up the time when that 
event occurs. 

Protects data by scanning: By using this feature, you can et up a filter that will scan 
all incoming and outgoing mai l ' in order to protect your compu ter from viruses. You 
can also blacklist some e-mail addr sses from which you don't want to receive e-mail. 
It also alerts periodically to change password so that the password remains secured 
and known to you only. 

Default e-mail program: The default e-mail program is opened when you click a web 
link in a different application for th purpose of sending messages for instance, when 
mail to link is being cHcked or when you click a send link in_ Firefox. You could 
choose an e-mail program from the list of default e-mail programs by default for 
handling certain action . Various other applications of e-mail can also be used but this 
might lead to invo at ion of the e-m ii cli nt on the In ternet page. 

Reliable: It is a very reliabl mail system as it has very high level security and 
periodically checks viru and malware. · 

Easy to use: It ha easy to handle too l for which you don' t have to acquire any 
special skills . It ha a very strong onl ine upport t troubl shoot problems. It have 
inbuilt help feature s that provide you with step by step proce s of problem solving. 

Available a// time: You can download e-mail to your PC, so you can read it any time. 
You don't have to be connected to int met all the time to view your e-mail. 

18.2.2 Starting O utlook Express 

If your computer is till u ing WindO\ 95, 98, ME, 2000 or XP take the following 
steps to open outlook expres . 



Step 1 

Click on Start menu to launch Outlook Express select Tool drop down menu then -
Accounts. Then the following screen will appear. 

-~u.tiaokf>!'<= 
1.Dtal Faldots 

~ lnbox ( I) 

Sent Item, 

Sync!.-orwm Ill 5~-
Ctrl+Sh,/t+8 
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u) Deloted lt. ___________ _ 
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art.acts • X 
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Ou tlook Account Configura tion 

Step2 
Click on the Add button and select Mail option. 

All Mad ewz Dr clor SerV1Ce 

Account 

Active D11ectory 

§Bigioot lniernet .. . 

VeriSign Internet .. . 

Whoi/,/here Inter. .. 

StepJ 

Type 

direc OI}' service 

directory sew~ 
cf~ectmy seivice 

duectmy rvice 

Connection 

Local Area Netwo1k 
Local.t,rea Netwo1k 

Local Area Network 

Local A,ea Network 

Outlook Mail Settings 

S tQrd 

Ciote 

Enter your display name. Display is that name which will appear to receiver when 
mail is sent from your account. Now Click on Next button to continue. 
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Step4 

Your Name 

When you ;end e-mail. your name will appear in the From Id of the tgoing message. 
Type yo1S nsne you ViOUld ke ~ to appear. 

n C<J11cel 

Outlook Setting to Receive E-mail 

Now enter your e-mail addre s. Make sure you enter a valid e-mail address otherwise 
this step will not complete. ow click on next to proceed. 

lntemet E-taail Addren 

I Your e-11111JI Ilda is the address other people use to send e-ma metiages to you. 

< Back II > 11 [ Caicel 

Outlook Setting to Recei e E-mail 

Step5 

In this step, we select the protocol to send and receive mail. Select POP3 or HTTP for 
incoming mails and elect SMTP ti r outgoing mails. This step is very important in 
order to configure your Outlook E press account becau e by choosing right protocol 



only we can send and receive mails conveniently. Now click on Next button to 
continue. 

Int 

Step6 

M_y incoming mail oerver Is a v server. ~~-- ...... 
A 

An SMTP !Oervet is the server that is used for _your outgoing e-maw. 

Outp,g mail {SMTP] server: 

smtp.1 and1. com 

< Back H 

C 

Outlook Setting to Recei e E-mail 

Cancel 

In this step, you will enter your full e-mail addre a your account name and your 
password associated with your above stated e-mail. If you don 't want to enter your 
password every tim whenever you send or receive e-mail check on "Remember 
password" option. Once you are done with aU formalities click on Next to continue. 

Internet Mail Logon 

Type the «count name and passw01d your Internet service PIOVIIW ~ given _you 

Accounl name: account@1 and1 help. com 

•••••••• 
0 Remember password 

II your lntemel- ervice piovider requires you to use Secure PMW101d . .\ulhenticaticn 
(SPA] to«oen _your mail accOlM1t, select the 'Log On UsJng SecuniPanW01d 
Authen!lcaoon (S PA)' check bow. 

0 Log on umg S e Password Authenticatior, (SPA) 

< Back H ~ ei< > ] I Cancel 

Outlook Setting to Receive E-mail 
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Step 7 

Now your e-mail is configured to your Outlook Expr ss, now cl ick on Finish to exit 
the wizard. · 

Step8 

Yoo have •~ ntered all of the iniorm.:ition required to ~l up your account. 

To save lhffse ,-e1tir,os ck Fnsh 

1....-..:..< ~Ba:.:c..:..k ~l.,._,.Fi,.·•_.I ( Cancel 

Outlook Setting to Receive E-mail 

Now you can send and receive e-mail by clicking Send/Receive button on the top of 
the Outlook Express window. 
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18.3 CONCEPTS OF CC AND BCC 

While composing your e-mail you fill CC and BCC text box to end e-mail. These are 
an optional part of e-mail and it is not at all necessary to fill it all the time. This option 
is used when you are sending mai l to multiple people. 

CC {Carbon Copy}: Put the e-mail addresses here if you are sending a copy for their 
information (and you waot everyone to e plicitly see this). 

BCC {Blind Carbon Copy}: Put the e-mai l addre s here if you are sending them a 
Copy and you do not want the other recipients to see that you sent it to this contact. If 
you are sending an e-mail to many peopl use BCC (so you don't give away 
everyone's e-mail address to everyone else). 

18.4 E-MAIL ADDRESS 

E-mail address is a unique web address provided by service providers to send and 
receive e-mails. Every e-mail have it's unique user name and domain name. Domain 
name is shared among many users whereas usemame or user-id is always unique. To 
get an e-mail addres all you need to do is to get registered with e-mail service 
provider. These service providers will ask you to fi ll a simple onJine registration form 
to get you an e-mail address. 

These forms will ask you question ranging from your personal information to question 
to set your password. Every time you try to get e-mail address then you also have to 
set password for it. U ing this password, you can acces your e-mail. Just in case if 
you loose your password, then you can take help and assistance from your service 
provider to get you new password. 

Example: usemame@domain 

xyz@gamil.com 

18.5 READING AND RECEIVING E-MAIL ME SAGE, 
COMPOSING MESSAGE AND REPLYING AND 
FORWARD ING MESSAGE 

To read and receive an e-mail take the following steps: 

To Receive E-mail 

To receive an e-mail you mu t have an e-mail address. You have to give this e-mail 
address to your friends and family in order to rec ive e-maH . Ory u an join some 
news groups or subscribe for some newsletters. News and newsletters are free mailing 
services that send you e-mail of your interest. 

To Read an E-mail 

To read an e-mail take the fo llowing steps: 

• Open your e-mail account by entering your username and password. 

• Make sure you enter ame usemame and password that you used while registering 
for e-mail addre s. 

• Usemame and password are case sensitive so make sure that you enter correct case. 

• Once you succe fully login in your e-mail account click lnbox to read e-mail. 

• In this box, y u will have a list of all old and new mail received. 
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• Click the mail you want to read, it can be new or old. 

• Once your e-mail content is retrieved, now it is ready to be read. 

• If your e-mail have ome attachment attached to it then you have to download this 
attachment to read it. 

• Click on attachment icon to read attachment. 

• Download attachment to save it on any location of your PC. 

• Open attached file and now you can read this attached file. 

18.5.1 Composing Message and Rep lying 

We compose e-mai l to share some data or information with other user. To compose an 
e-mail all you need is a valid user login and valid e-mail of receivers. If you enter a 
wrong e-mail for r ceiver then e-mai l wi ll not be sent ucces fu lly and eventually will 
come back to you as a bounce e-mail. To send or reply to an e-mail take the following 
steps : 

• Open your e-mail account by entering a valid user name and password. 

• Click on write mail. new mail, compose like option [every e-mail service provider 
have there own tyl ]. 

Now a blank e-mail fonn will open having options like as given below, you need to 
use these options to create an e-mail. Some options are compulsory while some 
options are optional. Once you are done with writing an e-mail all you need to do is to 
send it. Make sure you are connected to the internet properly otherwise mail will not 
be sent. 

TO: In this text box enter the e-mail address of recei er. And it is a compulsory step. 

BC : Blind carbon copy i u ed when you want to send same mail to other users also. 

CC: This also wor ame as BCC. But all receivers can see e-mail Id of other 
receiver as w II. 

Body: Body of e-mail is actual text area where you edit your -mail. 

Send: Click this button to send e-mail once y u ar d ne writing it. 

Attach: This option i used to attach file from your PC to e-mai l. 

Subject: This option give brief de cription what e-mail i ab ut. 

Signature: You can add signature at the bottom or top of e-mail. This acts as a 
salutation. 

Browse: This button i used for brow ing file from your PC. 

Save as Draft: Use thi option to ave e-mail that you wish to send later. 

Font: This option is available with some mailing services, using this option you can 
modify default font of e-mail. 

To Reply 

When you replay to any e-maiJ then options like TO and subjects are filled 
automatically, alth ugh you can modify it as per req irement. To reply to any e-mail 
take the following step : 

• Open your inb x. 

• Select the e-mail that you wish to reply to. 

• Compose the body of e-mail and click send. 

• teps written abo e are applicable whi le replying e-mail. 



To Forward 

We can forward e-mail that is received by us. Sometimes there is a situation when you 
want to send e-mail received by you to someone else. In this cenario, you can use 
forward option available in your e-mail inbox to forward an e-mail, you need to select 
the e-mail that you wi h to forward and then enter the e-mail ID of the person to 
whom you wish to forward it. And then click fi rward button to send e-mail. You can 
modify forwarded e-mail as per your requirement. 

Attaching Files 

Attaching a file is a very integral part of e-mail. By using this feature of e-mail, we 
can share data and information with other users. By using attachment option, we can 
send the files stored in computer. Every e-mail service provider provides the facility to 
attach file saved in your PC. The process of attaching file will tart with composing 
e-mail procedure whlch would be same, the only difference is ab ut attaching file to 
e-mail. Click on attachment button available in compose fonn . Click on it to brow e 
file location. Double-click file that you want to attach. File will appear in attachment 
dialog box, click attach button to confirm. Every E-mail service provider provides 
limited file size that you can attach to an e-mail so if you have bigger file that you 
want to attach than one method is to compress file or you can send file in different 
fragments. Although you can attach more than one file in an e-mail but all attachment 
have to be within that pecified limit. 

18.5 .2 Creating Signatur e in Outlook Expr ess 

An e-mail signature i a word or phrase that i added to the bottom of your outgoing 
e-mail message . A signature can be as simple a J. Smith, for example, or as 
complicated as a lengthy quote from a S!iakespeare's play. 

Add Signature 

• Click the Signatures link on the Preferences. 

• In the Add Signature section, type a name for the new signature in the Signature 
Name box. 

• Type the a tual t xt of the new signature in the Signature box. 

• If you want thls to be your default signature, s I ct Set As Defau lt. 

• Click Save. 

Edit Signature 

• _click the Signatures link on the Preferences. 

• Click the Edit link to the right of the signature you want to change. 

• Type the name of the signature to be edited in the Signature Name box. 

• Edit the signature text which is displayed in the Signatur box. 

• Click Save. 

Delete Signature 

• Click the Signatures link on the Preferences. 

• Check the box to the left of the signature or ignatures you want to delete . 

• Click the Delete button. 
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18.5.3 Formattin g Message Text 

You can modify the text you ins rted in an e-mail. To fo rmat text use tex~ 
modification buttons f Outlook Expr ss, by using these buttons, you can modify text. 
Though only limited text formatting options are available in Outlook. The following 
are the text formatting options of Outlook : 

Line: Inserts a dividing line at the point where your cursor i sitting. All text will be 
moved above or below the line. 

Return: Breaks the line you're typing onto the next line, without starting a new 
paragraph. This is di fferent from pressing the ENTER key on your keyboard, which 
will start a n w paragraph and in ert a blank line. 

Paragraph: Creates h aders and defin s sections of unfonnatted text, by using this 
menu. When you select an option from this menu, it affects al l the text you've typed in 
that paragraph. Remember that if you have used the Return option on the Insert menu, 
that text is included in a paragraph. 

Fon t: Changes the fo nt of text you're about to type, or select some text and change its 
font. 

Size: Changes the size of text you're ab ut to type, or select some text and make it 
larger or smaller. 

Colour: Changes the colour of the text you 're typing, or elect text and change its 
colour to another hue. 

B, I, U buttons: Use these buLrons to make the text bold, italic, or underlined. 

Paragraph alignmen t buttons: The lhree buttons next to the text style buttons affect 
how a paragraph is aligned in the message. The first button left alignment - aligns 
your text left. The centr button centres it, and the right button right aligns the text. 

List buttons: Next t the paragraph al ignment buttons are two buttons that let you 
make ordered and unordered li t . To make a list, enter the items on your list onto 
separate lines in your message body. elect all the lines using your mouse, then click 
one of the List buttons. If you change your mind about hat kind of list to make, place 
your cursor in one item on the Ii t and click the other list type. The whole list will 
change. 

Indent buttons: The last two buttons on the right of the fom1atting toolbar allows you 
to indent paragraphs. Place your cursor in a paragraph (anywhere in the paragraph) 
and click the button that bas an arrow pointing towards the right. That paragr ... ph will 
b indented. You can click these buttons multiple times to move paragraphs further 
over. 

18.6 WHAT IS MIME? 

MIME stand for M ultimedia Internet Mai l Extension or Multipurpose Internet Mail 
Extension, As the name indicates, it is an extension to th Internet e-mail protocol that 
allows it' s use to e change clifferent kinds of data fi le over the Internet uch as 
images, audio, and video. Th MIME is required if the t xt in character sets other than 
ASCII. Virtually all human-written internet e-mail and a fairly large proportion of 
automated e-mai l is transmitted via SMTP in MIME format. Actually , MIME was 
design d mainly for MTP. but the content types defined by MIME standards are also 
important in communication protocols outside of e-mail, such as HTTP. ln 199 I, 
Nathan Borenstein ofBellcore proposed to th IETF that SMTP should be extended s 
that Internet (but mainly Web) client and servers could recognize and handle other 



kinds of data than A Cll text. As a result, new file types were added to "mail" a a 
supported Internet Protocol file type. 

Applying Sta tionery 

Stationery in Microsoft Outlook includes backgrounds and patterns and offers a set of 
unified design elements such as fonts, bullets, colours and effects. You can choose 
from a pred fined Ii t of Outlook stationery and themes so that you can easily 
personalize HTML-formatted e-mail messages. 

Apply Outlook stationery and themes to all messages 

• Click the File tab. 

• Click Options. 

• Click Mail. 

• Click Stationery and Fonts. 

• On the Per onal Stationery tab, click Theme. 

• NOTE: If you try this procedure without HTML as your message format, the 
message Theme that are not installed appear . 

• Under Choose a theme, click the theme or tationery that you want, and then 
click OK. 

• Select the font options that you want to use. 

• Apply Outlook tationery and themes to a single message. 

• Click the Home tab. 

• In the N w group, click New Items, point to E-mail Message Using, and then 
click More Stationery. 

• Under Choose a Theme, click the theme or tationery that you want, and then 
click OK. 

• Compose and end your message. 

18.7 INSERTING A HYPERLINK OR 
HTML PAGE INTO A MESSAGE 

Sometime it becomes very important to make ome links from e-mail. Imagine you 
created a document and uploaded it over the internet. Now you want to share web link 
with other user, in this case, you need to ins rt web link with oth r user. Use the 
following method to insert web link in an e-mail : 

Method 1 

Copy link add.re from web browser and paste it in your e-mail body. 

Method2 

Insert some text and mark it as hyperlink. 
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Highlight the words "Click Here' then go to the Insert Menu and select Hyperlink . 
Now insert the text that you want to make a hyperlink. 

Insert II Hypeiin 

lion 

Qnc:e4 

Inser ting Link 

http://www.!;J'oup-mllil.coml


Insert URL address that you want to link with hyperlink text. 

Press OK once done inserting link. 

Now Test the link. 

18.7.1 Flagging an E-mail or News Message 

Over time, flags have become a favouri te Outlook feature for users who need help 
remembering important messages. If you can ' t respond to an important e-mail right 
away, you can fl ag that me age as soon as you read it. Then, you' 11 be sure to get 
back to it. You can al o plant a flag in a message y u s nd to others to remind them of 
a task. 

One-click Flagging 

When you look at the list of messages in your lnbox, you ee a little box at the right 
end of each subject line containing a little grey outline of a flag, sort of a shadow flag. 
When you click that little hatlow, it changes from grey to a bright red colour to show 
you've flagged it. 

Setting F Jags for Different Days 

If you click only once on a message to add flag, a copy of the message appears in 
your To-Do Bar along with the list of things you're scheduled to do today. You might 
not be ready to deal with a certain message today; you might prefer to put it off until 
tomorrow or next week. 

18.7.2 Importing Messages from Other E-mail Programs 

Start the Import and Export Wizard by choosing one of the following options : 

• In Outlook 20 l 0, on the File tab, click Open > Import. 

• In Outlook 2007, on the Fi le menu, click Import and Export. 

• Click Import Internet Mail and Addresses, and then click N xt. 
.. . - -- - - ~ - - - ---

Im po rt and Export Wizard 

Import Internet Mail Account Settings 
mn:1.,1,mm1,Ml@fflil&BNlt4{i¥ I Import RSS Subscri ions from an OPML f ile I 

Next > ] [ Cancel 

Import and Export Wizard for Importing Ma ils from Other E-ma il Progr m 

• Click Outlook Express. 

• Select the Import maiJ check box. 

• Click Next. 

• Click Finish. 
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Newsgroups (also known a Usenet) are one of the oldest uses of the in ternet. They 
have been around for much longer than the web. A new group is very similar to an 
e-mail account with one important differ nee: everyone in the world can access it. 

When you post a message to a newsgroup, the messag goe to your local news server, 
and this server sends copie of the message to all the s rvers it knows about. The 
message slowly propagates through the net , until all the news servers in the world 
have a copy. 

In contrast, some websites have "me sage boards", which may look like newsgroups. 
They serve the sam basi purpo , but do not work as well . Message boards have 
become more popular than newsgroups, simply because they are easier to find. To use 
a message board, you just click on a link from the main sit . To use a newsgroup, you 
must start up a newsread r, which is a separate program from the web browser. 

Types of Newsgroups 

Newsgroups are listed in a hier rcby that goes back to the early l 980's. The diffi rent 
types of newsgroups are shown by an extension; examples of ome of th di fferent 
types of extensions and meanings are given below (for Google newsgroups): 

alt. - Any conceivable topic. 

biz. - Business products, ervice , reviews 

comp. - Hardware, software , consumer info 

humanities. - Fine art, literature, philosophy 

misc. - Employment h alth, and much more 

news. - Info about Usenet News 

rec. - Games, hobbies, sports 

sci. - Applied science, social sci nee 

soc. - Social issues, culture 

talk. - Current issues and debates. 

Sivitching between E-mail and Ni ws R ading 

In the Folders list , cl ick the lnbox folder to go to your e-mail, or click a news server 
name or a specific newsgroup to isit newsgroups. 

-or-

Click Outlook Express at the top of th Folders list to open the Outlook Express pane 
where you can click link for the ta k you 1/ant. 

Identities {Multiple User: on a Single Comp uter) 

When two or more p ople want to use th same computer to access different e-mail 
accounts, the accounts should be kept completely eparate from one another. 
Otherwise, messages delivered to one person will be viewable by another, and all 
those messages will be mixed t gether in one inbox. One w y to overcome this 
problem is to create a eparate user account for each per on which may tum as 
overheard for other application. 



Creating Identities 

This is one of the best tool of Outlook helping its user to use same e-mail program 
while keeping there data separate and personal. Most e-mail programs like Outlook 
Express have a feature called "Identities." You can setup an identity for each person 
who wants to access an e-mail account on the same computer. The program will create 
a separate lnbox and a separate list of contacts for each identity. This allows two or 
more people to use the ame e-mail program while keeping their e-mail account 
settings, e-mail message and contacts separate. 

Adding a New Identity 

To create an identity click Tools > Account Settings. Select the desired account from 
the list on the left, then click the Manage Identities button in the bottom right. This 
displays a list of the identitie previously created for the account. To create a new 
identity, click Add. 

Managing Contacts with Outlook 

Content to any e-mail program is important and keeping track record of the e-mail 
sent and received is also equally important. In outlook address book is a place where 
you keep information of e-mail content. The address book program lets you insert 
information of other user. You can insert personal infi nnation of content like phone 
number, address, primary and alternative e-mail, etc. 

Creating Addresses 

To create address book take the following steps: 

• Create a folder under Contacts, and then make that folder an ddress book. Select 
the People tab at the bottom of your Outlook screen. 

. . · 1 

• On the Home tab under My Contacts right-click the Contacts folder and then click 
on New Folder. 

I:. I •• .. 
Nrw New Contact 

Contact Group 

New 

., My Contacts 

Suggested Contacts 

Lyne: Contacts 

SEND/ RECEIVE 

~ X 
N- Delete 

Items• 
0,1,t, 

C 

Contacts Option 

• In the Create New Folder dialog box, name the folder, select wher to place it, and 
then click OK. It' probably best to place the new folder in the Contacts folder. 
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• To make sure your folder is available as an address book, right-click the new 
folder, and then click Properties. 

Myfoothal - .. 
~"■.l OpE:n in New Win do ~ 

Conned to a ~o New Folder ... 

I Rename Folder 

£opy Folder 

Move Folder 

Qelete Folder 

~ Recover Oele!t:d Items ... 

• Move.Up 

_Share 

fr pvties ... 

Property Dialog Box 

• Click the Outlook Address Book tab, and make sure that the check box for "Show 
this folder as an e-mail Address Book" is selected. 

TEST Properties Il I 
- --

G,m,ral I Hon,e hoe 
Outlook Address Book I Pennis s1ons I srnctmm:izatlon 

Show this fold et as an e-mai l Address Book 

Nam-e of the address boo ---
MY football t , am 

J -

I 01( l l cancel J I Apply I 

Folder Property Window 



• Confirm that the new contacts folder was added as an address book. From your 
Inbox, click the Home tab > Address Book. 

j Search People 

[fil[: Address ook 

I T Filter Email ... 

Fin d 

• In the Address Book dialog box, verify that the address book you just created 
appears in the Add.re Book list. 

ers 

Suggested Co ntacts 
Volunte er Gro up 

Importing an Address Book from Another Program 

To get content stored in some other program we use import and export tool of Outlook 
Express. Take the fo llowing steps to import an address book from another program. 

Outlook Menu and Tab 

Choose Open & Export > Import/Export. This starts the wizard! 

Open Outlook Data File 
L] Open i!n Ou.lloo datil fil ,e (.pst). 

Open Outfook 
Data File 

~ 
Import/~ 

Import/Export 
Import or l!KJ)Ort files 11Jld settings. 
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/ 

Choose Import from another program or file, and then choose Next. 

Ch001c n d1on to 11crfo """ 

Elrport RS f-reds to an OPM Ill! 
fl:p<>rt to il Ill! 

01\ 

.vn 

h o athn fllu . such as Out10-01t 
I PST) and tm 11ti 

Steps oflmport Wizar d 

Choose Comma Separated Values, and then choose Next. 

Steps oflmport Wizard 

In the Import a Fil box. browse to your contacts fi le, and then double-click to select 
it. 

Steps ofi mport Wiza rd 



Choose one of the foUowi ng to specify how you want Outlook to handle duplicate 
contacts: 

Replace duplicates with items imported, if a contact is already in Outlook and your 
contacts file, Outlook discards the info it has for that contact and uses the info from 
your contacts fil e. You should choose this option if th contact info in your contacts 
file is more compl te or more current than the contact info in Outlook. 

Allow puplicates to be created: If a contact is in Outlook and your c ntacts fil e, 
Outlook creates duplicate contacts, one with the original Outlook info and one with 
the info imported from your contacts file. You can combine info for those people later 
to eliminate duplicate contacts. This is the default option. 

Do not import duplicate items: If a contact is in Outlook and your contacts fi le, 
Outlook keeps the info it has for that ontact and discards the info from your contacts 
file. You should choose this option if the contact info in Outlook is more complete or 
more current than the info in your contacts file. 
Click Next. 

In the Select a destination folder box, scroll to the top if needed and select 
the Contacts folder > Next. If you have multiple -mail accounts, choose the Canta t 
folder that is under the e-mail account you want to be a ociated with the contacts. 

Steps oflmport Wizard 

Choose Finish. 
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teps of Import Wizard 

Outlook begins importing your contacts immediately. You'U know it's finished when 
the Import Progress box closes. 

To see your contacts, al the bottom of Outlook, choose the People icon. 
, .. --~" --- ---~--~------~ -~-~ --=---- -

: ~~ ' . . I . 
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Outlook Home Screen 



Using Keyboard Shortcuts in Outlook Express 

Below is a listing of all the major shortcut k ys in Microsoft Outlook. See the 
computer shortcuts page if you are looking for other bortcut keys used in other 
programs. 

Shortcut Description 

Alt+ S Send the e-mail. 

Ctr I+ Enter Send the e-mail you're composing. 

Ctr I+ C Copy selected text. 

Ctrl + X Cut elected text. 

Ctr!+ P Pnnt selected text. 

Ctr I+ K Complete the name or e-mail being typed in the e-mail address bar. 

Ctr!+ B Bold highlighted selection. 

Ctr!+ I Italic highl ighted selection . 

Ctr!+ M Send and receive all. 

Ctr! +U Underline highlighted selection. 

Ctr! +R Reply to an e-mail. 

Ctr!+ F Forward an e-mail. 

Ctrl + N Create a new e-mail. 

Ctr!+ Y Go to fol der. 

Ctr!+ Shift+ A Create a new appointment to your calendar. 

Ctrl +Shift+ 0 Open the Outbox . 

Ctr!+ Shift+ I Open the lnbox. 

Ctrl +Shift+ K Add a new task. 

Ctrl +Shift+ C Create n new contact. 

Ctr!+ Shift+ J Cre ten new journal entry. 

Ctr!+ Shift+ V Move fo lder. 

Fill in the blanks: 

l . HTML stands for -----

2. BCC and CC are options of ___ _ 

3. Outlook i utility tool. - ----

4. Import and export wizard is used for ___ _ 

5. Identities help in ___ _ 

6. Hyperlink option is available in ____ menu . 

7. MIME stands for -----

8. By using _ _ _ _ option we can attach files in a mail. 

18.9 LET US SUM UP 

• This lesson is all about e-mail. We saw in th i lesson that how can we create n 
e-mail. And what all options are available whi t writing an e-mail. 

• Now we know how and what are the functions of new group. 
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• We can import content and e-ma il by using import and export wizard. 

• We saw how to create mail and how to share information with e-mail. 

18.10 LESSON END ACTIVITIES 

I . Write an e-mail having BCC and CC opt ion. Note down the difference . 

2. Create a new e-mail account and transfer all your contacts to this new mail 
account. Write down steps that you followed. 

3. Attach 5 files in e-mail and send it to your friends. 

18.11 KEYWORDS 

SMTP stands for Simple Mail Tran ·fer Protocol. It is a protocol used for sending and 
r ceiving information via e-mail. 

FTP stands for File Transfer Protocol used for sending file. 

POP stands for Post Offi ce Protocol. It is a standard protocol for e-mail rotation over 
internet. 

GUI stands for Graphic U er Interface. 

PC stands for Personal Computer. 

XP: It is a kind of Operating System developed by Microsoft. 

ME: It is a kind of Operating ystem developed by Micros ft. 

HTTP stands for Hypert xt Transfer Protocol and it is a protocol for web browsing. 

CC stands for Carbon Copy. It is an optional text box while writing an email. 

BCCstands for Blind Carbon Copy. 1t is an optional text box while writing an e-mail. 

MIME stands for Mult imedia Internet Mail Extension used for ending and receiving 
multimedia enabled e-mails 

ASCII stands for American Standard Code for Information Interchange. It is the 
standard code that comp ter under tands . 

HTML stands for Hypertext Mark-up Language, a standard language for web page 
creation. 

18.12 QUESTIONS FOR DI CUSSION 

1. What do you Wlderstand by MIME? 

2. Write all the steps involved in writing an e-mail. 

3. What is newsgroup? Explain the different types of newsgroups. 

4. How to attach a file? Explain the t ps. 

5. What is e-mail formatting? 

6. What is the use of import and export wizard? Explain in detail. 

7. Write the advantage of identities and stationery tools. 

8. How to create addr ss book? Explain the steps. 



Check Your Progress: Model Answer 

1. Hypertext Mark-up Language 

2. e-mail 

3. Mailing 

4. Importing and exporting contacts 

5. Keeping data separate for users using same e-mail program 

6. Insert 

7. Multimedia Internet Mail Extension 

8. Browse 

18.13 SUGGESTED READINGS 

Jennifer T. Campbell, Steven M. Freund, Mark Frydenberg, 2016, Shelly Cashman 
Series Discovering Computers & Microsoft Office 365 & ... 

Gary B. Shelly, 1995, Microsoft Office. 

Advanced Concepts and Techniques expands on those projects, showing you 
additional capabilities that help increase your productivity. With Introductory 
Concepts and Techniques, you'll gain a better understanding of Microsoft Office 
Manager. 

Joesph Habraken, 2001, Microsoft Office XP 8-in- 1. 
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